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Preface

This Reference Guide describes the features and functionality 
available in boujou 4.1 and explains their general operation.

Audience
This book is intended for users who are using boujou for camera 
tracking, including tracking moving objects or generating detailed 
3D structures from shots. Refer to this book as often as necessary.

boujou camera tracking and calibration data is used by 
professional matchmovers in the following types of applications:

• Post Production for film and TV visual effects solutions.

• Industrial Design for architecture, manufacturing, 
prototyping, forensic, and other industrial applications.

• Education for training and research programs.

This book does not assume any previous experience with boujou. 
If you have used a previous release, you will notice some 
differences in the user interface and some functionality. All boujou 
concepts, features, and functionality are described fully in this 
book.



Preface

x boujou 4.1 Reference Guide

Structure
This section describes how the information in this book is 
organized.

The first chapter provides an overview of this boujou:

Chapter  1 Introduction describes the role of boujou in 
camera-tracking applications, summarizes its key 
features and functionality, and explains its 
workflow.

Each of the following chapters describe the features and operation 
of boujou:

Chapter  2 User Interface describes the layout of the 
boujou interface and its operation.

Chapter  3 Basic Functions describes the basic tracking 
process and the tools used to track the majority 
of shots in boujou.

Chapter  4 Advanced Functions describes the advanced 
tools used for complex or difficult camera moves, 
as well as keyboard shortcuts, user preferences, 
and batch processing in boujou.

Chapter  5 Export to an Animation Package describes 
how to export data from boujou for use in 
supported third-party animation packages.

Each of the appendices provide additional information that can 
help you make the most of using boujou:

Appendix  A boujou 4.1 Keyboard Shortcuts lists all the 
keyboard shortcuts available in boujou.

Appendix  B boujou 4.1 Preferences lists and describes the 
interface and tool settings you can customize in 
the Preferences dialog box.

Appendix  C Lens Squeeze Ratio shows how to determine 
the appropriate value to set in the Lens Squeeze 
Ratio option in the Cameras dialog box to correct 
for an anamorphic shot.
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Appendix  D boujou_script File Commands lists and 
describes the available boujou script commands 
and provides an example boujou_script file.

Appendix  E Using Survey Points without a 3D Model 
describes how to use survey points to improve the 
3D structure of your solve if you have coordinates 
rather than a 3D model.

Conventions
This table illustrates the typographical conventions used in this 
book.

Convention Description

This type Menus, commands, buttons, and options 
displayed in the GUI.
Terms in a definition list or emphasis for 
important introductory words in a paragraph.

This type Text displayed by the system or extracts of 
program code.

This type Path names, file names, and extensions.
Commands or text you are to enter in files or 
dialog boxes.

This type Cross-references to related information in 
another section or document.

This type A URL for a site on the World Wide Web.
Caution A caution alerting you to actions that could result 

in the loss of data.
Important A note giving information that emphasizes or 

supplements important points in the text or 
information that may apply only in special cases.

Tip A tip helping you to apply the techniques and 
procedures in the text to your specific use or to 
suggest an alternative method.
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Related Documentation
This Reference Guide book is designed to be used in conjunction 
with the additional documentation for this release of boujou shown 
in the following table.

Document Description

Books All of the boujou books are installed in PDF 
format (requires Adobe Reader version 5.0 or 
later, which you can download free from the 
Adobe Web site at www.adobe.com).

Quick Start 
Guide

This book provides details on installing and 
getting started with the current software 
release.

This book is also provided in printed form in 
your boujou product box.

Tutorials This book provides step-by-step instructions 
on the intended way of performing specific 
tasks in boujou.

2d3 Web site The 2d3 online support system 
(www.2d3.com/php/support/faqs.php) 
provides a library of information that you can 
use to help answer your questions.

http://www.2d3.com/php/support/faqs.php
http://www.adobe.com
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boujou 4.1 provides fully automated 3D camera tracking and 
calibration from film and video material. In most cases no prior 
information about the camera or material is required, and no 
skilled user intervention is needed to derive the 3D information.

Camera tracking with boujou
boujou 4.1 enables you to add 3D objects to live camera footage 
in your 3D animation package by creating a virtual camera that 
matches the physical one that took the shot. It does this by 
automatically identifying features in the scene over the entire 
length of the shot. These features are then automatically linked 
together into a large number of tracks. boujou 4.1 then uses 
state-of-the-art techniques to solve the highly complex 3D 
mathematics in order to work out the camera parameters for each 
frame of the shot. 3D consistency between tracked features 
ensures that small moving objects are excluded from the shot.

boujou 4.1 tracks features in the scene automatically, so its 
processing engine can quickly analyze and choose the maximum 
number of qualifying features. boujou 4.1 uses statistical analysis 
to detect tracks that are producing inconsistent results and 
eliminate them. By repeating this process of analysis and 
elimination throughout the sequence, boujou 4.1 ends up with a 
large number of tracks that are consistent and a highly accurate 
calibration.

boujou 4.1 also supports imported geometry to help define 3D 
space. This means that difficult shots are easier to track, and an 
extended range of tracking options are available.
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Supported Import Image File Formats
Table 1-1 lists the types of image file formats that can be imported 
for camera tracking in boujou 4.1. For details on importing image 
files into boujou 4.1, see Chapter 4 Advanced Functions.

Table 1-1: Supported import image file formats

File Format Extension Support

Windows AVI .avi Appropriate codec must be installed 
on your machine. Not supported on 
Linux or OS X.

Cineon/DPX .cin 
.dpx

30- or 40-bits per pixel.

DPX: 3 or 4 channel 16 bit log 
encoded data, 10 and 16 bits per 
component.

Open EXR .exr Full EXR support (read only).

Maya IFF .iff Full IFF support.

JPEG .jpg Full JPEG support.

Quicktime .mov Full Quicktime support (read only). 
Not supported on Linux.

PGM .pgm Full PGM image support.

Softimage .pic 24- or 32-bits per pixel, with or 
without encoding.

PNG .png Full PNG support.

PPM .ppm Full PPM support.

SGI .rgb 
.sgi

Silicon Graphics Bitmap RGB or 
RGBA, with or without encoding, 8- 
or 16-bits per component.

TGA .tga 24- or 32-bits per pixel, with or 
without encoding (read only).

TIFF .tiff Grayscale, RGB or RGBA, with or 
without encoding, 8- or 16-bits per 
component.
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Supported Export Image File Formats
Table 1-2 lists the types of image file formats that can be exported 
from boujou 4.1 for camera tracking in third-party animation 
packages. For details on exporting image files from V, see 
Chapter 4 Advanced Functions.

Table 1-2: Supported image export file formats

File Format Extension Support

Windows AVI .avi Appropriate codec must be installed 
on your machine. Not supported on 
Linux or OS X.

Cineon .cin 30- or 40-bits per pixel.

Maya IFF .iff Full IFF support.

JPEG .jpg Full JPEG support.

PGM .pgm Full PGM image support.

Softimage .pic 24- or 32-bits per pixel, with or 
without encoding.

PNG .png Full PNG support.

PPM .ppm Full PPM support.

SGI .rgb 
.sgi

Silicon Graphics Bitmap RGB or 
RGBA, with or without encoding, 8- 
or 16-bits per component.

TIFF .tiff Grayscale, RGB or RGBA, with or 
without encoding, 8- or 16-bits per 
component.
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Supported Camera Export File Formats
Table 1-3 lists the types of camera file formats that can be 
exported from boujou 4.1 for camera tracking in third-party 
animations packages. For details on exporting a scene file created 
in boujou 4.1, see Chapter 5 Export to an Animation Package.

Table 1-3: Supported camera export file formats

File Format Extension

3D Studio Max *.ms

After Effects (Maya) *.ma

boujou Animation *.ban

Cinema 4D *.c4d

Cineon *.jdf

Combustion *.cws

Filmbox (Windows and Linux only) *.fbx

Flair *.mrmc

Flame v5.0, v7.0, or v9.0 *.action

Fusion 5.0 *.comp

Houdini 4.1 *.hip

Lightwave *.lws

Maya pre version3, Maya 3, or Maya 4+ *.ma

Mistika DVE *.fx

Shake *.shk

Smoke *.dve

SoftImage (3.8, 3.9.1, and 3.9.2) *.xsi

XSI (1.5 and 2.0+) *.xsi

Text *.txt
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boujou Camera Tracking Workflow
This section summarizes the basic workflow for camera tracking 
in boujou 4.1. The workflow is highly non-linear, and there are 
many additional stages that can be added. However, the following 
basic stages always need to be carried out, and in the order 
specified:

1. Import an image sequence.

You load film or video material from live camera footage into 
boujou 4.1. 

2. Track 2D features.

You create feature tracks in which boujou 4.1 identifies parts 
of the imported image sequence that are different from the 
surrounding area and then matches them with similar features 
found in subsequent frames.

3. Solve the camera.

You solve the camera using the 2D feature tracks. During this 
stage boujou 4.1 calculates the motion of the camera 
(position, orientation, and focal length) and the three 
dimensional position of most feature points detected in the 
scene.

4. Export the results.

You export the scene file created by the camera solve for use 
in a third-party 3D animation package.

For details on these basic stages, see Chapter 3 Basic Functions. 
To learn more about additional boujou 4.1 functionality, see 
Chapter 4 Advanced Functions.
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22User  In ter face

This chapter covers the various elements of the boujou 4.1 
interface:

• boujou 4.1 User Interface Enhancements on page 2-2

• boujou 4.1 Window on page 2-3

• Menu Bar on page 2-7

• Toolbars on page 2-16

• Play Controls Toolbar on page 2-21

• Left Sidebar on page 2-23

• Image Window on page 2-32

• Timebar on page 2-43

• Status Bar on page 2-43

• Right Sidebar on page 2-46

• Basebar on page 2-63

• Cache Bar on page 2-69

Important
If you are new to boujou 4.1, or if you have been using an earlier version 
of the product, you should read this chapter first.
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boujou 4.1 User Interface Enhancements
The boujou 4.1 interface has been redesigned and includes the 
following significant differences from previous versions of boujou:

• The windows and panels surrounding the main Image window 
can be undocked and floated anywhere in the screen area or 
docked in other areas of the interface. This enables you to 
customize the layout of boujou 4.1 to suit your way of working 
and is ideal for multi-monitor setups.

• The image display contrast and brightness in the Zoom Tool 
pane can be adjusted, using new controls.

• The progress bar now contains a new Lasso selection tool 
button.

• On the menu bar, the Import/Export, Artifacts, Actions, 
and Play menu items have been removed, and new Setup, 
2D Tasks, 3D Tasks, Scripts, and Export menu items have 
been added.

• The boujou 4.1 toolbar has additional buttons for Orthogonal 
views, stepping through solved frames, and the Fly Align and 
Vertex Align tools. The layout of the Play controls on the 
toolbar has been slightly changed.

• Access to the Toolbox, Taskview (formerly Artifacts Tree), 
History, Help, Overlays, Zoom, and Model panes is now 
tab-based.

• The boujou 4.1 menu bar has been redesigned. The Import/
Export, Artifacts, Actions, and Play menu items, which 
were present in boujou 3, have been removed and new 
Setup, 2D Tasks, 3D Tasks, Scripts, and Export menu 
items have been added.
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boujou 4.1 Window
The boujou 4.1 window, shown in Figure 2-1, is clearly laid out to 
enable you to easily work with your image data.

Figure 2-1: boujou 4.1 user interface

As you work with boujou 4.1, you will use the following key areas 
of the user interface:

1. Menu Bar

Contains commands for managing the appearance and 
operation of boujou 4.1. For details, see Menu Bar on 
page 2-7.

2. Toolbars

Contain tools for managing project files, configuring views, 
and manipulating camera angles. For details, see Toolbars on 
page 2-16.



User Interface

2-4 boujou 4.1 Reference Guide

3. Play Controls Toolbar

Contains controls for playing and stepping through image 
sequences and camera movements. For details, see Play 
Controls Toolbar on page 2-21.

4. Left Sidebar

Contains tool and function panes in a customizable layout. It 
can also remain empty. For details, see Left Sidebar on 
page 2-23.

5. Image Window

Displays image sequences, and 2D and 3D graphical tracking 
data in various configurable views. For details, see Image 
Window on page 2-32.

6. Timebar

Enables you to navigate through an image sequence, specify 
frame ranges, and display the Go to frame dialog box in 
which you can type the required frame number. For details, 
see Timebar on page 2-43.

7. Status Bar

Provides status information on system activity and contains 
tools for selecting and manipulating data in the Image 
window. Status information is also displayed in the Wizard. 
For details, see Status Bar on page 2-43.

8. Right Sidebar

Contains tool and function panes in a customizable layout. It 
can also remain empty. For details, see Right Sidebar on 
page 2-46.

9. Basebar

Contains tool and function panes in a customizable layout. It 
can also remain empty. For details, see Basebar on page 2-63.

10. Cache Bar

Displays information about the memory used to cache an 
image sequence while it is being loaded. For details, see Cache 
Bar on page 2-69.
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Each of the boujou 4.1 window elements is described in more 
detail on page 2-7 to page 2-69. Sections appear in the order they 
are listed above.

Managing Panes
The right sidebar, left sidebar, and basebar areas are containers 
for the panes that contain the tools you use to work within 
boujou 4.1. They are configurable areas that can contain one or 
more panes.

For information on the default layout of the panes in each area, 
see Left Sidebar on page 2-23, Right Sidebar on page 2-46, and 
Basebar on page 2-63.

Within the right sidebar, left sidebar, and basebar areas, you can 
lay out the panes in the following ways:

• Tabbed In the tabbed layout, the panes lay on top of one 
another and are accessible using the tabs at the bottom of the 
area.

• Stacked In the stacked layout, the panes are positioned one 
above the next within the sidebar areas, and side by side in 
the basebar.

• Combined tabbed and stacked layouts In a combined 
layout, some of the panes are stacked and some are tabbed.

You can also undock and float the panes in any area of the screen 
space or across a multi-monitor setup.

To display or hide a pane:
1. From the View menu, point to Panes.

OR
right-click any toolbar or the title bar of any pane.

2. Click the name of the pane that you want to display or hide.

Tip
You can also hide a pane by clicking the Hide button in the top right 
corner of the pane.
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To undock or dock a pane:

• Click the Undock button in the top right corner  
OR 
double-click the title bar of a docked pane to undock it and 
make it a floating pane.

• Double-click anywhere on the title bar at the top of a floating 
pane to dock it in the last location at which it was docked.

To move a pane:
• Drag the pane by its title bar to its new location. You can leave 

the pane floating or you can dock it in the same or another 
location.

When you drag a pane over an area into which it can be docked 
in the left sidebar, the right sidebar, or the basebar, a dotted 
outline shows where the pane will dock when you release it.

Tip
Not all panes can be docked in all areas. Sidebar panes (except the Toolbox 
pane) can be docked in either sidebar but not in the basebar area. The 
Toolbox, however, can be docked in either sidebar or the basebar. 
The basebar panes, except for the Console pane, can also be docked in 
the area between the toolbars and the Image window at the top of the 
boujou 4.1 window. For more details of the panes that can be docked in 
each area, see Left Sidebar on page 2-23, Right Sidebar on page 2-46, 
and Basebar on page 2-63.
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Menu Bar
The menu bar, shown in Figure 2-2, contains commands for 
managing the appearance and operation of boujou 4.1.

 
Figure 2-2: boujou 4.1 menu bar

The commands available from the boujou 4.1 menu bar are 
described in the following sections:

• File Menu on page 2-8
• Edit Menu on page 2-9
• Setup Menu on page 2-10
• 2D Tasks Menu on page 2-11
• 3D Tasks Menu on page 2-12
• Export Menu on page 2-13
• View Menu on page 2-14
• Scripts Menu on page 2-15
• Help Menu on page 2-15
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File Menu
The commands in the File menu, shown in Figure 2-3, enable you 
to manage project files in boujou 4.1.

Figure 2-3: File menu

Tip
Some menu commands have corresponding keyboard shortcuts; for 
details on these, see Appendix A boujou 4.1 Keyboard Shortcuts.
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Edit Menu
The commands in the Edit menu, shown in Figure 2-4, enable you 
to manage recent actions, editing operations, the Setup Wizard, 
the image sequence cache, data playback, and user preferences.

Figure 2-4: Edit menu

Tip
Some Edit commands also can be accessed from elsewhere in the 
boujou 4.1 window. Some menu commands have corresponding keyboard 
shortcuts; for details on these, see Appendix A boujou 4.1 Keyboard 
Shortcuts.
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Setup Menu
The commands in the Setup menu, shown in Figure 2-5, enable 
you to manage image sequences, camera settings, and proxy 
sequences.

Figure 2-5: Setup menu

Tip
Some Setup commands also can be accessed from Toolbox shortcut 
buttons; for details, see Toolbox Pane on page 2-28. Some menu 
commands have corresponding keyboard shortcuts; for details on these, 
see Appendix A boujou 4.1 Keyboard Shortcuts.
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2D Tasks Menu
The commands in the 2D Tasks menu, shown in Figure 2-6, 
enable you to manage feature tracking, masks, and target 
tracking on 2D image data.

Figure 2-6: 2D Tasks menu

Tip
Some 2D Task commands also can be accessed from Toolbox shortcut 
buttons; for details, see Toolbox Pane on page 2-28. Some menu 
commands have corresponding keyboard shortcuts; for details on these, 
see Appendix A boujou 4.1 Keyboard Shortcuts.
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3D Tasks Menu
The commands in the 3D Tasks menu, shown in Figure 2-7, 
enable you to manage camera solving, scene geometry, test 
objects, transformation, modeling, and mesh generation.

Figure 2-7: 3D Tasks menu

Tip
Some 3D Task commands also can be accessed from elsewhere in the 
boujou 4.1 window. Some menu commands have corresponding keyboard 
shortcuts; for details on these, see Appendix A boujou 4.1 Keyboard 
Shortcuts.
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Export Menu
The commands in the Export menu, shown in Figure 2-8, enable 
you to export image data from boujou 4.1.

Figure 2-8: Export menu

Tip
Some Export commands also can be accessed from Toolbox shortcut 
buttons; for details, see Toolbox Pane on page 2-28. Some menu 
commands have corresponding keyboard shortcuts; for details on these, 
see Appendix A boujou 4.1 Keyboard Shortcuts.
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View Menu
The commands in the View menu, shown in Figure 2-9, enable 
you to manage the appearance and layout of the boujou 4.1 
window.

Figure 2-9: View menu

Tip
Some View commands also can be accessed from toolbar buttons; for 
details, see Active View Controls Toolbar on page 2-18. Some menu 
commands have corresponding keyboard shortcuts; for details on these, 
see Appendix A boujou 4.1 Keyboard Shortcuts.
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Scripts Menu
The commands in the Scripts menu, shown in Figure 2-10, enable 
you to manage the boujou 4.1 scripts. For details on using boujou 
scripts for customizing processing, see Chapter 4 Advanced 
Functions.

Figure 2-10: Scripts menu

Tip
Some menu commands have corresponding keyboard shortcuts; for 
details on these, see Appendix A boujou 4.1 Keyboard Shortcuts.

Help Menu
The commands in the Help menu, shown in Figure 2-11, enable 
you to display the About boujou dialog box in which you can view 
version and licensing information about the installed release of 
boujou 4.1.

Figure 2-11: Help menu
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Toolbars
The Toolbars, shown in Figure 2-12, contain buttons for some of 
the frequently used functions within boujou 4.1.

Figure 2-12: boujou 4.1 Toolbars

By default, the buttons are arranged in groups in the main toolbar 
area at the top of the boujou 4.1 window.

The buttons available from the five tool groups are described in 
the following sections:

• Standard Toolbar on page 2-17

• Active View Controls Toolbar on page 2-18

• Transformations Toolbar on page 2-19

• Model Toolbar on page 2-20

• Play Controls Toolbar on page 2-21

You can customize the appearance and location of the boujou 4.1 
toolbars to suit your preferences. The toolbars can be positioned 
at the top (default), bottom, left, or right of the main window. 

To display or hide a toolbar:
1. From the menu bar, click View and point to Panes

OR
right-click any toolbar or the title bar of any pane.

Panes that are currently displayed are indicated by a check 
mark in the menu.

2. Click the name of the toolbar you want to display or hide.

boujou 4.1 maintains these settings until you adjust them again.
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To position a toolbar elsewhere in the boujou 4.1 
window:
1. Click the split bar on the left side of the desired toolbar and 

drag it to the desired location in boujou 4.1 window.

The toolbar changes to an outline shape so you can visualize 
where it will be positioned.

2. Drop the toolbar at the far right, left, top, or bottom areas of 
the main window. You may need to increase your screen 
resolution.

Standard Toolbar
Table 2-1 describes the buttons in the Standard toolbar.

Table 2-1: Standard Toolbar Buttons

Button Function Description

New Displays a dialog box that gives you the 
options of closing the current project, 
leaving it open, or canceling your 
request. If you choose to close the 
current project, you are prompted to 
save any unsaved changes. It then 
opens a new boujou 4.1 project.

Open Displays the Open Project dialog box, 
in which you can browse for a previously 
saved boujou 4.1 project. 

Save Saves the current project. 

Undo Undoes the last command.

Redo Cancels the last undo.
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Active View Controls Toolbar
Table 2-2 describes the buttons in the Active View Controls 
toolbar, which you use to manage the visualization of data in the 
Image window (for details, see Image Window on page 2-32)

Table 2-2: Active View Controls Toolbar Buttons

Button Function Description

View modes
2D Mode Sets the active view to 2D mode.

3D Mode Sets the active view to 3D mode.

Orthogonal 
Mode

Sets the active view to single Orthogonal 
mode.

Graph Mode Sets the active view to Graph mode.

Split Views
Orthogonal 
Views

Splits the Image window into four views 
in a 2x2 grid: Top, Side, Front, or 3D 
view.

Single View Reverts the Image window to a single 
view.

Horizontal Split Splits the Image window into two views, 
side by side. 



User Interface

boujou 4.1 Reference Guide 2-19

Transformations Toolbar
Table 2-3 describes the buttons in the Transformations toolbar.

Vertical Split Splits the Image window into two views, 
one on top of the other.

Grid Splitter Splits the Image window into four views 
arranged in a 2x2 grid.

Table 2-2: Active View Controls Toolbar Buttons

Button Function Description

Table 2-3: Transformations Toolbar Buttons

Button Function Description

Edit the 
coordinate 
frame

Applies transformations edits to the 
coordinate frame when the button is in 
this setting.

Edit the test 
objects

Applies transformations edits to the 
selected test object when the button is in 
this setting.

Scale Displays or hides the scale manipulator 
for the selected 3D test object (if Edit 
the test objects button pressed).

Translate Displays or hides the translate 
manipulator for the selected 3D test 
object or the coordinate frame 
(depending on whether the Edit the 
coordinate frame or the Edit the test 
objects button is pressed).
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Model Toolbar
Table 2-4 describes the buttons in the Model toolbar.

Rotate Displays or hides the Rotate manipulator 
for the selected 3D test object or the 
coordinate frame (depending on whether 
the Edit the coordinate frame or the 
Edit the test objects button is 
pressed).

Reset coordinate 
frame 
transformations

Undoes all transformations that have 
been applied to the coordinate frame.

Table 2-3: Transformations Toolbar Buttons

Button Function Description

Table 2-4: Model Toolbar Buttons

Button Function Description

Fly Align Moves the camera while in the 2D View 
using mouse navigation in conjunction 
with an imported model. A Camera icon 
is displayed in the top right of the Image 
window to indicate when this mode has 
been invoked.

Vertex Align Moves the camera while in the 2D View 
by selecting and manipulating points on 
an imported model.
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Play Controls Toolbar
Table 2-5 describes the buttons in the Play Controls toolbar, which 
you use to play back data in the Image window (for details, see 
Image Window on page 2-32).

Table 2-5: Play Controls Toolbar Buttons

Button Function Description

Play Backward Play the image sequence backward.

Stop Playback Stop playing the image sequence. 

Play Forward Play the image sequence forward.

Step Backward Step backward by one frame. 

Step Forward Step forward by one frame.

Go to Start Go to the first frame of the image 
sequence. 

Go to End Go to the last frame of the image 
sequence. 

Previous Key Jump to the previous keyframe of the 
currently selected artifact (polygon 
mask, target track, or locator).
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Next Key Jump to the next keyframe of the 
currently selected artifact (polygon 
mask, target track, or locator).

Play Once Play forward to the end frame, then stop.

Cycle Repeat playback from the start when the 
last frame is reached.

Auto Reverse 
(ping pong)

Play forward to the end frame, then 
backward to the start frame.

Locked to Point Lock the view to a single selected point 
during playback. The background image 
moves, but the selected point is static. 
This allows you to see how much the 
surrounding pixels move relative to the 
point.

Table 2-5: Play Controls Toolbar Buttons

Button Function Description
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Left Sidebar
By default, the Left Sidebar contains the following panes, 
described on the pages indicated, in a tabbed layout: 

• Taskview Pane on page 2-24

• History Pane on page 2-26

• Toolbox Pane on page 2-28

It can also contain the following panes or be empty:

• Overlays Pane on page 2-48

• Help Pane on page 2-56

• Zoom Tool Pane on page 2-57

• Model Tools Pane on page 2-60

Figure 2-13 shows an example of a customized layout, with both 
tabbed and vertically stacked panes. For more information on 
managing the panes within the left sidebar, see Managing Panes 
on page 2-5.

Figure 2-13: Left sidebar with tabbed and stacked panes
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Taskview Pane
The Taskview pane, shown in Figure 2-14, shows the tracking 
tasks that need to be completed and indicates your progress.

Figure 2-14: Taskview pane

The Taskview pane is displayed when you click the Taskview tab 
at the bottom of the left sidebar in the default layout, as shown 
in Figure 2-15.

Figure 2-15: Taskview tab
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The green lights show which tasks have been completed. You can 
expand a branch by clicking the +; this reveals the artifact 
associated with that action. Double-click the artifact to view or edit 
the properties for that action.

Informationals

Informationals are a context-sensitive advice system offering 
prompts, guidance, and warnings throughout the camera solving 
process. For example, if you camera solve a sequence and then 
add a locator, an Informational is created suggesting that you 
camera solve again, as shown in Figure 2-16.

Figure 2-16: Sample Informational

Informationals are displayed when you double-click the artifact in 
the same branch as the task to which they relate in the Taskview 
pane.
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History Pane
The History pane, shown in Figure 2-17, displays the actions that 
you have carried out since opening the current project file. The 
actions are listed with the most recent displayed at the top.

Figure 2-17: History pane

The History pane is displayed when you click the History tab at 
the bottom of the left sidebar in the default layout, as shown in 
Figure 2-18.

Figure 2-18: History tab
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To undo an action:
• Use any of the following methods:

History pane: Double-click the action. The blue check mark 
turns into a red cross to show that the item has been undone. 
All items above the selected one are also undone.

Standard toolbar: Undo button 

Keyboard shortcut: CTRL+Y

To redo an action:
• Use any of the following methods:

History pane: Double-click a previously undone action. The 
red cross turns into a blue check mark to show that the item 
has been redone. All items above the selected one are also 
redone.

Standard toolbar: Redo button 

Keyboard shortcut: CTRL+Y 
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Toolbox Pane
The Toolbox pane, shown in Figure 2-19, contains buttons to 
carry out all actions for workflow tasks in boujou 4.1.

Figure 2-19: Toolbox pane

The Toolbox pane is displayed when you click the Toolbox tab 
at the bottom of the left sidebar in the default layout, as shown 
in Figure 2-20.

Figure 2-20: Toolbox tab
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By default, a basic set of buttons appears in the Toolbox. You can 
add to or rearrange the default shortcut buttons to suit the way 
you work. Table 2-6 shows all of the available shortcut buttons, 
identifying their category and whether or not they are displayed 
in the Toolbox by default.

Table 2-6: Available Shortcut Buttons

Category Button Default

Miscellaneous
Preferences Yes

Setup
Import Sequence Yes

Edit Sequence No

Edit Camera Yes

Edit Focal Length Constraints Yes

Assess Lens Distortion No

Import Proxy No

Generate Proxy Yes
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2D Tasks
Track Features Yes

Non-consecutive Feature Tracking No

Import Tracks No

Import Image-based Masks No

Import Polygon-based Masks No

Add Polygon-based Mask Yes

Edit Named Tracks No

Add Locator Yes

Add Target Tracks Yes

Table 2-6: Available Shortcut Buttons

Category Button Default
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3D Tasks
Camera Solve Yes

Add Scene Geometry Yes

Add Test Object Yes

Export
Export Camera Solve Yes

Export Tracks No

Export Tracks to Shake Yes

Export Sequence No

Lens Adjust External Sequence No

Export Polygon-based Masks No

Table 2-6: Available Shortcut Buttons

Category Button Default



User Interface

2-32 boujou 4.1 Reference Guide

To add a shortcut button to the Toolbox:
• Right-click in an empty area of the Toolbox, and then in the 

displayed menu point to the desired category (Miscellaneous, 
Setup, 2D Tasks, 3D Tasks, Setup), and then click the desired 
shortcut button.

To replace an existing shortcut button:
• Right-click the shortcut button, and then in the displayed 

menu point to the desired category, and then click the desired 
shortcut button.

To remove a shortcut button:
• Right-click the shortcut button, and then in the displayed 

menu select Remove button.

To move a shortcut button:
• Drag it to the desired location (the pointer looks like an I-beam 

to guide you in placing the button).

Image Window
The Image window, shown in Figure 2-21, enables you to 
configure the visualization of image data. The Image window is 
always displayed in the center of the boujou 4.1 window.

Figure 2-21: Image Window
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You can use the Active View Controls toolbar, shown in 
Figure 2-22, to select an available view mode or split the Image 
window (for details, see Active View Controls Toolbar on 
page 2-18).

Figure 2-22: Active View Controls toolbar

You can configure the overlays for each window either from the 
Overlays pane (for details, see Overlays Pane on page 2-48) or 
the right-click menu in the Image window.

The current frame number is displayed in the top left of the Image 
window. You can navigate to a specific frame in the sequence by 
entering the required frame number in this box. 

If you are working with multiple solves or survey data, you can 
select which of these is displayed in the Image window. To do this, 
click the required option from the drop-down list at the top left of 
the Image window.

The following sections describe the components and operation of 
the Image window:
• 2D Mode View on page 2-34
• 3D Mode View on page 2-35
• Ortho Mode View on page 2-36
• Graph Mode View on page 2-37
• Splitting the Image Window into Multiple Views on page 2-38
• Playing Back Data in the Image Window on page 2-40
• Navigating Data in the Image Window on page 2-41
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2D Mode View
The 2D Mode view, shown in Figure 2-23, enables you to view the 
image sequence through the camera which captured it. You can 
move forward and backward through time, and you can scale and 
drag the image in the plane of the lens.

Figure 2-23: Sample 2D Mode view

The 2D Mode view is displayed when you click the Set active 
view to 2D mode button on the Active View Controls toolbar.
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3D Mode View
The 3D Mode view, shown in Figure 2-24, enables you to view 
your scene though a camera other than the one that captured the 
shot. This new camera can move completely independently of the 
scene. You can only use the 3D view after you have solved the 
shot and created a 3D structure.

Figure 2-24: Sample 3D Mode view

The 3D Mode view is displayed when you click the Set active 
view to 3D mode button on the Active View Controls toolbar.
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Ortho Mode View
The Ortho Mode view, shown in Figure 2-25, enables you to view 
the 3D scene from preset directions without any foreshortening or 
perspective.

Figure 2-25: Sample Ortho Mode view—Front

The standard 3D orthogonal views are available:

• Front (looking down –Z axis when working with Y-up, Z-back)

• Side (looking down –X axis when working with Y-up, Z-back)

• Top (looking down –Y axis when working with Y-up, Z-back)

The Ortho Mode Front view is displayed when you click the Set 
active view to Orthogonal button on the Active View Controls 
toolbar.
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Graph Mode View
The Graph Mode view, shown in Figure 2-26, enables you to view 
the camera rotations and translations split into X,Y,Z components, 
as well as the focal length once camera solving is complete.

Figure 2-26: Sample Graph Mode view

The Graph Mode view is displayed when you click the Set active 
view to graph mode button on the Active View Controls toolbar.

You cannot edit the graph points. The overlays can be managed 
from the Overlays pane.
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Table 2-7 describes the main options for navigating in the Graph 
Mode view.

Splitting the Image Window into Multiple Views
You can split the Image window into a 2x2 grid view, two 
horizontal views, or two vertical views. This is useful when aligning 
objects or structure, joining tracks, and working with locators.

Once you have split the Image window, you can set each view to 
the desired mode and configure its overlays independently. You 
can resize the views by moving the vertical splitter left and right, 
and the horizontal splitter up and down. In a 2x2 grid view, the 
vertical splitter resizes all views together.

Click the desired view to make it active. In the 2D Mode view, you 
can then hold the SHIFT key and left-click and drag the mouse to 
shuttle to the desired frame. You can revert the Image window to 
a single view at any time.

Table 2-7: Graph Mode view navigation options

Option Controls

Pan view SHIFT+LMB+RMB 
or 
SHIFT+MMB (if Middle Mouse button for 
navigation is set in Preferences; see 
Appendix B boujou 4.1 Preferences)

Zoom all SHIFT+RMB
Zoom vertical SHIFT+ALT+RMB+drag vertically
Zoom horizontal SHIFT+ALT+RMB+drag horizontally
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For example, the Orthogonal Views split view, shown in Figure 
2-27, splits the Image window into four views: top, side, front, and 
3D.

Figure 2-27: Sample Orthogonal Views Mode view

The Image window is split into this 2x2 grid when you click the 
Orthogonal Views button on the Active View Controls toolbar.

When you are using split views, you can link the views so that they 
are all synchronized to the same timeline. This is useful when you 
have split the Image window into a 2D mode view and a 3D mode 
view and you want to see both views at the same point in time (as 
if you were using a 3D animation package). To use this feature, 
from the View menu, click Link Frames Across Views.

When you are working with multiple solves or survey data, you can 
link the solve or survey data that is displayed in each of the split 
views so that they are synchronized. To use this feature, from the 
View menu, click Link Solves Across Views.
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Playing Back Data in the Image Window
You use the buttons in the Play Controls toolbar to manage the 
play back of data in the Image window.

Figure 2-28: Play Controls toolbar

For further details on the Play Controls toolbar, see Play Controls 
Toolbar on page 2-21.

The following additional play controls are available from the Edit 
menu:

Toggle Play Start or stop playback.
Step Forward 10 Move 10 frames forward.
Step Backward 10 Move 10 frames backward.
Play Range Play the frame range specified by the 

Zoom Bar.
While Tracking Step through the image sequence during 

feature tracking. This option is on by 
default.

Set playback rate Set the required playback rate. This value 
does not affect the value of frame rate in 
the Cameras dialog or scene export.
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Navigating Data in the Image Window
Table 2-8 describes the main options for navigating in the Image 
window.

Table 2-8: Image window navigation controls

Mouse Keyboard Function

— Zoom/Dolly the 
view in 2D mode or 
3D mode

or if Middle Mouse button 
is set in Preferences (see 
Appendix B boujou 4.1 
Preferences):

— Translate/Truck/
Pan the view in 
2D mode or 3D mode

or click and drag on the 
Timebar.

— Shuttle/Scrub 
through the timeline 
in 2D mode

— Orbit the view in 
3D mode

— Roll the view in 
3D mode
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Tip
You can restrict the play range to the zoom range. To do this, from the 
menu bar, click Edit and then click Play Range.

Play Controls toolbar

ALT+LEFT ARROW Play Backward

SPACEBAR Start/Stop

 ALT+RIGHT ARROW Play Forward

LEFT ARROW Step Backward

RIGHT ARROW Step Forward

Go to frame dialog box 
(for details, see Timebar 
below).

— Move to a specific 
frame

Table 2-8: Image window navigation controls

Mouse Keyboard Function
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Timebar
The Timebar, shown in Figure 2-29, enables you to navigate 
through an image sequence, specify frame ranges, and display 
information about the length of a sequence and the current frame 
position.

Figure 2-29: Timebar

The Timebar shows the frame range for the entire sequence. The 
red Zoom bar in the bottom half of the Timebar controls the range 
of frames displayed in the top half; to resize the Zoom bar, click 
and drag the arrow at either end of it.

When you first import an image sequence, the size of the Zoom 
bar defaults to the full length of the sequence. To restrict playback 
to the range specified by the Zoom bar, from the menu bar, click 
Edit and then click Play Range. Double-click the Zoom bar to 
expand it to the full length of the sequence.

To jump to a particular frame number, right-click anywhere on the 
Timebar, then click Go to frame... and in the Go to frame dialog 
box, enter the required frame number and click OK.

Status Bar
The Status bar provides status information on system activity 
and contains tools for selecting and manipulating data in the 
Image window.

The Status bar is directly below the Image window. The contents 
of the bar depend on the current state of system activity:

• Processing Status on page 2-44

• Editing Status on page 2-44
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Processing Status
The Status bar displays processing information during tracking 
and saving operations, as shown in Figure 2-30.

Figure 2-30: Status bar—processing

During processing, the status bar contains the following controls:

• Progress bar
Displays progress of processing operations.

• Camera Solve on Completion check box
Determines whether or not to automatically start a camera 
solve process when the current processing operation 
completes. 

• Cancel
Enables you to cancel the current operation.

Editing Status
The Status bar contains tools for editing the current image data 
when tracking and saving operations are not being run, as shown 
in Figure 2-31.

Figure 2-31: Status Bar—editing

The right side of the Status bar contains the following editing and 
proxy controls and information:

• Clear All Selections button
Clears all objects currently selected.
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• Lasso Selection Mode button
Enters or exits Lasso Selection mode.

When this button appears to be pressed, Lasso Selection 
mode is on and you can define a selection area from the path 
of the mouse cursor. When Lasso Selection mode is off, you 
return to rectangular selection mode. You can add and 
subtract from the selection set by using the CTRL key in the 
usual way.

• Toggle Edit Mode button
Enters or exits Edit mode.

When the button appears to be pressed, Edit mode is on.

• Artifact
Displays the name of the artifact that you are currently adding 
or editing.

• Proxy
Indicates whether or not you are using a proxy image 
sequence. If Using Proxy is displayed, you can right-click the 
Proxy box to display a menu with commands to turn proxies 
on or off, or to switch between proxies.
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Right Sidebar
By default, the Right Sidebar contains the following panes, 
described on the pages indicated, in a tabbed layout: 

• Overlays Pane on page 2-48

• Help Pane on page 2-56

• Zoom Tool Pane on page 2-57

• Model Tools Pane on page 2-60

It can also contain the following panes or be empty:

• Taskview Pane on page 2-24

• History Pane on page 2-26

• Toolbox Pane on page 2-28

Figure 2-32 shows an example of a customized layout, with both 
tabbed and vertically stacked panes. For more information on 
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managing the panes within the right sidebar, see Managing Panes 
on page 2-5.

Figure 2-32: Right sidebar with tabbed and stacked panes
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Overlays Pane
The Overlays pane controls which overlays are displayed in the 
Image window. All of the controls in the Overlays section of an 
Overlays pane are also available from the menu displayed when 
you right-click anywhere in the Image window.

The contents of the Overlays pane depend upon the current view 
mode (for details, see Active View Controls Toolbar on page 2-18).

Figure 2-33 shows the Overlays pane for 2D mode. 

Figure 2-33: Overlays pane—2D mode
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Figure 2-34 shows the Overlays pane for 3D mode. 

Figure 2-34: Overlays pane—3D mode

Figure 2-35 shows the Overlays pane for Orthogonal mode.  

or 

Figure 2-35: Overlays pane—Orthogonal mode
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Figure 2-34 shows the Overlays pane for Graph mode. 

Figure 2-36: Overlays pane—Graph mode
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The Overlays pane is displayed when you click the Overlays tab 
at the bottom of the right sidebar in the default layout, as shown 
in Figure 2-37.

Figure 2-37: Overlays tab
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Table 2-9 describes the Overlays pane controls.

Table 2-9: Overlays pane controls

Function View Mode Description

View Displays the View options.

Default View Re-centers the view and restores the default view 
settings.

Center on 
Selection

2D and 3D Centers the view on the selected object or group 
of objects.

Actual Size 2D only Displays the image at actual size, dependent on 
the resolution of the screen.

Fit to Window 2D only Scales the image to fit the size of the current 
boujou 4.1 Image window.

Tracks Display the track length display options.

Minimum 2D only Sets the minimum visible track length.

Default: 2

Before 2D only Sets the number of frames visible before the 
current frame. 

Default: 10

After 2D only Sets the number of frames visible after the current 
frame. 

Default: 10

Show 
Complete

2D only Shows the entire track, including the current 
feature position.

Show Feature 
Only

2D only Shows just the current tracked feature position.
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Overlays Displays the overlay options.

Image 2D and 3D Displays the background image.

Masks 2D only Mask Display Options > Polygons
Displays only the Polygon outline of the mask.

Mask Display Options > Filled Regions
Displays only the fill region of the mask.

Mask Display Options > Both
Displays the Polygon outline and the fill region 
(default).

Show Nearest Keyframes
Displays lines linking each vertex of the polygon 
outline to their position at the nearest keyframe.

Radial 2D only Displays the distorted/undistorted image (if lens 
correction has been applied).

Tracks 2D only All
Displays all types of feature track (default).

Inlying
Displays only the inlying feature tracks (the ones 
used to calculate the camera).

Gold
Displays only the feature tracks that have been 
given gold status by the user.

Predictions 2D and 3D All
Displays all predictions (default).

Live
Displays only the predictions that are associated 
with features visible in the current frame (the 
yellow ones).

Errors 2D only Displays the error difference between the original 
feature and the reprojected predictions at 10 
times its actual length.

Table 2-9: Overlays pane controls

Function View Mode Description
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Locators 2D only

2D and 3D

2D only

Locator Options > Tracks Only
Displays only the keyframes set by the user.

Locator Options > Predictions Only
Displays only the 3D prediction calculated from 
the locator (2D view option, 3D view default).

Locator Options > Both
Displays both the keyframes and the 3D prediction 
(default).

Cameras 3D only Camera Options > Show Camera Path
Displays the camera path as a continuous red line.

Camera Options > Show Individual Cameras
Displays the position of the camera in each frame 
as a red dot with a line to show the direction of 
view. The length of the line is proportional to the 
camera's focal length.

Target Tracks 2D only

2D and 3D

2D only

2D only

Target Track Options > Tracks Only
Displays only the 2D track.

Target Track Options > Predictions Only
Displays only the 3D prediction calculated from 
the Target Track (2D view option, 3D view 
default).

Target Track Options > Both 
Displays both the 2D track and the 3D prediction 
(default).

Show All Features
Displays the position of the 2D feature found by 
the target tracker in each frame as a black dot.

Survey Points 2D and 3D Displays any survey points that have been used to 
improve the 3D structure of the solve.

Models 2D and 3D Displays any imported models.

Meshes 2D and 3D Displays meshes generated from predictions.

Test Objects 2D and 3D Displays any 3D test objects that have been 
created after camera solving.

Ground Plane 2D and 3D Displays the ground plane.

Axes 3D only Displays the axis tripod in the bottom left of the 
3D view.

Table 2-9: Overlays pane controls

Function View Mode Description
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Rotation Graph only X Rotation
Displays the X rotations as a red line.

Y Rotation
Displays the Y rotations as a green line.

Z Rotation
Displays the Z rotations as a blue line.

Rotation type > Static Euler
Expresses rotations as Euler rotations about static 
axes.

Rotation type > Moving Euler 
Expresses rotations as Euler rotations about 
moving axes.

Translation Graph only X Translation
Displays the X translations as a red line.

Y Translation
Displays the Y translations as a green line.

Z Translation 
Displays the Z translations as a blue line.

Focal Length Graph only Focal length units > mm
Displays the focal length in millimeters.

Focal length units > inches
Displays the focal length in inches.

Focal length units > pixels
Displays the focal length in pixels.

Camera Scale 3D only Sets the scale factor by which the camera display 
is multiplied in the 3D view. 

Default: 4

Error Scale 2D only Sets the scale factor by which reprojection errors 
are multiplied in the 2D display. 

Default: 10

Table 2-9: Overlays pane controls

Function View Mode Description
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Help Pane
The Help pane, shown in Figure 2-38, shows context-sensitive 
help pages which describe the tools and actions in greater detail.

Figure 2-38: Help pane

The Help pane is displayed when you click the Help tab at the 
bottom of the right sidebar in the default layout.

You can navigate through previously viewed help pages by using 
the Back, Forward, and Home buttons at the bottom of the Help 
pane. The Navigation Help button displays the Workspace 
Navigation help topic, which describes the keyboard and mouse 
controls to use for navigating in the boujou 4.1 Image window.
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Zoom Tool Pane
The Zoom Tool pane, shown in Figure 2-39, displays a zoomed-
in area of the main image which makes working with locators and 
target tracks easier and more accurate. 

Figure 2-39: Zoom Tool pane
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The Zoom Tool is displayed when you click the Zoom tab at the 
bottom of the right sidebar in the default layout, as shown in 
Figure 2-40.

Figure 2-40: Zoom tab

If the Zoom Tool pane is not hidden, it will also be displayed 
automatically when you add a new locator or target track, or when 
you turn on the edit mode using the Toggle Edit Mode button in 
the Status bar.

The position of a locator or target track keyframe can be edited 
in the Zoom Tool pane using the truck/pan navigation control (for 
details, see Table 2-8 on page 2-41), which shows the position 
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using a cross hair. The X and Y values of the Point at the center 
of the locator or target track are given below the zoomed region.

The zoomed region is shown in the main window as a yellow box, 
quartered by a cross hair. You can change the amount of zoom by 
using the zoom navigation control (for details, see Table 2-8 on 
page 2-41) in the Zoom Tool pane. Zooming in and out in the 
Zoom Tool pane makes the yellow box in the main window get 
smaller and larger. The X and Y positions (in pixels) of the center 
of the cross hairs is given below the zoomed region. The Name 
of the artifact that you are editing is also given below the zoomed 
region.

If you are editing a locator prior to camera solving, or a target 
track that has not yet been tracked, an image will appear in the 
Zoom Tool pane only when you are on a keyframe.

If you are editing a locator after camera solving, or a tracked 
target track, an image is displayed in the Zoom Tool pane even 
when you are not on a keyframe. Any adjustments that you make 
in the Zoom Tool pane will create a keyframe at the current 
frame.

The Display Controls adjust the brightness and contrast of the 
image display in both the main Image window in 2D Mode view 
and the Zoom Tool pane. These Brightness and Contrast 
controls can be used to make features clearer and easier to work 
with when adding locators or target tracks. Adjustments made 
here are to the display only and do not affect boujou 4.1’s tracking 
or solving engine in any way. The Reset button returns these 
values to their default of 0 (zero).

When high dynamic range images are loaded, these controls are 
replaced with the Black Point (default is 0), Display Gamma 
(default is 2.2), and Exposure Adjust (default is 0) parameters 
which apply to EXR, Cineon, and DPX formats.
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Model Tools Pane
The Model Tools pane, shown in Figure 2-41, provides a set of 
tools to help with face-based tracking. This tracking method, 
introduced in boujou 4.1, is described in Chapter 4 Advanced 
Functions.

Figure 2-41: Model Tools pane
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The Model Tools pane is displayed when you click the Model tab 
at the bottom of the right sidebar in the default layout, as shown 
in Figure 2-42.

Figure 2-42: Model tab
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Table 2-10 describes the Model Tools pane controls.

Table 2-10: Model Tools pane controls

Function Description

Face-Based Tracking

Track Forward Track the faces of the model forward.

Track Backward Track the faces of the model backward.

Track Forward One Frame Track the faces of the model forward by one frame.

Track Backward One 
Frame

Track the faces of the model backward by one frame.

Vertex-drag Controls

Default View from Known 
3D

Creates a camera view based on the default model 
position. Frames with default views are displayed in 
yellow on the Timeline.

Delete all springs Deletes all vertex align springs in every view.

Delete springs active 
view

Deletes all vertex align springs in the current view.

Optimize Focal Length Optimizes focal length based on vertex alignment.

Focal Length Enables you to manually enter the focal length of the 
current view.

Solve View from Known 
3D

Creates a camera view based on connected survey 
points.
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Basebar
By default, the Basebar contains the following panes, described 
on the pages indicated, in a tabbed layout:

• Console Pane on page 2-64

• Wizard and Troubleshooter Pane on page 2-65

• Timeline Pane on page 2-66

It can also contain the following pane or be empty:

• Toolbox Pane on page 2-28

Figure 2-43 shows an example of a customized layout, with both 
tabbed and stacked panes. For more information on managing the 
panes within the basebar, see Managing Panes on page 2-5.

Figure 2-43: Basebar with tabbed and stacked panes
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Console Pane
The Console Pane, shown in Figure 2-44, has two functions:

• Displays summary information about system activity such as 
the speed of feature tracking or the location of autosaved files.

• Acts as the embedded scripting command entry window, 
where you can type commands for the embedded scripting 
engine. Embedded scripting in boujou is still in extended beta 
phase. For more information about the embedded scripting 
functionality, contact 2d3 Support (for contact details, see 
Appendix F Support Resources).

Figure 2-44: Console pane

The Console pane is displayed when you click the Console tab 
at the bottom of the basebar in the default layout, as shown in 
Figure 2-45.

Figure 2-45: Console tab
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Wizard and Troubleshooter Pane
The Wizard, shown in Figure 2-46, is designed to help new users 
through the tracking process in boujou 4.1. It guides you through 
every stage from setup through to export. You can use the Wizard 
and the Troubleshooter in parallel with all of the other interface 
items.

Figure 2-46: Wizard

The Wizard is displayed when you click the Wizard tab at the 
bottom of the basebar in the default layout, as shown in 
Figure 2-47.

Figure 2-47: Wizard tab
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The Wizard contains the following buttons:

• Related Tasks
This button at the top of the Wizard displays a list of additional 
tasks you can choose to carry out during the tracking process 
if you are feeling more confident in using boujou 4.1.

• Troubleshoot Menu
This button at the top of the Wizard displays troubleshooting 
tips, which show you what to do if things go wrong at any time 
during the tracking process.

• More
This button at the bottom of the Wizard opens the original 
boujou 4.1 dialog box for a particular tool. For example, if you 
know that a specific tool setting will allow you to track your 
shot without having to go through the Troubleshooter, use this 
button.

• Back
This button at the bottom of the Wizard displays the previous 
Wizard, Related Task, or Troubleshooting page.

• Next
This button at the bottom of the Wizard displays the next 
Wizard, Related Task, or Troubleshooting page.

Timeline Pane
The Timeline, shown in Figure 2-48, displays the keyframes for 
masks, locators, and target tracks, and also the target tracking 
quality.

Figure 2-48: Timeline pane
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The Timeline pane is displayed when you click the Timeline tab 
at the bottom of the basebar in the default layout, as shown in 
Figure 2-49.

Figure 2-49: Timeline tab

The left side of the Timeline contains a list of project artifacts you 
can select to navigate through in the image sequence.

The right side of the Timeline displays the keyframes for masks, 
locators and target tracks, and also the target tracking quality. 
Gold tracks and named tracks are also displayed, making it easier 
for you to check that your gold tracks are evenly distributed 
throughout the sequence. It can be useful to see how the locator 
keyframes are distributed when you are working with survey 
points. Frames that contain default camera views, such as those 
created when key schedules are generated, are displayed in 
yellow on the Timeline.

Table 2-11 describes the Timeline submenu functions, which you 
can access by right-clicking any of the colored bars in the Timeline.

Table 2-11: Timeline submenu options

Artifact Menu Item Description

Sequence Properties Opens the Import Sequence 
dialog to display the image 
sequence properties.
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Sequence 
(cont.)

Define tracking 
region

Specifies a frame range to be 
tracked. When the cursor has 
changed to an I-beam, click and 
drag the image sequence bar to 
highlight the required frame 
range. The selected area 
changes color.

Delete tracking 
region

Clears a previously defined 
tracking range (the feature 
tracks are not deleted).

Feature track region Feature tracks the specified 
range of frames.

Masks Add keyframe Adds a mask keyframe.

Delete keyframe Deletes a mask keyframe.

Toggle visibility Makes the mask visible or 
invisible, depending on its 
current state, and sets a visibility 
keyframe.

Properties Opens the Polygon-based Mask 
dialog to display the properties 
for the selected mask.

Locators Delete keyframe Deletes a locator keyframe.

Properties Opens the Locators dialog to 
display the properties for the 
selected locator.

Target 
Tracks

Add keyframe Adds a target track keyframe.

Delete keyframe Deletes a target track keyframe.

Properties Opens the Target Tracks dialog 
to display the properties for the 
selected target track.

Track Tracks between the first and last 
keyframes.

Track range Tracks between the two nearest 
keyframes.

Table 2-11: Timeline submenu options

Artifact Menu Item Description
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When you first import an image sequence, the size of the Zoom 
bar defaults to the full length of the sequence. To restrict playback 
to the range specified by the Zoom bar, from the menu bar, click 
Edit and then click Play Range. Double-click the Zoom bar to 
expand it to the full length of the sequence.

Cache Bar
The Cache bar, shown in Figure 2-50, displays information about 
the memory used to cache an image sequence.

Figure 2-50: Cache bar

The Cache bar is located at the bottom right of the boujou 4.1 
window.

It shows the amount (in Mb) the image sequence occupies in the 
cache and the total amount of memory that has been allocated to 
the cache. The cache is the amount of physical memory 

Target 
Tracks 
(cont.)

Clear range tracking Clears the range between the 
two nearest keyframes.

Set range occluded Defines the range between the 
two nearest frames as occluded. 
The range changes color to 
black.

Clear range 
occluded

Changes an occluded range to 
untracked.

Named 
Tracks

Properties Opens the Named Tracks dialog 
box to display the properties for 
the selected track.

Gold Makes the selected track gold.

Flagged Flags the selected track for 
export.

Solves Properties Displays the camera solve 
information for the selected 
solve.

Table 2-11: Timeline submenu options

Artifact Menu Item Description
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boujou 4.1 uses to store image files for faster playback. When you 
launch boujou 4.1, it sets a cache size equal to approximately 
70% of the total available system RAM. 

You can view and change these settings in the Cache Properties 
dialog box (for details on caching images, see Chapter 3 Basic 
Functions).
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33Bas ic  Funct ions

This chapter describes the basic tracking process and the tools 
that you need to track the majority of shots as well as the 
advanced functions of the feature tracker and camera solver:

• Importing an Image Sequence on page 3-1
• Specifying a Camera on page 3-5
• Saving a Project on page 3-8
• Tracking Features on page 3-9
• Solving the Camera on page 3-15
• Using 3D Test Objects on page 3-20
• Caching Images on page 3-27
• Adding Project Notes on page 3-29

Importing an Image Sequence
The first thing you need to do when you launch boujou 4.1 is to 
import the image sequence that you want to track. boujou 4.1 can 
track a wide range of formats including 16-bit and HDR images, 
and any resolution. The image sequence contains all of the 
information that boujou 4.1 needs to calculate the motion of the 
camera that filmed the sequence.
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You use the Import Sequence dialog box, shown in Figure 3-1, 
to load an image sequence in boujou 4.1.

Figure 3-1: Import Sequence dialog box

Important
For details of the available image formats you can import into boujou 4.1, 
see Chapter 1 Introduction.

To import an image sequence:
1. Open the Import Sequence dialog box in any of the following 

ways:

Toolbox: Import Sequence 

Menu bar: Setup > Import Sequence

Keyboard shortcut: CTRL+I
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2. Use the navigation controls to browse for the image sequence.

Tip
 If you don’t know your drive mapping letters, use the 

Browse Network button at the top right of the dialog box to display 
an Explorer-style dialog box.

A preview of the image sequence is shown in the bottom half 
of Figure 3-2. This can be toggled on and off using the 
Preview button. Once you have selected an image, click 
Open.

Figure 3-2: Import Sequence preview image sequence

3. In the Name field, either leave the default name, Sequence 
1, or overtype it with the name you want to use for the 
sequence you have just loaded.

4. The File field shows the full path name of the first frame of 
the image sequence. You can edit this field to select a different 
image sequence, but it is easier to click the Browse button 
and return to the previous dialog box.
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5. Specify the type of camera move from the Move Type drop-
down list:

• Free Move
The camera is free to translate and rotate.

• Nodal Pan
The camera is fixed in 3D space and can only move in an 
angular sense (pan, tilt, and roll). An example of this 
would be a camera mounted on a tripod. Nodally panning 
moves provide no depth information about objects in the 
scene, so boujou 4.1 calculates its prediction points as 
though they were projected onto a sphere.

6. Specify the appropriate interlace setting from the Interlace 
drop-down list, as described in Table 3-1.

7. Enter the Start frame, Step, and End frame. By default the 
first frame and last frame that can be found in the specified 
directory are displayed. Step defaults to 1, but you may wish 
to step frames if you are working with a smooth, slow shot and 

Table 3-1: Interlace drop-down menu options

Interlace Setting Description

Not Interlaced Treat the frames as progressive and 
ignore fields.

Use Upper Fields 
Only

Keep the upper fields, discard the lower 
fields and interpolate to maintain the 
image pixel height.

Use Lower Fields 
Only

Keep the lower fields, discard the upper 
fields and interpolate to maintain the 
image pixel height.

Use Fields, 
Lower Field First

Use both fields, starting with the lower 
field, without interpolation. This 
doubles the length of the sequence in 
the boujou 4.1 Image window.

Use Fields, 
Upper Field First

Use both fields, starting with the upper 
field, without interpolation. This 
doubles the length of the sequence in 
the boujou 4.1 Image window.



Basic Functions

boujou 4.1 Reference Guide 3-5

only choose to work on a few frames. In this case, your 3D 
animation package interpolates between them. 

8. The Number from value controls the start frame index. It 
defaults to the frame number of the first frame of the 
sequence.

9. Select OK to confirm your selections.

If you want to make any changes to the camera or focal length 
settings, go to the Taskview. If not, you are ready to start feature 
tracking.

Specifying a Camera
The Cameras dialog box contains the settings for the camera type 
that was used to capture your footage. boujou 4.1 automatically 
chooses the appropriate camera settings based on the resolution 
of the image. For example, if your footage has a pixel resolution 
of 720x576, boujou 4.1 creates a PAL camera. If the resolution 
does not match any in the list, a custom camera with a pixel aspect 
ratio of 1 is created. You can create your own camera presets by 
editing a copy of the preset_cameras.bpc file from the \Extras 
folder on the installation disc. This file is not used by default; to 
make it active, from the Edit menu, click Preferences, expand 
Import and then click Preset Camera File Location to set the 
location (for details, see Appendix B boujou 4.1 Preferences).

A camera with the appropriate settings is created automatically as 
soon as the image sequence is imported when you click the OK 
button in the Import Sequence dialog box. At this point, you are 
ready to track. If you want, you can check or change any of your 
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camera or focal length settings in the Cameras dialog box, shown 
in Figure 3-3.

Figure 3-3: Cameras dialog box—Basic tab

To specify a camera:
1. Open the Cameras dialog in either of the following ways:

Taskview: Double-click Camera and then double-click the 
desired Camera artifact.

Menu bar: From the Setup menu, click Edit Camera.

2. In the Name field, either leave the default, Camera 1, or 
overtype it with the name you want to use to identify the 
camera.

Caution
If you are using Maya, don’t rename your camera to something 
beginning with a number. Maya doesn’t recognize object names 
starting with a number and will fail to load any animation data.

3. If you want to change the type of camera, choose a different 
preset from the Type drop-down list. If your camera settings 
are not covered by the presets, choose Custom.

4. If you clear the Show Compatible Cameras option, all of the 
preset camera types are displayed. If you choose a camera 
that isn’t compatible with the image size, boujou 4.1 issues a 
warning.

5. Enter the width and height of the Film Back (this is the area 
of the film that is exposed to light, or the size of the CCD in 
the case of digital cameras). The default Units can be set to 
either inches or millimeters from the drop-down list.
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6. Adjust the pixel aspect ratio if necessary. If you edit the 
default value, press the TAB key and boujou 4.1 will calculate 
the appropriate Film Back height. boujou 4.1 relies on a 
correct value of pixel aspect ratio; if the value is wrong, the 
solution quality may be poor.

Important
The pixel aspect ratio of an image is the area of a picture described 
by one pixel. For example, the pixel aspect ratio for a NTSC image on 
a 4:3 screen is: 486/720x4/3=0.9 (i.e. the pixels are 10% taller than 
they are wide).

7. Adjust the Lens Squeeze Ratio if required, for example, if 
the incorrect vertical field of view makes CG objects look 
wrong when using film resolution footage. For details and 
examples of this option, see Appendix C Lens Squeeze Ratio.

Caution
Not all 3D animation packages support lens squeeze. Please check 
before you decide to use the lens squeeze ratio.

8. Choose the Advanced tab, shown in Figure 3-4, if you wish 
to adjust the Principal Point position or apply a Radial 
distortion factor:

• The position of the principal point of the image is given 
as a percentage of the image size in x and y. The origin 
is assumed to be at the top left of the image. The values 
are percentages, but you can change the units from the 
Units drop-down list.
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• Use the up and down arrows to specify the amount of 
Radial distortion to be applied to the image sequence. 

Figure 3-4: Advanced tab in Cameras dialog box

9. Click OK. If you have any default camera views or an existing 
solve in the project, a warning message is displayed to alert 
you to the fact that the camera views or solve are no longer 
valid for the undistorted image. For more details, see section 
Assessing lens distortion in Chapter 4 Advanced Functions.

Important
Radial distortion can be assessed automatically or by using calibration 
lines. If you don’t know the radial correction factor for your camera/lens, 
leave the value as zero and use automatic assessment or the calibration 
lines to assess the level of distortion in the image. For more details, see 
section Assessing lens distortion in Chapter 4 Advanced Functions.

Saving a Project
Save your work regularly to avoid losing it in the event of system 
failure.

By default, boujou 4.1 automatically saves your project when it 
finishes feature tracking or camera solving. The autosaved file is 
written to a temporary directory:

Windows: C:\Documents and Settings\<Username> 
\Local Settings\Temp

OS X: /private/tmp
Linux:  /tmp
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If you have not previously saved the current project, the file saved 
after feature tracking is called Untitled Project_T_autosave.bpj 
and the file saved after camera solving is called Untitled 
Project_C_autosave.bpj. 

You can change this default location, or configure boujou 4.1 not 
to save automatically after tracking. To do this, from menu bar, 
click Edit, then click Preferences, expand Directories and then 
click Auto-save Files (for details, see Appendix B boujou 4.1 
Preferences). You can also manually save your project.

To save your current boujou 4.1 project:
1. Open the Save Project As dialog box in any of the following 

ways:

Toolbar: Save 

Menu bar: File > Save

Keyboard shortcut: CTRL+S.

2. Specify the location and the name of the boujou project file 
(.bpj) in which your project settings are to be saved

3. Click Save to save the file and close the dialog box.

Tracking Features
The feature tracking process identifies parts of the image that are 
different from the surrounding area and then matches them with 
similar features found in subsequent frames. boujou 4.1 finds 
features and matches them automatically; it then decides which 
tracks are moving consistently and passes them on to the solver. 
The quality of the final camera solve depends entirely on the 
quality of the feature tracks. Any feature tracks that start or end 
outside the selected range are also kept in their entirety, 
preventing any discontinuities in the 2D tracking data.

It is possible to feature track with different settings over different 
sections of the shot. The different sections of tracks are then 
merged together. boujou 4.1 allows multiple solves to be stored 
in a single project but allows only one set of feature tracks. If you 
feature track the same section twice, boujou 4.1 throws away the 
first set of tracks for that section (except for any that were made 
gold) and replaces them with the new ones.
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When a solve is created from a given set of feature tracks, a very 
close, one-to-one correspondence is created between each 
prediction and the feature track from which it was created. To 
boujou 4.1, they are inseparable. Therefore, if you feature track 
the same section again, the first set of feature tracks in that 
section only will be thrown away, but the predictions associated 
with the discarded tracks will be removed for the entire project.

This means that if a project already contains a solve and you 
feature track the entire project again, all of the predictions in that 
solve will be discarded. If you feature track only a subsection of 
the project again, the predictions associated with any feature 
tracks that cross this subsection will be removed for the entire 
project. The camera patch and any predictions for tracks that do 
not cross these sections will be kept.

When you complete a feature track in a project that has any 
existing feature tracks and solves, a message is displayed to alert 
you to this fact.

You use the Feature Tracking Properties dialog box, as shown 
in Figure 3-5 to manage the feature tracking process.

Figure 3-5: Feature Tracking Properties dialog box

To track features:
1. Open the Feature Tracking Properties dialog box, as shown 

in Figure 3-5 on page 3-10, in any of the following ways:

Toolbox: Track Features 
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Menu bar: 2D Tasks > Track Features 

Keyboard shortcut: F9

2. You can track the entire sequence by selecting the All Frames 
option (default). If you only want to track part of the 
sequence, choose Selected Range and enter the Start and 
End frames in the Tracking Range section.

3. A set of Advanced Properties, as shown in Figure 3-6, can 
be accessed by clicking the Advanced button.

Figure 3-6: Feature Tracking properties dialog box—Advanced



Basic Functions

3-12 boujou 4.1 Reference Guide

Table 3-2 describes the Advanced Properties you can set in 
the Feature Tracking Properties dialog box.

Table 3-2: Advanced Properties

Property Description

Search 
Distance (%)

Specifies how far ahead in the image boujou 4.1 
looks when building feature tracks. The value is a 
percentage of the total image size from edge to edge 
in any given direction. Fast moving shots need a 
larger search distance than slow moving shots 
because the features move a greater number of 
pixels from frame to frame. However, the greater the 
search distance the longer it takes to feature track a 
shot. The search distance in the boujou 4.1 feature 
tracker is adaptive. This means that it automatically 
increases if it cannot find a feature in the next frame. 
The Min and Max settings define the range of values 
of search distance that the feature tracker uses. This 
helps you to optimize the speed of feature tracking 
for a particular shot.

Sensitivity Determines the number of features found in a frame. 
Click and drag the slider arrow to change the value 
of sensitivity. Increasing the sensitivity increases the 
number of features found. 

The effects appear in the image preview as soon as 
you release the mouse button. Not all of the features 
shown in the preview become feature tracks. Only 
features that are successfully matched with features 
in subsequent frames become tracks. Increasing the 
sensitivity can sometimes have a detrimental effect 
because features will be found in the noise in the 
image, and this will make it less likely that boujou 4.1 
will be able to find good matches. For example, you 
may get better results for a greenscreen shot or a 
shot with a lot of blur, if you reduce the sensitivity.
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4. Click the Start button to begin feature tracking.

5. The Status bar shows the feature tracking progress and an 
estimated finish time. If you click the Camera Solve on 
Completion check box check box next to the camera icon, 
boujou 4.1 starts camera solving as soon as feature tracking 
is finished.

6. Tracking statistics are displayed in the Console pane during 
feature tracking.

7. You can make boujou 4.1 automatically save the current 
project after feature tracking and camera solving in 
Preferences (for details, see Appendix B boujou 4.1 
Preferences).

Feature Scale Controls the type of features that are detected. For 
example, for a wooden tabletop, the Normal scale 
setting finds features mainly in the texture of the 
wood grain, but the Large scale setting finds features 
at the corners of the tabletop. The advantage of using 
the Large setting is that the feature tracker ignores 
smaller, noisier features. The image preview shows 
you the effect each option has on the feature 
detection (not all features become tracks). Large 
scale features should work well for the markers in 
greenscreen or bluescreen shots.

Channel Select Enables you to choose which color channels are used 
for tracking. The image preview shows you the 
features that will be detected using the current 
selection. Not all features will become tracks.

Fast Tracking Makes the feature tracker run even faster, but with 
reduced accuracy. It is only available for Free Move 
shots and not Nodal Pans.

Table 3-2: Advanced Properties

Property Description
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Checking Feature Tracking Quality
You can examine the quality of your feature tracks in the Feature 
Tracking Info dialog box, shown in Figure 3-7.

Figure 3-7: Feature Tracking Info dialog box

For a camera solve to be successful, the feature tracking process 
must achieve the following:

• Several long tracks should be produced.

• At any one time there should be at least 10–15 evenly 
distributed tracks present.

• The features being tracked need to be distributed in 3D space 
and should not be constrained to a single plane.
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To check the quality of feature tracking:
1. Open the Feature Tracking Info dialog box. In the 

Taskview, expand Feature Tracking and then double-click 
the desired Feature Tracking artifact.

2. Examine the details in the Feature Tracking Info dialog box:

• The total number of tracks.

• The maximum and minimum track length.

• The median track length.

• A track length histogram showing the percentage of tracks 
that are in a particular length range.

• A list of the number of tracks in each frame. The values 
can be sorted by clicking the column heading.

When you are satisfied with the quality of your feature tracks, you 
can move on to camera solving.

Solving the Camera
Camera solving calculates the motion of the camera (position, 
orientation, and focal length) and the three dimensional position 
of most feature points detected in the scene.

You can manage the basic camera solving process in two stages, 
which are described in the following sections:

1. Performing a Complete Camera Solve on page 3-16

2. Performing an Adjust Camera Solve on page 3-18

Tip
For details on additional methods that provide you with additional control 
over the camera solving process, see Chapter 4 Advanced Functions.
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Performing a Complete Camera Solve
Performing a Solve Complete process automatically initializes 
the camera, generates 3D structure, and then optimizes the 
camera parameters. It is also possible to automatically correct for 
lens distortion and smooth the camera path as part of this process.

You use the Advanced Camera Solve Properties dialog box, 
shown in Figure 3-8, to manage the process.

Figure 3-8: Advanced Camera Solve Properties dialog box

To perform a complete camera solve:
1. Open the Advanced Camera Solve Properties dialog box 

in any of the following ways:

Toolbox: Camera Solve 

Menu bar: 3D Tasks > Solve Camera

Keyboard shortcut: F10

Important
In boujou 4.1, this Advanced Camera Solve Properties dialog box 
only covers Complete camera solving (where a new solve is created). 

2. Select or clear the Delete existing solves option to choose 
whether or not to keep existing solves in your project for 
reference or backup before beginning a new camera solve. If 
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you chose to keep existing camera solves, they can be 
accessed from the Taskview pane.

3. From the Options section, select whether you want to create 
a complete camera solve or one in sections based on frame 
ranges:

• All frames
Solves the camera for the entire duration of the image 
sequence.

• Selected Range
Solves the camera for the specified range of frames.

4. From the Solve Range section, specify the frame range if you 
specified Selected Range in the Solve Range section:

• Start
The first frame in the range.

• End
The last frame in the range.

5. In the Advanced solve refinement section, you can specify 
the following options if required:

• Optimize radial distortion parameters
Select this option if you want boujou 4.1 to automatically 
calculate the amount of lens distortion in your shot.

• Optimize Camera Path Smoothness
Select this option if your camera path is noisy. When the 
camera path has been smoothed, boujou 4.1 recalculates 
the 3D structure to make sure that it matches the new 
camera motion.

6. Click the Start button to begin camera solving.

The Status bar shows tracking progress, giving the estimated 
time of completion and the percentage completed.

When boujou 4.1 solves a camera, it creates 3D predictions. If 
boujou 4.1 cannot calculate a camera for the entire sequence, it 
does as much as it can. For very difficult shots this can mean that 
it calculates several track fragments for the sequence. These 
fragments cannot be joined together in boujou 4.1, but they can 
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show you where the problem areas are and can be joined together 
in a 3D animation package.

Tip
Tim Dobbert’s book, Matchmoving: the Invisible Art of Camera Tracking 
(Sybex, 2005, ISBN 0-7821-4403-9) contains a very useful chapter on 
how to connect two partial camera tracks in a 3D animation package.

Performing an Adjust Camera Solve
The Solve Adjust process can only be performed once you have 
got a camera solve. It carries out just the structure generation and 
optimization stages of the solving process. It is a very useful way 
of improving the camera solve after making small changes such 
as adding a locator or making some feature tracks gold.

You use the Solve Adjust dialog box, shown in Figure 3-9, to 
manage the process.

Figure 3-9: Solve Adjust dialog box

To perform an adjust camera solve:
1. Open the Solve Adjust dialog box by selecting Adjust Solve 

from the 3D Tasks menu.

2. From the User Solve drop-down list, select the camera solve 
that you want to adjust (multiple solves can exist in the same 
project).

3. In the Advanced solve refinement section, you can specify 
the following options if required:

• Optimize radial distortion parameters
Select this option if you want boujou 4.1 to automatically 
evaluate the value of lens distortion in your shot.



Basic Functions

boujou 4.1 Reference Guide 3-19

• Optimize camera path smoothness
Select this option if your camera path is noisy. When the 
camera path has been smoothed, boujou 4.1 recalculates 
the 3D structure to make sure that it matches the new 
camera motion.

4. Click the Start button to begin solve adjust.

Checking Camera Solve Quality
You can examine the quality of your camera solve in the Camera 
solve information dialog box, shown in Figure 3-10.

Figure 3-10: Camera solve information dialog box

To display the Camera solve information dialog box, in the 
Taskview, expand Camera solves and then double-click the 
desired Camera solve artifact.

The Camera solve information window shows the calculated 
focal length, camera X,Y,Z position, camera X,Y,Z rotation and 
residual for each frame. The values can be sorted in ascending or 
descending order by clicking the column headings. Focal length 
units can be selected from the drop-down list (the default is 
millimeters). The rotations can be expressed as either static Euler 
angles or moving Euler angles from the Rotation type drop-down 
list. The residual values do not appear when you first open the 
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Camera solve information dialog box. This makes the dialog 
box open much faster. Click the Calculate Residual Errors 
button to display the residuals for each frame.

Residual is a measure of the accuracy of the calculated camera 
track. It is the difference (in pixels) between the predicted position 
of a feature and its measured position in the image. The values 
shown in the Camera Tracking Information window are the 
average of all the residuals in a particular frame. You should look 
out for any residuals that are significantly higher than the ones 
around them as these sudden spikes show that there is a problem. 
Individual residuals can be displayed by turning on the Errors 
overlay. The Percent of Maximum values show the residual 
values for that frame as a percentage of the maximum residual.

Using 3D Test Objects
Test objects provide a quick and easy way of assessing the quality 
of the camera solve before you export to your animation package. 
It is good practice to check that the test object does not appear 
to slip or jump in the 2D view when you play through the sequence 
before you export the camera track.

The following sections describe how to work with 3D test objects:

• Inserting a 3D Test Object on page 3-21

• Manipulating 3D Test Objects on page 3-24
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Inserting a 3D Test Object
You use the Test Objects dialog box, shown in Figure 3-11, to 
insert a 3D test object.

Figure 3-11: Test Objects dialog box

To insert a 3D test object:
1. Open the Test Objects dialog box in any of the following 

ways:

Toolbox: Add Test Object 

Menu bar: Actions > Add Test Object

Keyboard shortcut: CTRL+T

2. A new test object is created as soon as the dialog box opens. 
By default this is a Ladybird named Test Object 1. It appears 
at the center of the floor grid.

3. To edit an existing test object, select it from the Artifact drop-
down list. To create another test object, choose <New Test 
Object> from the list. To delete a test object from the 
Artifact list, click the Delete button.
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4. Choose the Type of test object from the drop-down list: 
Arrow, Cube, Cylinder, Disk, Ladybird (default), Plane, 
Pyramid or Sphere, as shown in Figure 3-12.

Figure 3-12: Test object types

The Preview window shows what the selected test object 
type looks like before you insert it into your project. You can 
navigate in this window by using the standard controls.

5. The % Opacity controls the transparency of the test object. 
The default is 100% opacity.

6. Select the Draw Style of the test object: either wireframe or 
solid.

7. Choose the method of alignment from the Alignment drop-
down list:

• None (default)
The test object is created at the origin, sitting on the floor 
grid.

• Move
Acts like a positional constraint. It translates the test 
object to the selected predictions or geometric feature 
without changing its orientation.

• Orient
Acts like a rotational constraint. If only one prediction is 
selected, it changes the orientation of the object so that 
it faces the prediction. If two predictions are selected, it 
aligns the object with the line between the predictions. If 
three or more predictions are selected, it aligns the object 
with the resulting best-fit plane. The position of the object 
does not change.

• Move and Orient
Acts like a positional constraint and a rotational 
constraint. It moves and orients the test object to the 
selected predictions or geometric features.
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8. Select the alignment target from the Align To list box. This 
box contains the XY plane, the YZ plane and the ZX plane by 
default, and also any locators, geometric features or currently 
selected predictions that are in the project. Only the alignment 
targets valid for the selected Alignment method are 
available—the rest remain dimmed. For example, if you have 
selected one prediction, only the <Center of selected 
predictions> option is available. <Line though selected 
predictions> and <Plane through selected predictions> 
are both grayed. You can select more predictions from the 2D 
or 3D view with the Test Objects dialog still open.

9. The Use object's origin as a selected point check box 
allows you to use the test object as one of the selected 
alignment targets.

10. Click Apply to apply the changes.

You can make further adjustments to the size and position of the 
test object by using the Scale, Translate and Rotate 
manipulators (for details, see Manipulating 3D Test Objects on 
page 3-24). You can also import models as .obj files and use these 
as objects by placing them appropriately in the scene; however, 
these do not appear in the Test Objects dialog box.
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Manipulating 3D Test Objects
The Scale, Translate, and Rotate tools, shown in Figure 3-13, 
enable you to manipulate 3D test objects in 3D space.

Figure 3-13: Scale, translate, and rotate tools

Tip
You can also use Translate or Rotate tools to manipulate the coordinate 
frame. For details, see Chapter 4 Advanced Functions.

These tools provide a fast and interactive way of manipulating the 
size or position of a test object. 

To scale, translate, or rotate a 3D test object:
1. From the Transformations toolbar, ensure that the Select 

whether to edit the coordinate system or the test object 
button has the test object selected (the ladybird is highlighted 
on the button).

2. Display the desired manipulator in either of the following 
ways:

Transformations toolbar: Scale , Translate , or 

Rotate

Image window right-click menu: Scale, Translate, or 
Rotate

3. Use the manipulator that surrounds the object to apply your 
transformations as described in Table 3-3 on page 3-25.

Tip
If you want to accurately align your test object to a point or orient it 
to a specific plane, use the Test Objects dialog box.
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Table 3-3 describes how to use each of the Scale, Translate, and 
Rotate tools.

Table 3-3: Scale, Translate, and Rotate tools

Tool Manipulator Function

Scale

To scale 3D test objects:

• Drag the red cube to scale in 
the local X direction.

• Drag the green cube to scale 
in the local Y direction.

• Drag the blue cube to scale in 
the local Z direction.

• Drag the yellow circle to 
scale in local X,Y,Z 
simultaneously (proportional 
scaling).

Translate

To translate 3D test objects or the 
coordinate frame:

• Drag the red arrow to 
translate along the local X 
axis.

• Drag the green arrow to 
translate along the local Y 
axis.

• Drag the blue arrow to 
translate along the local Z axis.

• Drag the yellow cube to 
translate in the local XY plane 
(green plus red).

• Drag the cyan cube to 
translate in the local YZ plane 
(blue plus green).

• Drag the magenta cube to 
translate in the local ZX plane 
(blue plus red).
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Table 3-4 describes the commands you can select from the Test 
Objects right-click menu to work with 3D test objects.

Rotate

To rotate 3D test objects or the 
coordinate frame:

• Drag the red circle to rotate 
about the local X axis (tilt/ 
pitch).

• Drag the green circle to 
rotate about the local Y axis 
(pan/ yaw).

• Drag the blue circle to rotate 
about the local Z axis (roll/ 
bank).

Table 3-3: Scale, Translate, and Rotate tools

Tool Manipulator Function

Table 3-4: Test Objects commands

Property Description

Scale Displays the scale manipulator allowing you to 
scale the object.

Translate Displays the translate manipulator allowing you 
to translate the object. 

Rotate Displays the rotate manipulator allowing you to 
rotate the object. 

Center view 
on selection

Places the test object you have selected in the 
center of the camera view.

Rename Enables you to rename the test object.
Delete Deletes the test object.
Properties Opens the Test Objects dialog box.
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Caching Images
The cache is the amount of physical memory boujou 4.1 used to 
store image files for faster playback. When you first play through 
the image sequence, the playback rate is slow as the images are 
loaded into the cache. Once the complete sequence is cached, it 
plays at the frame rate you specify. To do this, from the menu bar, 
click Edit and then click Set playback rate.

You can view the default cache settings in the Cache bar (for 
details, see Chapter 2 User Interface). You can change the values 
in the Cache Properties dialog box, shown in Figure 3-14. 

Figure 3-14: Cache Properties dialog box

The Cache Properties dialog box tells you how much RAM 
memory boujou 4.1 has used caching the current sequence, how 
much RAM is allocated to the boujou 4.1 image cache, and what 
the total amount of system RAM available is. When you first open 
the Cache Properties dialog box, the number field displays the 
total available RAM, and the slider is at the 70% position.

To set the cache size:
1. Open the Cache Properties dialog box in either of the 

following ways:

Menu bar: From the Edit menu, click Cache Properties.

Cache bar: Double-click anywhere in this area.

2. Change the amount of memory allocated to the cache by 
moving the Allocated slider or entering a value in the number 
field.
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Important
If the total amount of RAM available in the image cache is shown as 
a negative value, you should set the amount manually. To do this, 
from the menu bar, click Edit and then click Preferences. Double-
click Miscellaneous and then click Total physical memory (MB) 
(for details, see Appendix B boujou 4.1 Preferences).

3. Click Close to close the dialog box and save your changes.

To flush the cache:
• Use either of the following methods:

Cache bar right-click menu: Flush Cache 

Menu bar: From the Edit menu, click Flush Cache.

The cache is automatically flushed before the start of feature 
tracking or camera solving. This helps to reduce the chances 
of boujou 4.1 running out of memory before tracking is 
finished. You can change this behavior in the Preferences 
(for details, see Appendix B boujou 4.1 Preferences).

To disable the cache:
• Use either of the following methods:

Cache bar right-click menu: Cache Enabled (clear the 
option)

Menu bar: From the Edit menu, click Cache Enabled.

If your image sequence is too long to fit in cache, you can 
either restrict the playback range or use a lower resolution 
image proxy.
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Adding Project Notes
You can add notes to your project file to describe how you tracked 
it using the Project Notes dialog box, shown in Figure 3-15.

Figure 3-15: Project Notes dialog box

These notes are saved with the project and can be referred to 
whenever the project is opened. 

The Project Notes dialog box can be opened from the menu bar. 
To do this, click File and then click Project Notes.
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44Advanced  Funct ions

This chapter covers the advanced tools required for complex or 
difficult camera moves, setting user preferences, and batch 
processing:

• Using Image Proxy Sequences on page 4-2
• Setting Focal Length Constraints on page 4-6
• Using Polygon Masks on page 4-10
• Importing an Image-based Mask on page 4-21
• Using Locators on page 4-23
• Using Target Tracks on page 4-30
• Describing Scene Geometry on page 4-42
• Solving the Camera with Advanced Tools on page 4-52
• Using Model-based Tracking on page 4-59
• Using Mesh Generation on page 4-67
• Using Feature Tracks on page 4-70
• Assessing Lens Distortion on page 4-80
• Setting User Preferences on page 4-94
• Using boujou 4.1_script for Command-line Processing on 

page 4-95
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Using Image Proxy Sequences
If your image sequence is too long to fit into the image cache, you 
can use lower resolution proxy images for playback. Tracking is 
still done on the original frames. You can import several proxy 
image sequences of different resolutions into your project and 
swap between them or turn them off as required.

The proxy tool functions are described in the following sections:

• Generating an Image Proxy Sequence
• Importing an Image Proxy Sequence on page 4-3
• Managing a Proxy Image Sequence on page 4-5

Generating an Image Proxy Sequence
You can generate a lower resolution proxy sequence using the 
Generate Image Proxy dialog box, shown in Figure 4-1. 

Figure 4-1: Generate Image Proxy dialog box

The generated sequence is automatically linked to the current 
image sequence.

To generate an image proxy sequence:
1. Open the Generate Image Proxy dialog box in either of the 

following ways:

Toolbox: Generate Proxy 

Menu bar: Setup > Generate Proxy Sequence

2. Under the Output section of the dialog box, select the 
Filename and Format. Use the Browse button to change the 



Advanced Functions

boujou 4.1 Reference Guide 4-3

folder that the proxy images are written to. The Output file 
name format section gives a preview of how the files are 
named based on the current settings. For details of supported 
image file formats, see Table 1-1 on page 1-2.

3. Under the Output size section, specify the size of the proxy 
images. Either leave the default, Half size, or select one of the 
other options from the drop-down list: No resize, Custom, 
Quarter, or Eighth. If you choose the Custom option, you 
can specify the image Height and Width in pixels.

4. Select the Assign proxy to current sequence check box to 
start using the image proxy straight away.

5. Click the OK button to start creating the images. Progress can 
be monitored in the Status bar.

Importing an Image Proxy Sequence
If you have created a lower resolution sequence from a third-party 
animation package, or if you have already generated one for the 
current image sequence, you can import it into your current 
boujou 4.1 project and use it as a proxy. You use the Import/
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Modify Proxy dialog box, shown in Figure 4-2, to import an image 
proxy sequence.

Figure 4-2: Import/Modify Proxy dialog box

To import an image proxy sequence:
1. Open the Import/Modify Proxy dialog box in either of the 

following ways:

Toolbox: Proxy 
Menu bar: Setup > Import/Edit Proxies

2. If you want to import a new proxy sequence, leave the 
Artifact field set to <New Proxy>. If you want to edit the 
settings of an existing proxy, select it from the drop-down list.

3. Click the Browse button to select the sequence that you want 
to use as a proxy, or type the full path in the File Name field.

4. In the Name field, either leave the default name, Proxy 1, or 
overtype it with the name you want to use for the current 
proxy.

5. Specify the appropriate interlace setting from the Interlace 
drop-down list. The settings are the same as in the Import 
Sequence dialog box.
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6. Choose the sequence that you want to associate the proxy 
from the Sequence drop-down list. The current version of 
boujou 4.1 does not support multiple image sequences so the 
drop-down list only contains Sequence 1.

7. The Start frame, Step, and End frame are set automatically 
from the available frames on disk. You can make any changes 
by editing the values in the text boxes. If the Preview button 
is activated, the start frame and end frame are displayed at 
the bottom of the dialog box.

8. Click the OK button to apply your changes and close the dialog 
box.

Managing a Proxy Image Sequence
When an image proxy is being used, the details are displayed in 
the right of the Status bar, as shown in Figure 4-3.

Figure 4-3: Proxy image details in Status bar

Right-click the Using Proxy text to display a different proxy or 
to switch the proxy off.

The proxy is a property of the image sequence and so all the 
available proxies are listed in the Import Sequence dialog box. 
To open this dialog box, in the Taskview, expand the Image 
Sequence and then double-click the Sequence1 artifact. When 
the Import Sequence dialog box appears, click the Proxy tab, 
as shown in Figure 4-4.

Figure 4-4: Import Sequence dialog box—Proxy tab
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Setting Focal Length Constraints
When you import a sequence into a new project, boujou 4.1 
assumes that your camera has a constant focal length of unknown 
value. If you have any additional information about the focal 
length of the camera, you can give it to boujou 4.1 using the Focal 
Length properties dialog box, shown in Figure 4-5.

Figure 4-5: Focal Length properties dialog box

To edit the focal length:
1. Open the Focal Length properties dialog box in any of the 

following ways:

Toolbox: Focal Length Constraints 
Menu bar: Setup > Edit Focal Constraints

Taskview: Focal Length branch > Focal Length 1 artifact (the 
artifact is created as soon as you have imported an image 
sequence into the project).

2. The name of the current Camera is displayed at the top of the 
dialog box. 

3. You can change the working units from the Units drop-down 
list. The options are millimeters (default), inches, or pixels.

4. Choose the focal length Type that applies to the whole 
sequence. Either leave the default, Constant unknown, or 
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select another focal length type from the drop-down list, as 
described in Table 4-1.

The User Fixed or Initialized focal length value can be typed 
in the Value field. The default value is 35 mm.

Using the Advanced Mode
The default constraint is a keyframe on the first frame and another 
one on the last frame. If you did not change any of the settings 
when you first opened the Focal Length properties dialog box, 
both keyframes are set to unknown focal length and the range 
between them is set to Constant.

You can set more complex focal length constraints in the 
Advanced mode in the dialog box, shown in Figure 4-6, in which 

Table 4-1: Focal Length Types

Focal Length 
Type Description

Variable 
unknown

There is zoom in the shot, but you do not 
know how much.

Variable 
initialized

There is zoom in the shot, and you’ve got 
a rough idea of the starting focal length. 
Giving boujou 4.1 an approximate value of 
focal length (+/- 25%) can reduce solve 
times significantly.

Constant 
unknown

There is no zoom and you do not know the 
focal length.

Constant 
initialized

There is no zoom and you have a rough idea 
of what the focal length was. Giving 
boujou 4.1 an approximate value of focal 
length (+/- 25%) can reduce solve times 
significantly.

User Fixed There is no zoom and you know exactly 
what the focal length is.
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you can add keyframes to describe shots that are part zoom and 
part constant focal length.

Figure 4-6: Focal Length properties—Advanced Mode

To set advanced focal length constraints:
1. Open the Focal Length properties dialog box and click the 

Advanced mode button (for details on opening the Focal 
Length properties dialog box, see Setting Focal Length 
Constraints on page 4-6).

2. To add a new keyframe, enter a frame number into the 
Keyframe box at the bottom of the dialog box and then click 
the Add button. A new frame appears in the frames list and 
there are now two ranges with constant unknown focal length.

3. Select the focal length type for a Frame from the drop-down 
list. The focal length at a Frame can either be unknown 
(default), approximate or exact. If you choose 
approximate or exact, you can enter the value in the field 
to the right (a value of 35 mm appears in here by default if 
you choose either of these two types). The approximate type 
is equivalent to initialized in the Basic mode.

4. The Range between keyframes can either be Constant or 
Variable, as shown in Table 4-2 on page 4-9. You can only 
set a range to Constant if the keyframes at either end have 
the same value. If one keyframe has Unknown focal length 
and the other has Approximate focal length, you can only 
choose the Variable option (see Table 4-2). 
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Both keyframes need to have the same focal length type for 
the Constant range option to be available.

Caution
If you add more than two focal length keyframes, as shown in Figure 
4-7, you need to use the scroll bar on the right of the dialog box to 
see them all. This may seem obvious but it can be very easy not to 
notice and start editing the wrong range, or to forget to change a 
range back from Variable to Constant.

Table 4-2: Range between keyframes

1st End 
Condition

2nd End 
Condition

Range - 
Constant

Range - 
Variable

Exact Exact User Fixed Variable 
Initialized

Approximate Approximate User Initialized Variable 
Initialized

Unknown Unknown Constant 
Unknown

Variable 
Unknown

Exact Approximate - Variable 
Initialized

Exact Unknown - Variable 
Unknown

Approximate Unknown - Variable 
Unknown
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Figure 4-7: Multiple focal length keyframes

5. Click OK to apply your changes and close the dialog box.

Using Polygon Masks
You can use masks to hide elements of the image or to concentrate 
on an area of particular interest. You can mask out features that 
may cause confusing tracks such as water, fire, or smoke, or you 
can mask out the background and just track a foreground object. 
The polygon mask tool allows you to quickly create a mask and 
keyframe it during the sequence. Multiple masks can also be 
created and be combined with imported masks. In boujou 4.1, 
areas within masks can be specified and subtracted from the mask 
to create masks with holes.

The following sections describe the polygon mask tools:
• Creating a Polygon Mask
• Editing a Polygon Mask on page 4-12
• Creating a Polygon Mask with a Hole on page 4-13
• Editing Polygon Mask Properties on page 4-15
• Importing and Exporting Polygon Masks on page 4-17
• Manipulating Polygon-based Masks on page 4-19
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Creating a Polygon Mask
The outline of a polygon mask can be drawn by clicking in the 
Image window to create the vertices of the polygon. Do not add 
too many vertices as this makes the mask more time-consuming 
to edit, and you do not need the mask to precisely match the 
outline of this shape that you want to hide.

To create a polygon mask:
1. Enter polygon mask creation mode in either of the following 

ways:

Toolbox: Add Polygon Masks 

Menu bar: 2D Tasks > Add Polygon-based Mask

2. Move the cursor over the image and click to create the first 
point of the mask outline. A magenta dot appears.

3. Move the cursor again and a yellow line is drawn between the 
first point and the cursor arrow. Click again to create a second 
point and the first line segment changes color to magenta. 
Continue to create points until you have created the required 
mask shape. You must have a minimum of three points to 
create a mask.

4. To close the mask outline, click the first point to close the 
outline (the cursor changes to a hand to show that you are 
about to complete the mask). A polygon mask is immediately 
created and appears in the Image window. A keyframe is also 
created at the current frame.

5. The mask can be animated by adding additional keyframes 
throughout the image sequence. Editing the mask creates a 
new keyframe.
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Editing a Polygon Mask
To ensure that the polygon mask covers the image object from 
frame to frame, edit it at certain points along the Timeline to add 
keyframes. boujou 4.1 interpolates between the keyframes you 
create.

To edit a polygon mask:
1. Select the polygon mask to be edited by clicking the outline. 

When a mask is selected for editing, the outline is drawn in 
yellow, the polygon vertices are visible, and the mask 
manipulator tool appears in the center of the mask.

2. Edit the mask using the following controls:

• To move a point, click a yellow dot and drag. When 
selected for editing, points appear red.

• To add a new point, hold down CTRL+SHIFT and click 
the outline where you wish to add a point. The newly 
created point is added to the selection, and can be 
immediately moved with CTRL+drag.

• To move multiple points, CTRL+click points or lines. 
When you select the last point, keep the mouse button 
held down and then drag.

• To move a line, click the line and drag—this moves two 
points. When selected for editing, lines appear red.

• To shuttle frames, SHIFT+drag.

3. When the mask is selected, the mask manipulation tool, 
shown in Figure 4-8, appears in the center.

Figure 4-8: Mask manipulation tool
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4. Use the following tools to manipulate the mask in the Image 
window:

• To translate the mask, click and drag the center of the 
tool.

• To rotate the mask, click and drag the arrow on the 
right.

• To scale the mask, click and drag the T-bar on the left.

• To move the pivot of the mask tool , CTRL+LMB - drag 
(the pivot is the center of rotation/ scaling).

• To re-center the pivot, CTRL+SHIFT+LMB - click.

• To invert the mask, right-click the mask and select 
Invert Mask from the displayed window. The area 
defined outside the mask borders is masked. Hiding the 
background in this way can be useful for isolating and 
tracking moving objects.

5. Once you have finished editing the polygon mask, deselect it 
in any of the following ways:

Image window: Click away from it

Menu bar: Edit > Clear Selections

Status bar: Clear All Selections button 

6. Mask keyframes are displayed in the Timeline. You can move 
keyframes by clicking them and dragging, and you can add or 
delete keyframes by right-clicking and selecting the 
appropriate option from the menu.

Creating a Polygon Mask with a Hole
In some complex shots with multiple moving elements, it can be 
necessary to make doughnut-shaped masks. boujou 4.1 enables 
you to perform simple boolean operations on two or more masks. 
This can make building complex polygon shapes much easier.
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To create a polygon mask with a hole:
1. Create the first mask, as shown in Figure 4-9. For details on 

doing this, see Creating a Polygon Mask on page 4-11.

Figure 4-9: First mask

2. Create a second mask inside the first mask, as shown in Figure 
4-10. This will be the hole.

Figure 4-10: Second mask (hole)

3. Select the first mask and choose Manage Holes from the 
right-click menu. The Subtract a mask dialog box, shown in 
Figure 4-11, is displayed.

Figure 4-11: Subtract a mask dialog box
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4. Select the second mask then click the Make a Hole button. 
The second mask is extracted from the first, as shown in 
Figure 4-12.

Figure 4-12: Hole in mask

The hole moves with the first mask, but you can also keyframe 
it separately.

Editing Polygon Mask Properties
Once you have created or imported a polygon mask, you can edit 
its properties using the Polygon-based Masks dialog box, shown 
in Figure 4-13.

Figure 4-13: Polygon-based Masks dialog box
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To edit polygon mask properties:
1. Open the Polygon-based Masks dialog box in any of the 

following ways:

Taskview: Masks branch > Mask artifact

Timeline right-click menu: Mask > Properties

Image window 2D Mode view right-click menu: 
Properties

Image window: select the mask and then use the keyboard 
shortcut CTRL+ENTER

Keyboard shortcut: CTRL+M

2. Edit any of the following properties in the Polygon-based 
Masks dialog box:

• Artifact: Select which mask you want view or edit the 
properties for from the drop-down list.

• Delete: Deletes the currently selected mask.

• Name: Either leave the default name, Mask 1, or overtype 
it with the name you want to use for the mask.

• Invert Mask: Hide either the area inside or outside the 
outline of the polygon-based mask. Select this check box 
to hide the area outside the mask.

• OK: Click this button to apply the changes and close the 
dialog box.

• Keyframing: Lists the keyframes that were set for that 
particular mask.

• Toggle visibility from current frame

Make the mask visible or invisible, depending on its 
current state, and set a visibility keyframe.

• Delete Keyframe

Delete individual keyframes.

• Manage holes: Displays the Subtract a mask dialog 
box, shown in Figure 4-14, in which you can use the 
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selected mask to cut a hole in another mask. The number 
of holes in a mask is listed to the right of this button.

Figure 4-14: Subtract a mask dialog box

• Follow track path: Attaches a mask to a selected 2D 
track (feature track or target track) in order to animate it. 
The mask now follows the path of the 2D feature.

Important
Once a mask has been attached to a track, no further keyframing is 
possible.

Importing and Exporting Polygon Masks
Polygon-based masks can be imported or exported between 
boujou 4.1 projects. The mask is scaled to fit the image size of the 
new sequence.

You export masks using the Export Polygon Based Masks 
dialog box, shown in Figure 4-15.

Figure 4-15: Export Polygon Based Masks dialog box

To export a polygon mask:
1. Open the Export Polygon Based Masks dialog box in either 

of the following ways:
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Toolbox: Export Poly Mask 

Menu bar: Export > Export Polygon Based Masks

2. Enter a name for the mask file that you are exporting in the 
Filename field. Click the Browse button to change the 
directory that the file is written to. The mask file has the 
extension .bmk.

3. You can choose which mask you want to export from the 
Masks to Export box. Several masks can be written to the 
same .bmk file.

4. Click OK to export the *.bmk file and close the dialog box.

You import masks using the Import Masks dialog box, shown in 
Figure 4-16.

Figure 4-16: Import Masks dialog box

To import a polygon mask:
1. Open the Import Masks dialog box in either of the following 

ways:

Toolbox: Import Poly Mask 

Menu bar: 2D Tasks > Import Polygon Based Masks 

2. Browse for the mask file (*.bmk) that you want to import from 
the Import Masks dialog box.
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If the image sequence in the new project contains a different 
number of frames to the project the mask was exported from, 
the warning window, shown in Figure 4-17, is displayed.

Figure 4-17: Frame numbers do not match warning message

3. In the warning window, select one of the following options:

• Scale: Scale the mask keyframes to fit the new sequence 
length.

• Don’t Scale: Import the mask keyframes with the same 
frame spacing that they had when they were created.

4. The mask is automatically scaled to fit the size of the new 
image sequence.

Manipulating Polygon-based Masks
Table 4-3 describes the commands you can select from the 
Polygon-based masks right-click menu.

Table 4-3: Polygon-based masks commands

Menu item Description

Add Keyframe Adds a new mask keyframe at the current 
frame. Also available by right-clicking the 
Timeline.

Delete selected 
keypoints

Deletes the currently selected points on 
the mask outline. The number of points 
which form the mask outline cannot be 
keyframed, so the selected points are 
permanently deleted.

Add keypoint Adds a point to the mask outline at the 
current cursor position. The number of 
points which form the mask outline can 
not be keyframed, so the new point is 
added for the entire sequence.
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Invert Mask Changes the masking from mask inside 
the outline (default) to mask outside the 
outline and vice versa.

Toggle visibility Makes the mask visible or invisible, 
depending on its current state, and sets a 
visibility keyframe. Also available by right-
clicking the Timeline.

Manage Holes Opens the Subtract a mask dialog box.
Rename Opens the Rename Artifact dialog box.
Delete Deletes the currently selected mask.
Follow Track Creates a translation key frame based on 

a selected mask and a single 2D track, 
which causes the mask to follow the path 
of the 2D track.

Delete Keyframe Deletes the current mask keyframe. Also 
available by right-clicking the Timeline.

Properties Displays the Polygon-based Masks 
properties dialog box. Also available by 
right-clicking the Timeline.

Table 4-3: Polygon-based masks commands

Menu item Description
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Importing an Image-based Mask
You can import any number of image-based masks within a 
project, using the Import Image-Based Mask dialog box, 
shown in Figure 4-18. These image-based masks can be used in 
conjunction with any polygon-based masks you have created in 
boujou 4.1.

Figure 4-18: Import Image-Based Mask dialog box

To import an image-based mask:
1. Open Import Image-Based Mask dialog box in any of the 

following ways:

Toolbox: Image Based Mask 

Menu bar: 2D Tasks > Import image-based masks

Keyboard shortcut: CTRL +H

2. The Artifact drop-down list displays all of the image-based 
masks that are in the current project. If you are importing a 
new mask, make sure that <New Image-Based Mask> is 
selected.
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3. The File Name field contains the full path and name of the 
first frame of the mask sequence or the complete movie file. 
If you want to use a different sequence, either type the new 
path into this field or select the Browse button to display the 
Import Sequence browse dialog box.

4. In the Name field, either leave default name, Imported 
image-based mask 1, or overtype it with the name you want 
to use for the Image-based mask.

5. Specify the required Interlace option from the drop-down 
list.

6. Select the Mask Type from the drop-down list. The options 
in this list relate to the image object imported as a mask, as 
shown in Table 4-4.

7. Specify the Start Frame, Step, and End Frame for the mask 
sequence. If you use a single frame as your mask, keep the 
default values and the frame will be used throughout the 
whole image sequence. If you use a sequence of frames as 
your mask, they are scaled to fit the current timeline. The size 
of the mask images is also scaled automatically to fit the 
current sequence.

8. The Preview button turns the preview of the first and last 
frames of the mask sequence on and off.

9. Click OK to apply the changes and close the dialog box.

Table 4-4: Mask Type options

Mask Type Description

Include white Track the white areas only.
Include black Track the black areas only.
Exclude white Do not track the white areas but track 

everything else.
Exclude black Do not track the black areas but track 

everything else.
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Using Locators
The main uses of Locators are:

• Adding extra 3D points
Sometimes boujou 4.1 fails to track an important feature in 
your shot and you do not get a 3D reference point for this 
feature when you export the camera. To pick out additional 3D 
points you can add a locator after camera solving and 
boujou 4.1 will use the current camera solution to predict 
where the feature will be in 3D space. You only need to add 
a minimum of two keyframes and boujou 4.1 fills in the gaps.

• Improving the camera solve
Adding locators can improve your camera solve solution and 
3D structure. Do an Adjust Solve after adding locators and 
you can get better 3D structure and camera path. This is a 
very useful technique for fixing problem tracks and the Adjust 
Solve means that you get very fast feedback on any editing 
you do. Sometimes this technique can also be used to join 
multiple camera solve fragments (partial solves). Make sure 
that the keyframes are evenly spaced along the Timeline, and 
a minimum of 3-5 keyframes is recommended. 

• Manual tracking
You can use the locator tool before feature tracking to create 
a manual feature track. The track is positioned by eye, one 
frame at a time. These locator tracks are set as gold by 
default, and so guide the automatic feature tracking and help 
create more tracks in problem areas. This is useful when 
boujou 4.1 has difficulty in finding enough feature tracks on 
its own (due to motion blur or other effects). 2D Locator tracks 
created in this way only exist on the keyframes that you create 
them on, so the more keyframes the better.

• Non-consecutive feature tracking
Add a locator with a keyframe on each of the frames that you 
want to match between to help guide the non-consecutive 
feature tracker.
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• Survey points
Locators can be connected to and disconnected from survey 
points, enabling you to improve the quality of the 3D structure 
using survey data measured on set.

The following sections describe the locator tools:

• Adding Locators

• Editing Locator Positions on page 4-27

• Editing Locator Properties on page 4-28

• Manipulating Locators on page 4-29

Adding Locators
To add a locator, you need to manually identify its position with 
two or more keyframes. Each locator keyframe that you specify 
adds another key to the solve key schedule. Adding too many 
keyframes or adding keyframes too close together can slow down 
camera solving significantly.

To add a locator:
1. Enter Edit mode in either of the following ways:

Toolbox: Add Locators 

Menu bar: 2D Tasks > Add Locator

The cursor changes to a cross hair. 

2. Click the image to create the first keyframe. A small, green 
box appears at the cursor position and the Zoom Tool pane 
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is displayed (unless the Zoom Tool pane has been hidden), 
as shown in Figure 4-19.

Figure 4-19: Zoom tool pane

3. In the Status bar below the main window the Toggle Edit 
Mode button is shown as pressed, indicating that Edit mode 
is now on, and the new locator is identified in the Artifact area 
of the status bar as shown in Figure 4-20.

Figure 4-20: Toggle Edit Mode on and Locator artifact

4. Hold the mouse button down and drag to roughly adjust the 
position of the locator in the main window. For fine adjustment 
use the Zoom Tool. The adjustment is done using the 
standard navigation tools: SHIFT+RMB controls the amount of 
zoom and SHIFT+LMB+RMB (or SHIFT+MMB if you have that 
Preference set) controls the position of the locator as shown 
by the crosshairs.

5. Move to another frame and add a second keyframe. You 
cannot shuttle through the sequence in the Zoom Tool pane, 
but SHIFT+LMB in the main window or clicking and dragging 
in the Timeline both work as normal. If you have already 
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tracked the camera, boujou 4.1 starts working out where the 
3D point will be as soon as you create the second keyframe. 
In the main window a small plus (+) appears near the center 
of the square to show where boujou 4.1 thinks your 3D point 
should be, based on the current camera solution. The Zoom 
Tool is always centered on the predicted position of the 
locator unless you are on a keyframe.

6. If the predicted position of the locator seems to drift as you 
play through the sequence, add more keyframes. Normally 3 
or 4 keyframes are enough if you just want to add an extra 
3D point to a good camera solution.

7. If you are adding locators to try and improve the camera 
solution, adding more keyframes is a good idea. After you 
have added the locators, do an Adjust Solve to refine the 
camera solve solution.

8. If you are adding locators as manual feature tracks prior to 
camera solving, you should try to add as many keyframes as 
possible, especially in the areas where the automatic feature 
tracker may have difficulties (blurred frames, for example). 
Locators are ’gold’ tracks; if you run the automatic feature 
tracker after adding a gold track, it is guided by the gold tracks 
and tries to find more automatic tracks that move in a similar 
way. The Zoom Tool is blank on all non-keyframe frames if 
the camera has not yet been tracked.

9. The locators overlay is switched on as soon as you start adding 
a locator. In the 3D view locator predictions are displayed as 
purple dots.

10. When you have finished adding keyframes to the locator click 
the Toggle Edit Mode button again to leave Edit mode and 
then de-select the locator.



Advanced Functions

boujou 4.1 Reference Guide 4-27

Editing Locator Positions
You may decide to change the position of a locator in one or more 
keyframes. This may be because you want to refine the accuracy, 
you made a mistake when you first created it, or you want to put 
it elsewhere in the scene.

To edit a locator’s position:
1. In the main boujou 4.1 window select the locator that you 

want to edit in either of the following ways:

Image window: Click the locator or drag a box around it

Locator properties dialog box: Artifact drop-down list (for 
details, see Adding Locators on page 4-24)

2. Switch on Edit mode in any of the following ways:

Status bar: Toggle Edit Mode 

Menu bar: Edit > Toggle Edit Mode

Image window right-click menu: Toggle edit mode

3. The zoom box appears around the locator and the Zoom Tool 
is displayed (unless the Zoom Tool pane has been hidden). 
The zoomed-in area of the image only appears in the Zoom 
Tool if the camera has been tracked or if the current frame 
is a locator keyframe.

Important
You can see where the locator keyframes are by expanding the 
Timeline. You can navigate between the keyframes of the currently 
selected locator by using the Next Keyframe and Previous 
Keyframe buttons in the Play Controls toolbar.

4. You can edit the locator position as before by making rough 
adjustments in the main window by clicking and dragging, and 
making fine adjustments in the Zoom Tool. 

5. You can only edit the currently selected locator when you are 
in Edit mode. If you want to edit a different locator, you must 
toggle Edit mode off, select the locator, then toggle Edit mode 
back on.

6. If you are in Edit mode and the camera has been tracked, 
editing the position of a locator on a non-keyframe frame 
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automatically adds a new keyframe.

7. If you need to edit lots of locators quickly, you can do so 
without toggling Edit mode on and off each time. Select a 
locator and either drag it to a new position in the main window, 
or open the Zoom Tool pane and make more precise 
adjustments with the Zoom Tool. You are only in Edit mode 
for as long as you have the mouse button pressed. This means 
that you can immediately select another locator in the main 
window and start editing it in the Zoom Tool pane.

8. If you click the Add Locator button when you are editing a 
locator in Edit mode, you immediately start editing the new 
locator.

Editing Locator Properties
Once you have created a locator, you can edit its properties in the 
Locators dialog box, shown in Figure 4-21.

Figure 4-21: Locators dialog box

To edit location properties:
1. Open the Locators dialog box in any of the following ways:

Taskview: Locators branch > Locator artifact

Timeline right-click menu: Properties

Image window 2D Mode view right-click menu: 
Properties

Image window 2D Mode view: Select the locator and use 
the keyboard shortcut CTRL+ENTER

Keyboard shortcut: CTRL+L
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2. Edit any of the following properties in the Locators 
properties dialog box:

• Artifact: Select which locator you want view or edit the 
properties for from the drop-down list

• Delete: Deletes the currently selected locator.

• Name: Either leave the default name, Locator 1, or 
overtype it with the name you want to use for the locator.

• Delete Keyframe: Delete individual keyframes from the 
list of keyframes that were set for that particular locator 
in the area at the bottom of the dialog box. Click a 
keyframe to jump to that frame in the main boujou 4.1 
window.

• OK: Click this button to apply the changes and close the 
dialog box.

Manipulating Locators
Table 4-5 describes the commands you can select from the 
Locators right-click menu to manipulate locators.

Table 4-5: Locators commands

Menu Item Description

Toggle edit 
mode

Turns Edit mode on or off.

Delete 
keyframe

Deletes the current keyframe. 

Add keyframe Adds a keyframe at the current frame.
Gold Toggles the gold status of the locator. Locators 

are gold by default.
Flag for 
export

Toggles the export flag status of the locator. 
Locators are flagged for export by default.

Connect 
Survey Point

Connects a selected locator to a selected 
survey point. Select the survey point using a 
model vertex and then CTRL+select the locator 
in one of the other views.
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Using Target Tracks
The target tracking process uses pattern matching to calculate its 
tracks. This makes it useful for tracking things that would cause 
problems for the automatic feature tracker, such as circular 
bluescreen or greenscreen markers. The automatic tracker finds 
false tracks around the edges of circular markers which do not 
move consistently with the camera motion. The target tracker 
tracks the center of the marker, as shown in Figure 4-22, resulting 
in an accurate and consistent track.

Figure 4-22: Target tracker

Target tracking is done as a separate process to automatic feature 
tracking. Add your target track keyframes (you need a minimum 
of two) and then track between them. The target tracker uses a 
weighted average of the pattern at each keyframe, which enables 
you to track features that change in shape due to perspective 

Center view 
on selection

Changes the camera view so that the currently 
selected object is in the center of the Image 
window.

Disconnect 
Survey 
Point(s)

Disconnects selected locators from survey 
points to which they are connected.

Rename Enables you to rename the locator.
Delete Deletes the selected locator.
Properties Displays the Locators properties dialog box.

Table 4-5: Locators commands

Menu Item Description
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effects (a circular marker becomes more elliptical as the camera 
moves around it).

If you select a target track and go to one of its keyframes, it is 
displayed as two concentric boxes and a small plus (+). The plus 
marks the position of the center of the feature that you are trying 
to track. The inner, green square is the comparison region and 
the outer, blue square is the search region.

The comparison region is the pattern that you are trying to match. 
If your pattern is a circle, the comparison region should be slightly 
larger than the diameter of the circle. If the comparison region is 
too large, there is lots of spurious information that confuses the 
pattern matching. If the region is too small, the outline of the circle 
is hard to distinguish against the background.

The search region works in the same way as the search distance 
in the Advanced Feature Tracking properties dialog box. It is 
the region that the target tracker looks at in the next frame to find 
the pattern that is being tracked. Increase the search region size 
for fast-moving shots and reduce it for slow-moving ones.

The sizes of the comparison and search regions can be keyframed, 
so can be set interactively by clicking and dragging on the corners 
of the boxes. To set the default sizes, from the menu bar click Edit, 
then click Preferences and expand Target Tracking (for details, 
see Appendix B boujou 4.1 Preferences).

The following sections describe target tracking tools:

• Adding Target Tracks on page 4-32

• Editing Target Tracks on page 4-35

• Checking Target Tracks Quality on page 4-37

• Editing Target Tracks Properties on page 4-38

• Manipulating Target Tracks on page 4-41
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Adding Target Tracks
You add target tracks to define the region that you want to track. 
You must specify two or more frames; each frame in the defined 
tracking region creates a target track keyframe.

To add a target track:
1. Enter Edit mode in either of the following ways:

Toolbox: Add Target Track 

Menu bar: 2D Tasks > Add Target Track 

The cursor changes to a cross hair. 

2. Click the image to create the first keyframe. A green plus (+) 
appears at the center of the region that you want to track, 
surrounded by the comparison region and the search region. 
The Zoom Tool is displayed (unless the Zoom Tool pane has 
been hidden), and the green box surrounding the target 
region in the main window shows the area that appears in the 
Zoom Tool, as shown in Figure 4-23. 

Figure 4-23: Zoom Tool view of target track
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3. In the Status bar below the main window the Toggle Edit 
Mode button is shown as pressed, indicating that Edit mode 
is now on, and the new target track is identified in the Artifact 
area of the status bar as shown in Figure 4-24.

Figure 4-24: Toggle Edit Mode button pressed

4. Hold the mouse button down and drag to roughly adjust the 
position of the target track in the main window. For fine 
adjustment, use the Zoom Tool. The adjustment is done 
using the standard navigation tools: SHIFT+RMB controls the 
amount of zoom and SHIFT+LMB+RMB (or SHIFT+MMB if you 
have the MMB Preference set) controls the position of the 
locator as shown by the crosshairs.

5. Adjust the size of the comparison region and the search region 
by clicking and dragging the corners of the squares. When you 
are in Edit mode this can only be done with the Zoom Tool.

6. Go to another frame where this feature is visible and click it 
to set another keyframe. If the feature changes shape by a 
significant amount, you may need to add more keyframes.

7. If the feature is hidden and then comes back into view, add 
a keyframe just before it disappears and another when it 
reappears. You can set the range between these two frames 
to be Occluded. The target tracker skips over this range 
during tracking, but the tracking data either side of the 
occlusion is considered part of the same track.

The size of the comparison region and the search region is 
keyed on each keyframe. This makes it much easier to track 
features that get bigger or smaller in the frame due to changes 
in focal length or the motion of the camera.

Important
You can see where the target track keyframes are by expanding the 
Timeline. You can navigate between the keyframes of the currently 
selected target track by using the Next Keyframe and Previous 
Keyframe buttons in the Play Controls toolbar.

8. When you are ready to start tracking, you must leave Edit 
mode. Click the Toggle Edit Mode button on the Status bar; 
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or from the menu bar, click Edit and then click Toggle Edit 
Mode; or when you are on a keyframe, right-click the target 
track in the main window and select Toggle Edit Mode from 
the submenu.

9. When you have left Edit mode, start tracking in any of the 
following ways:

Image window right-click menu: Track

Menu bar: 2D Tasks > Target Tracking Tools > Track 

Timeline: see Checking Target Tracks Quality on page 4-37 
for details

The Status bar displays target tracking progress, as shown in 
Figure 4-25.

Figure 4-25: Target tracking process in status bar

The patch that is being tracked is shown in the main window 
and a zoomed-in view is shown in the Zoom Tool. This allows 
you to monitor the accuracy of the target track as it works 
through the shot.

10. Once the tracking is complete, you can check the quality by 
either looking at the Timeline or the Target Track properties 
dialog box.
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Editing Target Tracks
Once you have added target tracks, you can edit them to change 
the defined tracking region.

To edit target tracks:
1. In the main boujou 4.1 window select the target track that you 

want to edit in any of the following ways (depending on 
whether the defined target track has already been tracked):

Target track previously tracked:

Taskview: Target tracks branch > target track artifact

Image window: Click the target track,
or
Drag a box around the target track path (only after 
tracking), 
or
Drag a box around the target track feature (a cyan +). If 
the target track is untracked, the feature (+) is only visible 
on keyframes.

Timeline: Target Tracks

Target Track dialog box: Artifact drop-down list (for 
details, see Adding Target Tracks on page 4-32)

Target track not yet tracked:

• Switch Edit mode on in any of the following ways:

Status bar: Toggle Edit Mode 

Menu bar: Edit > Toggle Edit Mode

Image window right-click menu: Toggle edit mode

Important
When you are in Edit mode, you cannot select a different target track. 
You must leave Edit mode, change the selection, then re-enter Edit 
mode.

2. Once you have selected the target track, add or delete 
keyframes by using the right-click menu in the Image window 
or the right-click menu in the Timeline (for details, see Adding 
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Target Tracks on page 4-32). If you are editing a tracked 
target track, you can add a keyframe by making a change with 
the Zoom Tool.

Caution
If you add a new keyframe in the middle of a tracked range, the 
tracking information is thrown away by default. To stop this 
happening, from the menu bar, click Edit, then click Preferences, 
expand Target Tracking, click Auto Clear and set it to No (for 
details, see Appendix B boujou 4.1 Preferences).

3. You can also edit target tracks without toggling Edit mode on 
and off each time:

• Select a target track and click and drag to modify its 
position or change the size of the search region or 
comparison region. 

• To make more precise adjustments, use the Zoom Tool. 
You are only in Edit mode for as long as you have the 
mouse button pressed. This means that you can 
immediately select another target track in the Image 
window and start editing it with the Zoom Tool. If you 
select an untracked target track, you can only use this 
method on keyframes.
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Checking Target Tracks Quality
The Timeline, shown in Figure 4-26, displays the keyframes, 
tracking status, and quality of the target tracks that you have 
added.

Figure 4-26: Target Tracks in Timeline

Tracked regions are shown in the following colors to indicate the 
accuracy of the tracking:

• Black: Range has been set to occluded.

• Background color: Untracked frames.

• Green: Tracking quality is above the Good track threshold. 

• Yellow: Tracking quality is above the OK track threshold. 

These thresholds are set in the Preferences dialog box (for 
details, see Appendix B boujou 4.1 Preferences). By default, the 
Good track threshold is 0.9, and the OK track threshold is 0.7. 
The maximum possible is 1.0. You should add extra keyframes in 
any red areas and then track the ranges again.

Table 4-6 describes the commands you can select from the right-
click menu displayed when you right-click between two keyframes 
in the Timeline.

Table 4-6: Target Track keyframes commands

Menu Item Description

Add Keyframe Adds a keyframe at the current frame.
Delete 
Keyframe

Deletes the current keyframe.

Properties Opens the Target Tracks properties dialog 
box.

Track Tracks between all keyframes.
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Editing Target Tracks Properties
Once you have created target tracks, you can edit their properties 
in the Target Tracks dialog box. The Target Tracks dialog box 
gives you a high level of additional control over how the target 
tracker works. You can rename target tracks, assess their quality 
frame by frame, and specify particular frame ranges over which 
a feature is occluded.

You can edit information about the individual tracked frames in the 
Frames tab, as shown in Figure 4-27.

Figure 4-27: Target Tracks dialog box—Frames tab

Track Range Tracks between the two neighboring 
keyframes.

Clear Range 
Tracking

Clears the range between the two neighboring 
keyframes.

Set Range 
Occluded

Changes the status of a range to occluded.

Clear Range 
Occlusion

Changes the status of a range from occluded to 
untracked.

Table 4-6: Target Track keyframes commands

Menu Item Description
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To edit target track frame properties:
1. Open the Target Tracks dialog box in any of the following 

ways:

Taskview: Target tracks branch > target track artifact

Timeline right-click menu: Properties

Image window 2D Mode view right-click menu: Target 
track > Properties 

Image window 2D Mode view: Select target track and use 
the keyboard shortcut CTRL+ENTER

Keyboard shortcut: CTRL+A

2. Click the Frames tab to display information about the 
individual frames (untracked frames are not listed).

3. Edit any of the following properties:

• Artifact: Select which target track you want to work with 
from the drop-down list. Selecting a track here also 
enables you to edit it in the main window.

• Name: View or change the name of your target track.

• Frame: The frame numbers of any tracked frames or 
keyframes between the first and last keyframe of the 
selected target track.

• Type: If a frame is a keyframe, the type is key.

• Score: A normalized measure of tracking quality. A 
keyframe always has a value of 1.0 and has a small key 
icon next to it. Tracked frames have a colored score light 
next to them. This light appears green if the score is above 
0.9 (Good track threshold), yellow if it is above 0.7 (OK 
track threshold), and red if it is below 0.7. You can set 
these threshold values in the Preferences dialog box (for 
details, see Appendix B boujou 4.1 Preferences).
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You can edit information about the frames between each pair of 
adjacent keyframes in the Ranges tab, as shown in Figure 4-28.

Figure 4-28: Target Tracks dialog box—Ranges tab

To edit target track range properties:
1. Open the Target Tracks dialog box in any of the following 

ways:

Taskview: Target tracks branch > target track artifact

Timeline right-click menu: Properties

Image window 2D Mode view right-click menu: 
Properties

Image window 2D Mode view: Select target track and use 
the keyboard shortcut CTRL+ENTER

Keyboard shortcut: CTRL+A

2. Click the Ranges tab to displays status of the frames between 
each pair of neighboring keyframes.

3. Edit any of the following properties:

• Artifact: Select which target track you want to work with 
from the drop-down list. Selecting a track here also 
enables you to edit it in the main window.

• Name: View or change the name of your target track.

• Start/End: The start and end frames for a range specified 
by two adjacent keyframes.

• Status: One of tracked, untracked, occlusion, or only 
one key. A frame range can be set to occlusion by clicking 
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the frame number in the Start column and then selecting 
the Occluded check box at the bottom of the dialog box. 
Frame ranges can be tracked using the Track button or 
untracked using the Clear button. The only one key icon 
is displayed if there is no entry or exit key for the range.

Manipulating Target Tracks
Table 4-7 describes the commands you can select from the Target 
Tracks right-click menu displayed when you right-click a target 
track in the Image window.

Table 4-7: Target Tracks commands

Menu Item Description

Toggle edit 
mode

Turns Edit mode on or off.

Track Tracks between all keyframes.
Clear Tracked 
Points

Clears tracked points between all keyframes.

Delete 
Keyframe

Deletes the current keyframe.

Add Keyframe Adds a keyframe at the current frame.
Gold Toggles the gold status of the target track. 

target tracks are gold by default.
Flag for 
Export

Toggles the export status of the target track. 
Target tracks are flagged for export by default.

Connect 
Survey Point

Connects a selected target track to a selected 
survey point. Select the survey point using a 
model vertex and then CTRL+select the target 
track in one of the other views.

Center View 
on Selection

Changes the camera view so that the currently 
selected object is in the center of the Image 
window.

Disconnect 
Survey 
Point(s)

Disconnects selected target tracks from survey 
points to which they are connected.



Advanced Functions

4-42 boujou 4.1 Reference Guide

Describing Scene Geometry
The Scene Geometry dialog box, shown in Figure 4-29, contains 
tools for manipulating the 3D coordinate frame and modifying the 
calculated 3D structure. The 3D structure calculated by 
boujou 4.1 can be aligned to the coordinate frame using soft 
constraints or adjusted to fit the coordinate frame using hard 
constraints.

Figure 4-29: Scene Geometry dialog box

Aligning the 3D scene to the coordinate frame makes the tracking 
data easier to work with when you export it to an animation 
package. Using hard constraints can improve the quality of your 
solution, but only if the existing solve is already quite good. Hard 
constraints cannot fix a solve that is very bad, broken, or 
fragmented.

The predictions that you select to connect to one Geometric 
feature are still selected when you add another geometric feature. 

Rename Allows you to rename the target track.
Delete Deletes the selected target track.
Properties Displays the Target Tracks properties dialog 

box.

Table 4-7: Target Tracks commands

Menu Item Description
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This means that you can add a Planar Constraint and then define 
it as the ZX plane without having to reselect the predictions.

The following sections describe the ways you can describe the 
scene geometry in boujou 4.1:

• Adding a Coordinate Frame Hint
• Adding a Survey Point on page 4-46
• Adding a Planar Constraint on page 4-48
• Editing Geometric Features on page 4-50

Adding a Coordinate Frame Hint
A coordinate frame hint is a soft constraint which fits the 
coordinate frame to the 3D predictions. The relative positions of 
the predictions do not change. If you create conflicting coordinate 
frame hints, boujou 4.1 does a ’best fit’ to try to fit the coordinate 
frame to them. The hints that you have set up are applied as soon 
as you click the Update Coord Frame button. Coordinate frame 
hints can only be added after camera solving. Any changes that 
you have made to the coordinate frame using the manipulators 
are overwritten.

To add a coordinate frame hint:
1. Open the Scene Geometry dialog box in any of the following 

ways:

Toolbox: Scene Geometry 

Menu bar: 3D Tasks > Add/Edit Scene Geometry 

Keyboard shortcut: CTRL+G
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2. From the Geometric features list, click the Add Coord Frm 
Hint button. An entry named Origin (hint) is added to the 
list, as shown in Figure 4-30 below.

Figure 4-30: Scene Geometry dialog box—Coordinate Frame Hint

3. From the Type drop-down list, leave the geometric feature 
type set to Origin (the default) or select another type of 
coordinate frame hint, as described in Table 4-8.

Table 4-8: Coordinate Frame Hint Type

Hint Type Minimum 
3D Points Description

Origin 1 The center of the 3D coordinate frame 
where X=0, Y=0 and Z=0. This point is 
in the middle of the workspace in your 
animation software.

X axis 2 A line passing through the origin in the 
X direction.

Y axis 2 A line passing through the origin in the 
Y direction. Y is the ’up’ axis for Maya, 
XSI, combustion, LightWave, etc.
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Tip
Each subsequent Coordinate Frame Hint that you add defaults to the 
previously selected type. You can change the type from the drop-
down list.

Z axis 2 A line passing through the origin in the 
Z direction. Z is the 'up' axis for 3ds 
Max.

XY plane 3 The plane represented by the ground 
plane overlay if you are working Z-up.

YZ plane 3 The plane defined by the Y axis and the 
Z axis, passing though the origin.

ZX plane 3 The plane represented by the ground 
plane overlay if you are working Y-up.

Line parallel to 
X axis

2 A line in the same direction as the X 
axis, but not going through the origin.

Line parallel to 
Y axis

2 A line in the same direction as the Y 
axis, but not going through the origin.

Line parallel to 
Z axis

2 A line in the same direction as the Z 
axis, but not going through the origin.

Plane parallel 
to XY plane

3 A plane that is parallel to the XY plane 
but does not go through the origin.

Plane parallel 
to YZ plane

3 A plane that is parallel to the YZ plane 
but does not go through the origin.

Plane parallel 
to ZX plane

3 A plane that is parallel to the ZX plane 
but does not go through the origin.

Known length 2 The value you assign to the distance 
between two selected 3D points, 
enabling you to scale the 3D structure. 
Enter the value in the Length field.

Table 4-8: Coordinate Frame Hint Type

Hint Type Minimum 
3D Points Description
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4. Under the Coordinate Frame Hint Properties section, in 
the Name field, either leave the default name, Geometric 
feature x, or overtype it with another name and press TAB to 
apply the new name.

5. Select the 3D predictions (including locator and target track 
predictions) that you want to constrain in the 2D or 3D views 
of the Image window.The selected points are identified in the 
text box near the bottom of the dialog box.

Tip
You can select points without having to close the Scene Geometry 
dialog box. 

6. Click the Connect to selected button to connect the 
geometric feature to the points. 

The Status of the Geometric feature immediately changes 
from Disconnected to ## Tracks Connected.

7. Click the Update Coord Frame button at the bottom of the 
dialog box to apply the soft constraint to the boujou 4.1 
coordinate frame.

8. If your coordinate frame appears to be the wrong way up after 
applying a hint, use one of the Rotate 180º about buttons 
to flip it around the X, Y, or Z axis.

9. Click the Close button to exit the dialog box.

Adding a Survey Point
Survey points can be used as a hard constraint to fit the 3D points 
to a set of 3D coordinates measured on set. You need a minimum 
of four survey points, visible for the entire shot, and well spaced 
in the frame, to create this type of constraint effectively. 

Tip
Survey points are usually created by importing a 3D model (for details, 
see Using a 3D Model as Survey Data on page 4-60 and in the 
boujou 4.1 Tutorials book). If you do not have a 3D model, you can input 
the survey points manually as X, Y, Z coordinates (for details, see 
Appendix E Using Survey Points without a 3D Model).



Advanced Functions

boujou 4.1 Reference Guide 4-47

To add a survey point:
1. Open the Scene Geometry dialog box in any of the following 

ways:

Toolbox: Scene Geometry 

Menu bar: 3D Tasks > Add/Edit Scene Geometry 

Keyboard shortcut: CTRL+G

2. From the Geometric features list, click the Add Survey Pt 
button. An entry named Survey Point (hard) is added to the 
list, as shown in Figure 4-31.

Figure 4-31: Scene Geometry dialog box—Survey Point

3. Under the Survey Point Properties section, in the Name 
field, either leave the default name, Geometric feature x, or 
overtype it with another name and press the TAB key to apply 
the new name.

4. In the X, Y and Z fields, enter the coordinates to which you 
want to constrain the 3D prediction.
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5. From a 2D or 3D view in the Image window, select the 3D 
predictions that you want to constrain. The selected points are 
identified in the Select a locator or target track field.

6. Click the Connect to selected button to connect the Survey 
Point to the selected 3D predictions.

The Status column of the Survey Point entry in the 
Geometric features list immediately changes from 
Disconnected to ## Tracks Connected.

7. Click the Update Coord Frame button at the bottom of the 
dialog box to apply the hard constraint to the boujou 4.1 
coordinate frame.

8. Click the Adjust Solve button to perform an Adjust Only 
camera solve without leaving the Scene Geometry dialog 
box. Because the new Survey Point is a hard constraint, you 
must recalculate the camera to match the modified 3D 
structure. 

9. Click the Close button to exit the dialog box.

Adding a Planar Constraint
This is a hard constraint which fits the selected 3D points to a 
plane. You need to do an adjust solve to apply this constraint and 
recalculate the camera path. To do this without leaving the Scene 
Geometry dialog box, click the Adjust Solve button at the 
bottom of the dialog box. You cannot force two planar constraints 
to be perpendicular to each other.

To add a planar constraint:
1. Open the Scene Geometry dialog box in any of the following 

ways:

Toolbox: Scene Geometry 

Menu bar: 3D Tasks > Add/Edit Scene Geometry 

Keyboard shortcut: CTRL+G
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2. From the Geometric features list, click the Add Plane 
Constraint button. An entry named Planar Constraint 
(hard) is added to the list, as shown in Figure 4-32.

Figure 4-32: Scene Geometry dialog box—Planar Constraint

3. Under the Planar Constraint Properties section, in the 
Name field, either leave the default name, Geometric feature 
x, or overtype it with another name and press TAB to apply 
the new name.

4. Select the 3D predictions (including locator and target track 
predictions) that you want to constrain in the 2D or 3D views 
of the Image window. The selected points are identified in the 
text box near the bottom of the dialog box.

Tip
You can select points without having to close the Scene Geometry 
dialog box. 

5. Click the Connect to selected button to connect the Planar 
Constraint to the selected 3D predictions.
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The Status column of the Planar Constraint entry in the 
Geometric features list immediately changes from 
Disconnected to ## Tracks Connected.

6. Click the Adjust Solve button to perform an Adjust Only 
camera solve without leaving the Scene Geometry dialog 
box. Because the new Planar Constraint is a hard constraint, 
you must recalculate the camera to match the modified 3D 
structure. 

7. Click the Close button to exit the dialog box.

Editing Geometric Features
Once you have created a Coordinate Frame Hint, Survey Point, or 
Planar Constraint, you can edit it.

To edit a geometric feature:
1. Open the Scene Geometry dialog box in any of the following 

ways:

Toolbox: Scene Geometry 

Menu bar: 3D Tasks > Add/Edit Scene Geometry 

Keyboard shortcut: CTRL+G

Taskview: Scene Geometry branch > geometric feature 
artifact

2. In the Scene Geometry dialog box, ensure that the 
geometric feature that you want to edit is selected. The 
properties displayed depend on the selected geometric 
feature.

3. Edit any of the properties (for details, see Adding a Coordinate 
Frame Hint on page 4-43, Adding a Survey Point on 
page 4-46, or Adding a Planar Constraint on page 4-48).
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Manipulating the Coordinate Frame
The Rotate and Translate tools, shown in Figure 4-33, enable 
you to move the ground plane relative to the 3D structure

Figure 4-33: Rotate and Translate tools

Tip
You can also use Scale, Rotate, or Translate tools to manipulate the 3D 
test objects. For details, see Chapter 3 Basic Functions.

These tools provide a quick and easy way of manipulating the 
coordinate frame, enabling you to orientate your 3D structure the 
right way up and parallel to the floor prior to export. You can 
access these tools from the Transformations toolbar. If this 
toolbar is not visible, show it by right-clicking one of the other Tool 
groups and selecting Transformations from the list.

Tip
Use the Orthogonal views to make orienting your 3D structure even easier 
(for details, see Chapter 2 User Interface). To adjust the coordinate frame 
more precisely, use the soft constraints in the Scene Geometry dialog 
box (for details, see Adding a Coordinate Frame Hint on page 4-43).

To translate or rotate the coordinate frame:
1. From the Transformations toolbar, ensure that the Select 

whether to edit the coordinate system or the test object 
button has the coordinate system selected (the axis tripod is 
highlighted on the button).

2. Display the desired manipulator in either of the following 
ways:

Transformations toolbar: Translate  or Rotate

Image window right-click menu: Translate or Rotate
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3. Use the manipulator at the center of the ground plane to apply 
your transformations as described in Table 3-3 on page 3-25. 
The manipulator remains static at the center of the ground 
plane and the 3D predictions move.

Solving the Camera with Advanced Tools
In previous versions of boujou, camera initialization was only ever 
performed using Solve Complete, while structure generation and 
optimization could be performed separately using Solve Adjust.

boujou 4.1 has an improved camera solver which provides more 
feedback and an extended and enhanced toolset enabling more 
data to be extracted from the shot.

In boujou 4.1, the camera solving process takes place in three 
main stages:

1. Initializing the Camera

The first stage of the camera solving process is to initialize the 
camera. This involves obtaining an initial estimate of the 
parameters of the camera, that it, its position and orientation 
at each frame and its focal length. This is most difficult stage 
and the most likely to fail for problem shots where the feature 
tracking information is low quality or there is not enough 
parallax.

2. Generating 3D Structure 

In the second stage of the camera solving process, you 
examine the generated structure and configure boujou 4.1 to 
discard all points where the projection error is above a 
specified threshold.

3. Optimizing Camera Parameters

In the third stage of the camera solving process, you optimize 
the 3D positions of the points and the position, orientation, 
and focal length camera parameters.

All three stages are automatically performed in a Solve 
Complete. A Solve Adjust performs only the structure 
generation and camera optimization stages. boujou 4.1 makes 
these internal camera solving tools accessible to the user to 
provide direct control for solving problem shots.
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The following sections describe advanced camera solving:

• Using Advanced Camera Solve Tools on page 4-55

boujou 4.1 provides many methods for the user to initialize 
the camera as well as tools for fine-grained control over 
structure generation and optimization These tools are in 
addition to the basic camera solving methods, described in 
Chapter 3 Basic Functions.

• Visualizing Reprojection Errors on page 4-56

After repairing the camera for any reprojection errors 
identified in the camera solving process, you can manually 
optimize the camera by minimizing reprojection errors.

• Working with Partial Solves and Fragmented Solves on 
page 4-57

You can visually identify any remaining problems with the 
camera solving process.

To make full use of the underlying functionality of the boujou 4.1 
camera solve tools, it is important to be precise in the use of 
camera solver terminology. Table 4-9 defines terms that were 
only loosely applied in previous versions of boujou, but which now 
refer to specific features or functions relating to the camera 
solver:

Table 4-9: Glossary of Camera Solve Terms

Term Definition

View The camera’s position, orientation, and focal 
length in a single frame.

Solve A series of camera views, plus the 
corresponding 3D structure.
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Key Schedule The distribution of solve keyframes. Before 
boujou 4.1 does any camera solving, it 
examines the feature tracks and breaks up the 
shot into sections which are linked by a certain 
number of tracks. These breaks are called solve 
keyframes. Shots with plenty of long, 
consistent tracks may just have a solve 
keyframe at the start and the end. Shorter, 
more sporadic tracks may result in many 
keyframes. When boujou 4.1 calculates a 
camera solution it creates views at the 
keyframes and then fills in the gaps. Feature 
tracks that span less than three keyframes are 
discarded. If the key schedule is very sparse, 
certain sections of the shot may have very few 
3D predictions, even though they seem to have 
lots of feature tracks. You can add extra solve 
keyframes by adding a locator (each locator 
keyframe creates a new solve keyframe).

At each frame of the key schedule, a default 
view is created. Frames with default views are 
displayed in yellow in the Timeline. You can also 
see these frames in the Graph view, where 
they are displayed as keys on each curve. Also, 
the frame numbers of those frames selected for 
the key schedule are displayed in the Console 
view.

Structure The cloud of 3D points calculated by boujou 4.1 
after camera solving.

Table 4-9: Glossary of Camera Solve Terms

Term Definition



Advanced Functions

boujou 4.1 Reference Guide 4-55

Using Advanced Camera Solve Tools
In boujou 4.1, cameras can be generated in a large variety of ways 
including:

• Solving a sub range

• Copying solved views from other parts of the sequence

• Importing from external sources (e.g. motion control data)

• Manually editing (’eyeballing’)

• Interpolating between existing views

• Solving using survey points/model vertices tied to tracks

The design of the some of the interface relating to camera solving 
and the locations of the tools has changed from previous versions 
of boujou. 

In boujou 4.1, the Solve Tools menu provides additional tools for 
managing the camera solve process. To access these commands, 
from the menu bar, click 3D tasks and point to Solve Tools.

• Regenerate Structure
Generates 3D points for all possible tracks.

• Filter Structure
Removes the least accurate predictions based on their 
covariance.

• Interpolate Views
Enables you to delete a range of camera views and replace 
them using a straight line interpolation.

• Copy Solve
Creates a copy of the current active solve. Several solves can 
coexist in a project file, and copying a solve is a good way of 
creating a backup of your solve before you start editing it.

• Create User Solve
Creates a solve that contains no camera views or structure. 
This is the starting point for creating your own camera views.

• Default View from Known 3D
Creates a new camera view based on the coordinate frame of 
the imported model. The camera is positioned so that the 
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model is in the center of its field of view, pointing down one 
of the axes. Frames with default views are displayed in yellow 
on the Timeline.

• Delete View
Deletes a single frame from the current solve.

• Copy View
Copies a view from a specified frame to the current frame.

• Optimize View
Optimizes the camera position and orientation in the current 
frame by minimizing the error between the measured features 
and the 3D predictions.

• Regenerate View
Recreate the view on the current frame using the existing 3D 
structure.

Caution
Make sure that you have got the correct solve selected when you use the 
Image window views. You can switch between solves using the Solve 
drop-down list in the top left corner of the Image window.

Visualizing Reprojection Errors
The 3D predictions of features tracked in the image sequence that 
boujou 4.1 creates in the first stage of the camera solving process 
are displayed in a 2D view window as a cloud of yellow and cyan 
dots on top of the image. A yellow dot indicates a prediction for 
a feature that was visible in that frame; a cyan dot indicates a 
prediction for a feature was not visible in that frame.

These predictions represent where the tracked 2D features are in 
3D space based on the calculated camera motion. There are 
always some differences between the measured feature and the 
3D prediction—these differences are called reprojection errors. 
The reprojection error for a point in a frame is the distance 
between the position of the track in that frame and the position 
of the tracks 3D point projected into the frame using the cameras 
parameters on that frame. The smaller the reprojection errors are, 
the more accurate the camera solve will be.
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To visualize the reprojection error:
1. Open a camera solved project and display a 2D view window.

2. Display the Overlays pane to show the 2D View Controls 
view.

3. In the Overlays section, select the following options and 
expand them to set any specified sub options:

• Track: Clear the All sub option

• Predictions: Clear the All sub option

• Errors 

4. In the Error Scale field, set the value to 1.0.

5. In the Tracks section, click Show Features Only.

6. In the Model toolbar, click the Fly Align button and use SHIFT 
+ mouse buttons to “fly” the camera around.

As you fly the camera away from its starting position, you 
should see the reprojection errors increase in the 2D view. 
These appear a purple lines linking the feature (represented 
by a red cross) and the prediction (represented by a yellow 
dot).

7. To repair the camera, from the menu bar, click 3D Tasks, 
point to Solve Tools and then click Optimize View. This 
changes the camera parameters in order to minimize these 
reprojection errors. 

Working with Partial Solves and Fragmented Solves
If boujou 4.1 cannot calculate a camera for the entire sequence, 
it does as much as it can. For very difficult shots this can mean 
that it calculates several track fragments. These fragments cannot 
be joined together in boujou 4.1, but they can show you where the 
problem areas are.

To fix the breaks and obtain a single camera track for the entire 
sequence, try feature tracking with different settings over the 
broken sections, adding locators and target tracks, or correcting 
for lens distortion.

You can tell if boujou 4.1 has only calculated a partial solve or 
multiple solve fragments when the predictions disappear during 
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playback in the 2D view, or if one set of predictions is suddenly 
replaced by another set. The Timeline displays each camera track 
fragment, as shown in Figure 4-34. 

Figure 4-34: Camera track fragments in Timeline

The Camera solve branch of the Taskview also shows each of 
the tracking fragments, as shown in Figure 4-35.

Figure 4-35: Tracking fragments in Camera solve branch

You can navigate between the camera tracking fragments by 
using the Solve drop-down list at the top left of the Image 
window, as shown in Figure 4-36

Figure 4-36: Solve drop-down list

Important
Tim Dobbert’s book, Matchmoving: the Invisible Art of Camera Tracking 
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(Sybex, 2005, ISBN 0-7821-4403-9) contains a very useful chapter on 
how to connect two partial camera tracks in a 3D animation package.

Using Model-based Tracking
boujou 4.1 allows you to import a 3D model in OBJ format. You 
import the model using the Import OBJ Model command on the 
3D Tasks menu.

A 3D model is useful for sparse solves. Objects can only help the 
camera solving if there are enough feature tracks to link the object 
to the image. If you have used the survey points tool in 
boujou three, you will be familiar with the idea of locator 
keyframes having to be linked by feature tracks. The locators are 
connected to the survey points and each frame of the sequence 
that has sufficient locator keyframes defines a camera view. These 
views represent a sparse solve—boujou 4.1 needs enough feature 
tracks connecting these views to fill in the gaps in the camera 
path.

A 3D model is also helpful for determining the appropriate model-
based tracking methods to use. If the vertices of your 3D model 
correspond to 2D features in the image, use survey points to solve 
from known 3D. If your model vertices do not correspond to 
vertices in the image, you can use face-based tracking. However, 
face-based tracking is less likely to give you a usable solution; the 
most robust method is ’eyeballing’ approximate camera positions.

The following sections describe these model-based tracking 
methods:

• Using a 3D Model as Survey Data on page 4-60

An imported OBJ model can be used to represent the survey 
data and to automatically determine where on the Timeline 
locator or target track keyframes should be placed.

• Using a 3D model to Create Approximate Camera Positions on 
page 4-63

Vertex alignment is a method of approximating the position 
of the camera. You can align the model using the Fly Align 
method (using the navigation tools), or the object 
manipulators, or the Vertex Drag method.
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• Using a 3D Model for Face-based Object Tracking on 
page 4-65

Face-based tracking links the feature tracks and the polygon 
faces in the model to calculate the camera motion. If you have 
too few features tracks or if they are poor quality, the accuracy 
of the tracking is low and the model appears to drift.

Using a 3D Model as Survey Data
boujou 4.1 allows you to use an imported OBJ model to represent 
the survey data and to automatically determine where on the 
Timeline locator or target track keyframes should be placed.

To use a model as survey data, you need to have locators or target 
tracks in your scene to identify the features that you have survey 
data for, and you need to have feature tracks linking the 
keyframes. This is exactly the same as the survey data tool in 
boujou three. However, you can now link the locators to the model 
vertices, which makes setting up your scene far more 
straightforward. As before, you need at least seven locator 
keyframes on a frame and at least 10 feature tracks joining this 
frame to the next set of locator keyframes.

Tip
If you do not have a 3D model, you can manually input survey points as 
X,Y,Z coordinates (for details, see Appendix E Using Survey Points without 
a 3D Model).

To use a 3D model as survey data:
1. Feature track your shot.

2. Go to the first frame of the sequence and from the menu bar 
click 3D Tasks and then click Import OBJ Model.

3. Select the Create User Solve check box. This creates a solve 
that contains no camera view or structure. This is the starting 
point for creating camera views by connecting model vertices 
to locators or target tracks. Click OK and the Input Focal 
Length dialog box is displayed.

4. In the Input Focal Length dialog box, enter a focal length 
for the camera created by the user solve in the previous step.
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5. To initialize the solve key schedule, from the menu bar click 
3D Tasks and then click Initialize Key Schedule. For an 
explanations of the solve key schedule, see Table 4-9 on 
page 4-53.

At each frame of the key schedule, a default view is created. 
Frames with default views are displayed in yellow in the 
Timeline. You can also see these frames in the Graph view, 
where they are displayed as keys on each curve. Also, the 
frame numbers of those frames selected for the key schedule 
are displayed in the Console view. This gives you the best set 
of frames for adding locators or target track keys based on the 
number of feature tracks connecting them.

6. Add locators or target tracks to features which correspond to 
vertices of the model. Make sure that locator/target track key 
frames are on the same frames as the solve key frames. The 
easiest way to do this is to use the Next/Previous Solved 
Frame buttons on the Play Controls toolbar.

Tip
Hiding the model while adding locators/target tracks makes the 
Image window less cluttered. When the locators/target tracks have 
been added, you can display the model again.

7. Connect the locators to the model vertices:

a. Select model vertices and locator/target tracks together 
in the 2D view, which you can do using either of the 
following methods:

• Align the model approximately with the image using 
one or both of the Fly Align and Vertex Align tools. 
When using these tools, bear in mind that you are 
actually moving the camera and effectively setting up 
an initial view.

• Split the main Image window into two views 
displaying the locators/target tracks, one set to a 
2D view and the other to a 3D view. In the 3D view, 
select Survey Data from the Solve drop-down list in 
the top left corner of the Image window. This displays 
the model that represents the survey data with 
connected vertices displayed in orange.
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b. Click a vertex which you want to connect to a locator/
target track. The entire model mesh turns green.

c. CTRL + click the corresponding locator/target track. It 
also turns green.

d. Right-click and select Connect Survey Point from the 
menu. The model vertex and the locator/target track 
turns orange when it is connected and deselected.

You can disconnect survey points using the Disconnect 
Survey Point(s) command from the same menu. This 
can be useful if a point has been connected in error.

e. Repeat this process for all the vertex locator/target track 
connections you wish to make.

8. Click the Next Solved Frame button to move to the next 
solved keyframe.

9. Click the Solve View from Known 3D button in the Model 
Tools pane. This aligns the camera, based on the survey point 
connections you made in step 7.

10. Connect any unconnected vertices to their corresponding 
locators/target tracks in the current frame. You only need to 
connect each vertex once.

11. Repeat steps 8–10 for each solved keyframe to the end of the 
sequence.

12. You now have a sparse solve with camera positions on each 
of the solve keyframes. To fill in the gaps between the 
keyframes and improve the result, from the menu bar, click 
3D Tasks and then click Solve from Existing Cameras. 
When boujou 4.1 calculated the key schedule it made sure 
that there would be enough feature tracks linking each pair of 
keyframes to allow it to work out how the camera moved 
between them.

Important
It is not possible to generate a solve from existing cameras if there 
is a default camera view on any frame in a solve. If you miss any 
frames during the process of survey data camera alignment, it is 
possible that default views will remain. Therefore, a warning message 
is displayed if you attempt to use Solve from Existing Camera while 
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there is a default camera present. The frames on which the default 
views lie are listed in the warning message.

Notice that the text under the frame counter in the main 
Image window says User Solve [Aligned] and the model still 
appears to be in the right position. This is because you 
connected the vertices of the model to the locators and the 
model is now always linked to the 3D predictions by the 
locators.

Using a 3D model to Create Approximate Camera Positions
When you manipulate the model in the 2D view prior to camera 
solving you are actually moving the camera. This means that you 
can create an approximate camera view by lining up the 3D model 
with the appropriate part of the scene in the image sequence. 
These approximate views should be added on the solve keyframes 
after feature tracking. This gives you a sparse solve. The gaps in 
this solve can be filled using Solve from Existing Cameras 
function. 

There are three methods of manipulating the model in order to 
create an approximate camera view:

• Fly Align
When you are in Fly Align mode, you can move the camera 
using the navigation tools. A large circle with a horizontal line 
through it appears in the Image window to indicate that you 
are moving the camera rather than moving an object, and a 
camera icon appears in the top right of the Image window. It 
also warns you that the navigation tools will not behave in the 
usual way (e.g.: Shift+LMB moves the camera position and 
does not shuttle through the image sequence). You enter Fly 
Align mode by clicking the Fly align button on the Model 
toolbar (for details, see Model Toolbar on page 2-20).

• Object Manipulators
The test object manipulators can also be used to manipulate 
the model. Click the model to select it (the mesh turns green) 
and then click one of the Rotate, Scale, or Translate 
manipulator buttons in the Transformations toolbar (for 
details, see Transformations Toolbar on page 2-19). The 
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selected manipulator appears centered at the model’s pivot 
point.

• Vertex Drag
This method is the quickest if the object's vertices correspond 
to features in the image (greenscreen markers, for example). 
Every time you drag a vertex to a feature in the image, you 
add a ’spring’. Adding subsequent springs changes the camera 
position until the model appears to be aligned with the image. 
If you have the optimize focal length option switched on in 
the Model Tools pane, the focal length is also adjusted to 
match the model alignment. You enter Vertex Drag mode by 
clicking Vertex Drag button on the Model toolbar (for details, 
see Model Toolbar on page 2-20).

Once you have set up approximate camera positions on solve 
keyframes, you can use the Solve from Existing Cameras 
function from the 3D Tasks menu. This fills in the gaps in the 
’sparse solve’ using the 2D feature tracks, and optimizes the 
camera.

To use a 3D model to create approximate camera 
positions:
1. Import an image sequence.

2. Import a set of feature tracks.

3. To import the OBJ model, from the menu bar click 3D Tasks 
and then click Import OBJ Model.

4. Click the Create User Solve check box.

5. In the Input Focal Length dialog box, set the focal length to 
an appropriate value (the default is 30 mm) and click OK. The 
model appears in the default position in the middle of the image.

6. From the menu bar, click 3D Tasks and then click Initialize 
Key Schedule. This calculates the solve key schedule. 
Camera views are initialized on the solve keyframes, giving a 
guide to the most effective frames to align the camera on. You 
can see where these keys have been put by looking at the 
Graph view or the Console pane.
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7. Use the Next Solved Frame and Previous Solved Frame 
buttons to navigate between the views. Go to the first solved 
frame (this should be on the first frame of the sequence).

8. Align the model so that it matches the object in the sequence 
as closely as possible.

9. Jump to next solve keyframe by clicking the Next Solved 
Frame button.

10. To get a better starting point for aligning the model you can 
copy the previous camera position (remember that you are 
actually moving the camera around the stationary model). 
From the menu bar, click Scripts and then click Copy from 
prev solved frame. Fine-tune the alignment as before.

11. Repeat until you have determined an approximate camera 
position (view) on all of the frames of the key schedule.

12. From the menu bar, click 3D Tasks and then click Solve from 
Existing Cameras. This fills in the gaps between the views 
and optimizes the solve. Note that the model is no longer 
aligned to the solution and can now be used as a test object. 
The model only remains aligned if it has been linked to the 
solve using survey points.

Important
It is not possible to generate a solve from existing cameras if there 
is a default camera view on any frame in a solve. If you miss any 
frames during the process of survey data camera alignment, it is 
possible that default views will remain. Therefore, a warning message 
is displayed if you attempt to use Solve from Existing Camera while 
there is a default camera present. The frames on which the default 
views lie are listed in the warning message.

Using a 3D Model for Face-based Object Tracking
Face-based tracking works by linking 2D features and the faces 
of a polygon mesh in the model to calculate the camera motion 
in the shot. If you have too few features tracks, or if they are poor 
quality, the accuracy of the tracking is low and the model appears 
to drift. Since drift is often a problem with this tracking method, 
you should look on it as a way of getting an approximate camera 
path that you can subsequently optimize.
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To use a 3D model for face-based object tracking:
1. Import an image sequence.

2. Track features.

3. Go to a frame where there are the most feature tracks visible 
on the object that you want to track. This gives you the best 
lock between the model faces and the 2D tracks.

4. To import the object model, from the menu bar, click 
3D Tasks and then click Import OBJ Model. Even a very 
simple model can be used for face-based tracking. boujou 4.1 
is linking the features found in the image with the polygon 
faces of the model and so the number and shape of the faces 
does not matter.

5. Click the Create User Solve check box.

6. In the Input Focal Length dialog box set the focal length to 
an appropriate value (the default is 30 mm) and click OK. The 
model should appear in the default position in the middle of 
the image.

7. Align the model to the object in the image by using the Fly 
Align mode or by clicking one of the vertices of the model and 
then using the Translate and Rotate manipulators from the 
Transformations toolbar.

8. In the Model Tools pane, click the Track Forward button. 
You should be able to see the object tracking all the way to 
the end of the shot. Watch the model during the tracking to 
check for drift. If the model starts to drift, stop the tracking 
by clicking the Cancel button in the Status bar below the main 
Image window. Correct the alignment of the model and then 
continue the tracking.

9. Go back to the frame where you first aligned the model. The 
easiest way to do this is to go to the last frame and then click 
the Next Solved Frame button on the right of the Play 
controls tool group.

10. Click the Track Backward button. This tracks the object all 
the way to the start.
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11. If you play through the shot now, you should see the model 
moving as though it is locked to the object in the image 
sequence.

12. If you go to the 3D view, you'll see the model and the camera 
path, but no 3D predictions. If you export the camera at this 
stage, it will line up with the OBJ in your 3D animation 
software.

The camera path produced from face-based tracking may not 
be perfect, but it can be used as a starting point. 

Using Mesh Generation
You can generate polygonal meshes from the 3D predictions 
created by boujou 4.1 and export them as .obj files (Maya ASCII 
(*.ma) export is also available via a script). The mesh is generated 
by projecting selected 3D points into 2D and then creating 
connectivity information in 2D, which is then used to mesh the 3D 
structure.

When generating meshes, it may be useful to:

• View only the active 3D points (those whose track has a 
feature in the currently selected frame).

This is so that points arising from non-continuous surfaces are 
not connected together. The 3D points used can either be from 
manual tracks (locators and target tracks) or from those 
automatic tracks that have had 3D points generated.

• Generate more 3D points than are produced by a default 
camera solve.

To turn all tracks with low reprojection error into 3D points, 
from the menu bar click 3D Tasks, point to Solve Tools and 
then click Regenerate Structure.

• Filter out those tracks whose 3D position is poorly constrained 
(e.g. 3D points arising from very short 3D tracks). 

To do this, from the menu bar click 3D Tasks, point to Solve 
Tools and then click Filter Structure.
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To generate meshes:
1. Import an image sequence (for details on doing this, see 

Importing an Image Sequence on page 3-1).

2. Feature track the image sequence (for details, see Tracking 
Features on page 3-9).

3. Perform a camera solve (for details, see Solving the Camera 
on page 3-15).

4. Select the 3D predictions to be used to generate the mesh.

5. From the 3D Tasks menu, select the desired projection 
method:

• Generate Mesh using Current Frame
Project the mesh from the direction of the current camera 
position, as shown in Figure 4-37.

Figure 4-37: Mesh from current frame
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• Generate Mesh using Ground Plane
Project the mesh perpendicular to the ground plane, as 
shown in Figure 4-38.

Figure 4-38: Mesh using ground plane

• Generate Mesh using 3D View
Project the mesh in a user-specified direction using 
current 3D view (you must be in 3D viewing mode), as 
shown in Figure 4-39.

Figure 4-39: Mesh using 3D view

Once you have created your mesh, you can export it as an .obj 
file. To do this, from the menu bar click Export and then click 
Export Meshes. The Export Meshes dialog box is displayed. 
Multiple meshes can be exported.

You can export the mesh as a Maya ASCII (*.ma) file using a 
script. From the Scripts menu, select Export Meshes to Maya.
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Using Feature Tracks
The automatic feature tracks calculated by boujou 4.1 cannot be 
edited directly. However, tracks can be transferred between 
projects and other software packages, inaccurate tracks can be 
deleted, fragmented tracks can be joined, and good tracks can be 
given gold status to improve the solve. A feature track is just a 
series of X and Y coordinates, so exported tracks can be viewed 
in any text editor.

The following sections described advanced methods for using 
feature tracks:

• Editing Automatically Generated Feature Tracks on page 4-70

• Creating Gold Tracks on page 4-72

• Exporting 2D Feature Tracks on page 4-73

• Importing 2D Feature Tracks on page 4-77

• Using Non-Consecutive Feature Tracking on page 4-78

Editing Automatically Generated Feature Tracks
Table 4-10 describes the function of each command shortcut 
menu that is displayed when you right-click a feature track or 
prediction in the Image window.

Table 4-10: Feature Tracks commands

Menu Item Description

Gold Makes the selected track gold. This gives it 
greater priority in the solver and allows you to 
influence which tracks get used and which get 
rejected. This is very useful when fixing 
problem shots.

Flag for 
export

Enables you to export only the tracks or 
predictions that you’re interested in. This helps 
to reduce the amount of data that you export 
and makes the scene more manageable in your 
animation software.
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Join Joins selected track fragments. If a foreground 
object moves in front of a feature that is being 
tracked, the track is broken and a new one is 
created when the feature comes back into view. 
boujou 4.1 does not know that these two tracks 
belong to the same feature and produces two 
3D predictions for that feature instead of one. 
This can mean that your 3D solution is less 
accurate. If you join the track fragments, the 
solver has more information about the position 
of that feature in 3D space and produces a more 
accurate result. 

Select the tracks fragments with the CTRL key 
held down and then choose Join from the right-
click menu. Alternatively use the keyboard 
shortcut CTRL+J. Joined tracks automatically 
become gold. If you have a lot of broken tracks, 
it is quicker and easier to use the Non-
Consecutive Feature Tracking tool. 

Connect 
Survey Point

Connects a selected track to a selected survey 
point. This option is only available when 
working with locators and target tracks.

Select the survey point using a model vertex 
and then CTRL+select the locator/target track 
in one of the other views.

Disconnect 
Survey 
Point(s)

Disconnects selected tracks from survey points 
to which they are connected. This option is only 
available when working with locators and 
target tracks.

Center view 
on selection

Places the track you have selected in the center 
of the camera view.

Table 4-10: Feature Tracks commands

Menu Item Description
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Creating Gold Tracks
Gold tracks help the tracking process in the following ways:

• Feature Tracking
The automatic feature tracker attempts to generate sets of 
tracks that are consistent with gold tracks, generally resulting 
in better automatic tracking.

• Camera Solving
Solutions for the camera solve are forced to include the gold 
tracks. This means that these tracks can never be rejected, 
which is useful if the tracks are in a part of the scene which 
has few other tracks. 

You can create gold tracks to give priority to the following types 
of track:

• Feature tracks generated by the automatic tracking engine

• Manual locator tracks (always gold)

Rename Displays the Rename Track dialog box, in 
which you can give the selected track a more 
meaningful name. 

Default: Named Track 1
Delete Deletes the selected track.
Properties Displays the Named Tracks dialog box, in 

which you can view and configure the 
properties of a named track. A named track is 
a track which has been either made gold or 
flagged for export. You can do most of the 
right-click menu operations from this dialog 
box. The Artifact drop-down list lets you 
choose any named track in the current project. 
If you want to change the properties of several 
named tracks, make sure you click the Apply 
button before you select the next track from the 
Artifact drop-down list.

Table 4-10: Feature Tracks commands

Menu Item Description
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• Target tracks (always gold)

• Tracks imported from other projects or packages

Tip
If you are making more than one track gold, make sure that the tracks 
are spread out in time and that a new track starts before the previous one 
finishes. The easiest way to do this is from the Timeline.

To create a gold track:
• In the Timeline, right-click the desired track and select gold 

from the displayed menu as shown in Figure 4-40 below.

Figure 4-40: Check track spread in Timeline

Exporting 2D Feature Tracks
You can export the 2D tracks created by boujou 4.1 to other 
boujou 4.1 projects or to 2D compositing packages such as Shake 
or Inferno. 
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You configure how boujou 4.1 is to export its 2D feature tracks in 
the Export Feature Tracks dialog box, shown in Figure 4-41.

Figure 4-41: Export Feature Tracks dialog box

Raw feature tracks and 3D predictions can all be exported as 2D 
tracks. Exporting 3D predictions as 2D tracks has the added 
benefit of providing you with tracks that last for the entire length 
of the sequence. There are several format options to allow you to 
export the 2D tracks to suit your compositor. The tracks can be 
scaled so that you can transfer the tracks between projects of 
different resolutions.

To export 2d feature tracks:
1. Open the Export Feature Tracks dialog box in either of the 

following ways:

Toolbox: Export Tracks 

Menu bar: Export > Export Feature Tracks

2. In the Tracks section, in the Filename field, enter a name 
for the exported file.
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3. In the Before Camera Solve section, specify any raw 2D 
tracks that you wish to export:

• Raw Tracks: 2D Feature Tracks as found by the 
automatic feature tracker.

• Target Tracks: Target tracks as 2D tracks. 

• Locator Keyframes: Locators on keyframes (manual 
tracks).

4. In the Projected Tracks section, specify any projected tracks 
(those that are the result of camera tracking and last for the 
entire sequence) that you wish to include in the export:

• Predictions: The 2D positions of 3D predictions on all 
frames.

• Target Track Predictions: The 2D positions of 3D 
predictions calculated from target tracks on all frames. 

• Solved Locators: The 2D positions of locators on all 
frames.

5. In the Camera Solve section, if your project contains several 
camera solve fragments, specify which fragment to export 
projected tracks for using the drop-down list. Text to the left 
of the drop down list indicates the frame range over which 
each camera track fragment is valid. 

6. In the What to export section, specify the tracks that you 
want to export:

• Export all: All tracks of the selected type.

• Flagged only: Only the tracks that have been flagged for 
export.

• From selection: Only the tracks in the current selection 
set.

7. Specify any additional formatting requirements:

• Clipped to frame: All tracks (including predictions) end 
when they leave the frame.

• File per track: Creates a separate file for each track.

• Separate X/Y: Creates separate files for the X and Y 
values of each track.
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8. In the Output scale section, you can resize the tracks and 
change the coordinate system to meet your requirements:

• Predefined Settings: Select the desired preset:

• Default: Linear dimensions in pixels, origin top left.
• x2: Linear dimensions in pixels, scaled by a factor of 

2, origin top left. 
• x4: Linear dimensions in pixels, scaled by a factor of 

4, origin top left. 
• Half Size: Linear dimensions in pixels, scaled by half, 

origin top left.
• Quarter Size: Linear dimensions in pixels, scaled by 

quarter, origin top left.
• Top-Left: Linear dimensions in pixels, origin top left.
• Bottom-Left: Linear dimensions in pixels, origin 

bottom left.
• Normalized [0,1]: Linear dimensions normalized to 

fit in the range 0 to 1, origin top left.
• Center Origin [-1, 1]: Linear dimensions normalized 

to fit in the range -1 to 1, origin in the center.

The selected preset automatically populates the other 
fields in this section, which you can accept or over type 
to meet your requirements:

• X0
• Y0
• X1
• Y1

9. Click OK to start the export.

The text file created consists of the feature track ID, frame 
number, and point coordinates.
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Importing 2D Feature Tracks
You can import a text file containing 2D track data into boujou 4.1. 
You can either import all the feature tracks that you need, or just 
import a small number of good ones and then feature track again. 
You can import feature tracks at any time. 

You configure the way boujou 4.1 is to import 2D track data in the 
Import Tracks dialog box, shown in Figure 4-42.

Figure 4-42: Import Tracks dialog box

To import 2D feature tracks:
1. Open the Import Tracks dialog box in either of the following 

ways:

Toolbox: Import Tracks 

Menu bar: 2D Tasks > Import Tracks

2. In the Filename section, select the text file you wish to import 
using the Browse button.

3. In the Tracks section, set any or all of the following import 
options:

• List as artifacts: Create artifacts for all of the imported 
tracks in the Named Tracks branch of the Taskview.

• Set as Gold: Automatically flag all imported tracks as 
gold (see Creating Gold Tracks on page 4-72).

• Flag for export: Automatically flag all imported tracks for 
export (see Editing Automatically Generated Feature 
Tracks on page 4-70.)
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4. In the Origin section, select the option for interpreting the 
imported track coordinates as having their origin either at the 
Top Left or the Bottom Left of the image.

5. Select the Import from Shake txt format option to create 
feature tracks in boujou 4.1 from 2D tracks exported from 
Shake as .txt files.

6. Click OK.

Using Non-Consecutive Feature Tracking
The non-consecutive feature tracker is a very useful tool for 
creating tracking matches between frames that are more than one 
frame apart on the Timeline. If an object in your shot goes out of 
frame and then comes back in again, or if a large foreground 
object moves across the scene and cuts the background tracks, 
the non-consecutive feature tracker can join the fragments and 
improve the 3D solution.

You configure the way boujou 4.1 handles such features in the 
Non-consecutive Feature Tracking Properties dialog box, 
shown in Figure 4-43.

Figure 4-43: Non-consecutive Feature Tracking Properties
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To use non-consecutive feature tracking:
1. Feature track your shot.

2. Open the Non-consecutive Feature Tracking Properties 
dialog box in either of the following ways:

Toolbox: Non-Consecutive Feature Tracking 

Menu bar: 2D Tasks > Non-Consecutive Feature Tracking

3. The Preview shows the two frames that you want to track 
between. By default the first and last frames of the sequence 
are displayed. If there was a break in the feature tracking, the 
frames either side of the break are displayed. You can use the 
usual boujou 4.1 navigation shortcuts to pan and zoom in the 
preview windows.

4. The Frames fields enable you to specify the two frames to be 
tracked.

5. The Flip between frames button swaps over the frames 
being displayed in the Preview for as long as the button is 
pressed. This is very useful for checking that the tracker has 
found good matches.

6. Set the Initial search distance (%) to an appropriate value 
for the frames that you are trying to match. If a particular 
feature in the scene has moved a large distance between the 
two frames, increase the value of Initial search distance. 
The higher the value, the greater the chance of incorrect 
matches being made.

7. When you have specified which two frames to match, click the 
Do matching button. The Status field shows how many 
matches have been made. If no matches were made, the 
message ‘matching failed’ is displayed.

8. If matching fails, try either adjusting the Initial search 
distance (%) value, or add a locator in the main boujou 4.1 
Image window (not in the Preview). The locator should have 
a keyframe on each of the two frames that you want to match 
between.
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9. When you are happy with the matches that have been made, 
click the Commit matches button and then start camera 
solving.

Assessing Lens Distortion
Lens distortion can have a serious effect on the quality of tracking 
and, if left uncorrected, can make it impossible to get a usable 
camera track from your footage. Distortion makes objects appear 
to change shape depending on where they are in the frame: a cube 
in the center of the frame looks different from a cube at the edge 
of the frame because the distortion increases as you move further 
from the center. This can make things very difficult for boujou 4.1 
because it cannot work out the 3D structure of non-rigid objects. 

boujou 4.1 has tools that allow you to estimate how much 
distortion there is in your shot and correct for it. These tools work 
by unwarping the image until features that you know should be 
straight line up with a calibration line that is always straight (as 
described in Understanding the Lens Distortion Pipeline on 
page 4-81). This task is made much easier if you shoot a lens grid, 
as shown in Figure 4-44, with your camera at the time of the 
shoot.

Figure 4-44: Camera lens grid

Important
If you apply a correction for radial distortion after you have initialized any 
cameras or there is an existing solve in a project, the existing cameras or 
solve will no longer be valid for the undistorted images.
This can affect the behavior of the Vertex drag tool.
Any solves with existing predictions can be corrected by performing an 
Adjust solve after radial correction has been applied.
If you are aligning a model and using default camera views, such as those 
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created when initializing the key schedule, these views should be 
regenerated before using the Vertex align tool.
If you apply a value of R in the Advanced tab of the Cameras dialog box 
and there is an existing solve or any initialized cameras, a warning 
message is displayed alerting you to this fact.

The following sections describe the tools boujou 4.1 provides to 
assess lens distortion:

• Manually Assessing Lens Distortion
• Automatically Assessing Lens Distortion on page 4-87
• Exporting a Corrected Image Sequence on page 4-90
• Lens-adjusting an External Sequence on page 4-92

Understanding the Lens Distortion Pipeline
Before assessing lens distortion, it is important to understand the 
process pipeline, which is described in Table 4-11.

Table 4-11: Lens Distortion Pipeline

No. Example Setting Description

1 D1 PAL

720x576

In this example the original images 
are D1 PAL resolution (720x576). 
Correcting for lens distortion involves 
warping the original image until all 
straight lines stop looking curved. 
This process results in a new set of 
images that are of a different size to 
the originals—they are larger if the 
value of R is positive and smaller if the 
value is negative. Because of this the 
camera that you export from 
boujou 4.1 is a custom type.
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2 Custom

810x648

A radial distortion value of 0.25 gives 
a custom camera with an image size 
of 810x648. You need to export the 
undistorted images from boujou 4.1 
using the Export Sequence tool to 
act as the background image 
sequence in your animation software. 
The 3D structure that boujou 4.1 
calculates is undistorted, and so you 
need to have undistorted images in 
the background for the 3D points to 
line up with features in the image.

3 Custom

810x648

Render the augmenting objects in 
your animation software with an 
alpha channel at the same resolution 
as the undistorted images exported 
from boujou 4.1 (in this example 
810x648). Do not render the 
background image. 

4 D1 PAL

720x576

Use boujou 4.1 to redistort the 
rendered sequence so that it matches 
the original footage. This can be done 
using the Lens-Adjust External 
Sequence tool. After the rendered 
images have been redistorted they 
should be in the same resolution as 
the original footage. 

5 D1 PAL

720x576

Composite the distorted CG frames on 
top of the original background plates. 

Table 4-11: Lens Distortion Pipeline

No. Example Setting Description
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Understanding boujou Lens Distortion Assessment

If you are an advanced user, you may also need to understand 
boujou 4.1’s lens distortion model, for example, to write a 
program to remove the lens distortion from your images before 
importing them into boujou 4.1. Otherwise, the information in this 
section is not necessary for the basic use of the boujou 4.1 lens 
distortion assessment tools.
boujou 4.1 uses the following single-parameter model to calculate 
lens distortion:

where:

is the lens distortion value in the boujou 4.1 Cameras 
dialog box (R).
is the pixel position in an image (the image contains 
distortion).
is the new pixel position when lens distortion is 
removed.
is the principal point position in pixels (the center of the 
image).

 is the width of the image in pixels.

is the height of the image in pixels.

is the film back width.

 is the film back height.
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Manually Assessing Lens Distortion
If your scene contains straight lines, you can use calibration lines 
to manually assess the amount of lens distortion in your shot using 
the Assess Lens Distortion dialog box, shown in Figure 4-45.

Figure 4-45: Assess Lens Distortion dialog box

To manually assess lens distortion:
1. Open the Assess Lens Distortion dialog box, shown in 

Figure 4-45, in either of the following ways:

Toolbox: Assess Distortion 

Menu bar: Setup > Assess Lens Distortion (manual)

2. The navigation controls in the Assess Lens Distortion 
window are exactly the same as in the main 2D view. To jump 
to a specific frame number, right-click the Timebar and the Go 
to frame button appears. Click it and the Go to frame dialog 
box is displayed. Enter the frame number that you want to go 
to and then click OK.

3. If your camera has a non-centered principal point, enter the 
correct position in the Principal Point %X and %Y fields. 
These values are the percentage distances of the principal 
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point from the top left corner of the image. X is the horizontal 
distance and Y is the vertical distance.

4. If you know the value of the distortion parameter, R, for the 
shot you are working on, enter it in the R field. Click the 
Toggle Radial Display to preview the results.

5. If you do not know how much distortion there is in your shot, 
you can estimate it by adding a calibration line. A calibration 
line is a line that is always straight regardless of how much you 
warp the background. The end points of the calibration line 
should both be on a feature in the image that you know is 
straight, for example, the corner of a building, a door frame, 
or the edge of a table. Change the value of R to undistort the 
image until the feature that you know should be straight is 
parallel to the calibration line. Try to avoid features that go 
through the center of the image as these are not distorted; 
lines are more distorted the further away they are from the 
center of the image. To add a calibration line click the Add 
Calibration Line button.

6. Click and drag in the image to draw a calibration line. Release 
the mouse button to stop drawing. When you click away from 
the line it changes color from yellow to cyan.

7. Click the line to edit it. It turns green and white boxes appear 
at each end. Click and drag these boxes to adjust the position 
of the calibration line.

8. Change the value of R using the up and down arrows next to 
the number field. Adjust the Step value if required (this 
controls by how much the value of R changes when you click 
the arrows). When the feature in the image is parallel with the 
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calibration line, as shown in Figure 4-46, click the OK button 
to apply the distortion correction and close the window.

Figure 4-46: Adjust feature to match calibration line

9. A Calibration line 1 artifact is added to the Taskview. If you 
double-click the artifact, the Calibration Lines dialog box is 
displayed, as shown in Figure 4-47, allowing you to delete or 
rename any of the calibration lines in the current project. If 
you click the Adjust Radial button, the Assess Lens 
Distortion window is displayed.

Figure 4-47: Calibration Lines dialog box

10. You can now feature track and camera solve your shot as 
usual.

11. Once you have determined the radial distortion for your lens, 
you can type it into boujou 4.1’s Cameras dialog box for 
every shot using that lens. The distortion and principal point 



Advanced Functions

boujou 4.1 Reference Guide 4-87

settings are under the Advanced tab, as shown in 
Figure 4-48.

Figure 4-48: Cameras dialog box—Advanced tab

Automatically Assessing Lens Distortion
It is not always possible to use calibration lines to assess the 
amount of lens distortion in your shot. Some scenes contain no 
straight lines, and if you didn’t shoot a lens grid before you started 
filming, you have no way of telling if you have removed all of the 
distortion. You can use the Auto-assess radial lens distortion 
dialog box, shown in Figure 4-49, to automatically calculate the 
optimum value of R for an existing camera solve. No calibration 
lines are needed and so scenes without straight lines are no longer 
a problem.

Figure 4-49: Auto-assess radial lens distortion dialog box

To automatically assess lens distortion:
1. Camera solve an image sequence.

2. Open the Auto-assess radial lens distortion dialog box in 
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any of the following ways:

Menu bar: 3D Tasks > Assess Lens Distortion (automatic) 

Advanced Camera Solve Properties dialog box: Optimize 
radial distortion parameters option

Solve Adjust dialog box: Optimize radial distortion 
parameters option

3. Choose the camera solve that you want to assess from the 
Use solve drop-down list.

4. If you corrected for lens distortion before you tracked the 
camera, the value of R that you used appears in the Current 
radial coefficient field.

5. Click the Assess radial button to make boujou 4.1 
automatically calculate the optimum value of lens distortion 
for the current camera track. The calculated value of R 
appears in the Auto-estimated R field. It is also shown in the 
Console pane.

6. If this value looks appropriate, click the Accept and Adjust 
button. An Adjust Solve camera solve is done, using the new 
value of R, which is written in the Advanced tab of the 
Cameras dialog box.

You can also find the optimum value of R from the Advanced 
Camera Solve Properties dialog box, shown in Figure 4-50 on 
page 4-89.
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Figure 4-50: Advanced Camera Solve Properties dialog box

In the Advanced solve refinement section. select the Optimize 
radial distortion parameters check box to automatically 
calculate the value of R, either as part of a Complete camera 
solve or an Adjust Solve. The calculated value of R is written in 
the Advanced tab of the Cameras dialog box, overwriting any 
existing value.
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Exporting a Corrected Image Sequence
Once you have corrected your image sequence for lens distortion 
you may want to export the undistorted images. These corrected 
images are then used as the background sequence in your 3D 
animation package.

You export image sequences using the Export Sequence dialog 
box, shown in Figure 4-51.

Figure 4-51: Export Sequence dialog box

To export an image sequence:
1. Open the Export Sequence dialog box in any of the following 

ways:

Toolbox: Export Sequence 

Menu bar: Export > Export Sequence 

Keyboard shortcut: F11

2. Using Browse button choose the location where you wish to 
save the exported image sequence and enter a name in the 
Filename field.
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3. Specify the image file Format that you'd like to export. For 
details of supported export image formats file formats, see 
Table 1-2 on page 1-3.

4. Specify the Output filename format. This is the template 
that is used for writing each image file in the sequence. The 
default is name.###.extension.

5. Set the Start frame, Step size, and End frame.

6. Set the Number From and Number Step options if required. 
If you want to export boujou 4.1 frames 0, 1, 2, 3, and 4 as 
1, 3, 5, 7, and 9, set Number From to 1 and Number Step 
to 2.

7. To save the images with the current overlays on (feature 
tracks, locators, predictions etc.) check the Use overlays 
from active view box. You can't change the active overlays 
if the Export Image Sequence dialog box is open.

8. To save images with brightness and contrast display 
adjustments made in the display controls of the Zoom Tool 
pane, select the Apply Display Adjustments check box.

9. If you want to save out images with the lens distortion 
removed or images with a non-centered principal point, check 
the required boxes under the Adjust Exported Sequence 
For heading. These boxes only become active if you have 
corrected for lens distortion or non-centered principal point 
within the current project:

• Lens Distortion: Export the image sequence with the 
lens distortion correction applied.

• Non-centered principal point: Export the image 
sequence with the principal point correction applied.

10. You can scale the exported images using the Output size 
option. Select the required option from the Resize drop-down 
list:

• No Resize: Export at the original image resolution.

• Custom: Export at the resolution specified in the Width 
and Height options, which become active when this 
option is selected.
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• Half: Export at one-half of the original image resolution.

• Quarter: Export at one-quarter of the original image 
resolution.

• Eighth: Export at one-eighth of the original image 
resolution.

11. Click OK to start exporting the sequence.

Lens-adjusting an External Sequence
If you have corrected for lens distortion in your boujou 4.1 project, 
you need to redistort your CG material to match the original 
distorted images using the Lens Adjust External Sequence 
dialog box, shown in Figure 4-52.

Figure 4-52: Lens Adjust External Sequence dialog box

To adjust lens distortion for an external sequence:
1. Open the boujou 4.1 project file for the shot that you have 

tracked and exported to your animation software. This project 
file contains the appropriate camera settings, radial distortion 
value (R), and principal point values. These values are 
required to make sure that the CG images that you have just 
rendered get redistorted by the correct amount to match the 
original images.
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2. Open the Lens Adjust External Sequence dialog box in 
either of the following ways:

Toolbox: Lens Adjust External Sequence 
Menu bar: Export > Lens Adjust External Sequence

3. Click the Browse button to browse for the CG image sequence 
that you want to redistort. The file name and path of the first 
frame of the sequence are displayed in the Filename field.

4. Set the Start, Step, and End frames as appropriate.

5. In the Output Sequence section of the dialog box, Browse 
for the directory where you want to write the images and give 
the file name root (typing name.###.extension makes sure 
you keep any leading zeroes in the frame numbers).

6. From the Export Type drop down list, select the required 
export format as shown in Table 4-12. Not all of these formats 
support alpha channels.

A preview of how the file name will be formatted appears in 
the Output filename format area.

Table 4-12: Lens-adjusted export file formats

File Format Extension Support

Cineon .cin 30- or 40-bits per pixel.

Maya IFF .iff Full IFF support.

JPEG .jpg Full JPEG support.

Softimage .pic 24- or 32-bits per pixel, with or 
without encoding.

PNG .png Full PNG support.

PPM .ppm Full PPM support.

SGI .rgb Silicon Graphics Bitmap RGB or 
RGBA, with or without encoding, 
8- or 16-bits per component.

TIFF .tiff Grayscale, RGB or RGBA, with or 
without encoding, 8- or 16-bits 
per component.
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7. Set the Number From and Numbering Step options if 
required. For example, if you want to export frames 0, 1, 2, 
3 as 1, 3, 5, 7, set Number From to 1 and Numbering Step 
to 2.

8. The Save button becomes active. Click it to start exporting the 
redistorted images.

Setting User Preferences
You can change the appearance of the boujou 4.1 interface and 
the tool settings in the Preferences dialog box, shown in Figure 
4-53. You can save your preferences and transfer them from one 
computer to another.

Figure 4-53: Preferences dialog box

To set up user preferences:
1. Open the Preferences dialog box in either of the following 

ways:

Toolbox: Preferences 
Menu bar: Edit > Preferences (Windows)
or boujou > Preferences (OS X)

2. The Preferences dialog box contains the following sections:

• 2D Display
• 3D Display
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• Camera Export
• Dialog
• Directories
• Graph Display
• Image Formats
• Import
• Miscellaneous
• Target Tracking
Click the + to expand each branch and display the settings you 
can set. For details of the preferences you can set within each 
of these sections, see Appendix B boujou 4.1 Preferences.

3. Use the controls at the bottom section of the Preferences 
dialog box to make your changes. For options that set colors, 
the Browse button opens a color palette from which to select.

4. Click the Reset all values button to change the preferences 
back to the default settings. 

Caution
This action cannot be undone.

5. You can save your preferences to a *.bpf file by clicking the 
Save to file button. You can import a *.bpf file by clicking the 
Load from file button.

6. Click OK to apply the changes and close the dialog box. Some 
preferences require you to close down boujou 4.1 and start it 
up again before they take effect.

Using boujou 4.1_script for Command-line Processing
boujou_script is a command-line version of boujou that enables 
you to create, track, and solve project files. You can process 
multiple project files using a batch file if desired. For example, for 
each image sequence that you want to track, you would run the 
normal version of boujou, set up the image sequence and the 
camera, and then save the project. You would then create a 
boujou_script file and run it from the command line to track and 
solve them all, one after the other.

Tip
If boujou_script encounters an error during processing, it terminates. This 
can be very inconvenient if it happens at the beginning of a long series of 
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shots. Therefore, it is a good idea to write a separate boujou_script file 
for each project and then run them consecutively using a batch file.

To write a boujou_script file:
1. Open a standard text editor.

2. Type the desired commands, using the following syntax:

BoujouScriptFile{}
command { argument1 value1 argument2 value2 argument3 
“value with spaces” }

where:

For an example boujou_script file and details of the 
commands, arguments, and values you can specify, see 
Appendix D boujou_script File Commands.

3. Save your boujou_script file with a .bsc file extension.

To run a boujou_script file:
1. Open a command session.

2. Change to the boujou 4.1 directory, which contains the 
boujou_script.exe file, by default:

• C:\Program Files\2d3\boujou 4 (Windows)
• usr/local/ boujou 4_0_1 (Linux)
• applications/boujou4 (OS X)

BoujouScriptFile {} is the required first line.
command is one of the available boujou_script 

functions.
argument is a characteristic of the specified 

function.
value is the data that the script is to 

process.

A space is considered a separator, 
so you must enclose any value 
containing spaces (for example, a 
directory path name) in quotation 
marks.
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3. Enter the following command:

boujou_script -name filename.bsc

where filename.bsc is the full path and file name of your 
boujou_script file.
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55Export  to  an Animat ion
Package

This chapter describes how to export data from boujou 4.1 for use 
in 3D animation package. It gives general guidance as well as 
information specific to supported export formats:

• Exporting a boujou 4.1 Scene for an Animation Package

• Importing a boujou 4.1 Scene into an Animation Package on 
page 5-4

• Exporting boujou 4.1 Data into Other Formats on page 5-17

Exporting a boujou 4.1 Scene for an Animation Package
This section describes how you can export the scene file created 
in boujou 4.1 for use in the 3D animation package that you are 
using. boujou 4.1 uses a Y-up, right-handed coordinate system by 
default, but it can be set to Z-up in the Preferences (for details, 
see Appendix B boujou 4.1 Preferences).

Caution
Only try to augment a part of the scene where there is a good coverage 
of predictions. If you place an augmenting object in an area where there 
are no predictions, it may appear to slip. The 3D predictions show you 
where the virtual camera is likely to give you good augmentation results.
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You configure the way boujou exports a scene file in the Export 
Camera dialog box, shown in Figure 5-1.

Figure 5-1: Export Camera dialog box

To export a boujou 4.1 scene file for a 3D animation pack-
age:
1. Open the Export Camera dialog box in any of the following 

ways:

Toolbox: Export Camera Solve 

Menu bar: Export > Export Camera Solve 

Keyboard shortcut: F12

2. In the Filename field, enter the name of the file. 
Alternatively, if you want to overwrite an existing file use the 
Browse button.

3. In the Export details section, specify the following options:

• Use the Camera Solve - Valid from option if you are 
exporting broken solves. If you have several solve 
fragments, your camera export is not going to be valid for 
the entire length of the sequence. The Valid from field 
tells you the duration of the current solve fragment.
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• In Export Type, select the appropriate file format from 
the drop-down list. For details of available export file 
formats, see Chapter 1 Supported Camera Export File 
Formats.

• Choose the appropriate Move Type:

• Moving camera, static scene: 3D points stationary, 
camera rotates and translates. (default).

• Panning camera, Translating Scene: Camera 
rotates only, 3D points translate.

• Static camera, Moving Scene: Camera static, 3D 
points rotate and translate.

Most export formats allow you to export a static camera 
and moving points, or a panning camera and translating 
points, in addition to the default moving camera and static 
points.

• Select the Export flagged tracks only check box if you 
want to export only the tracks that were flagged for export 
in the Named Tracks dialog box.

4. In the Parameters section, specify the following options:

• You can export a subsection of the camera track by 
specifying Start Frame, Step, and End.

• The Start Index allows you to export with a non-zero first 
frame; Null Size changes the size of the 3D features 
within the animation package; Scale Scene by changes 
the global scale of the exported scene. 

Tip
You can set the default value of Scene Scale in the Preferences 
dialog box. From the menu bar, click Edit then click Preferences. 
Expand Camera Export and then General. Select Default Scale 
and change the value. For details, see Appendix B boujou 4.1 
Preferences.

 The Start Index and Null Size fields become available 
and you can enter the required value for the first frame. 
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• If you want to export with a different first frame index, 
clear the Use format default for start index and null 
size check box. boujou 4.1 defaults to using the Number 
From value from the Image Sequence dialog box when 
it exports.

5. Click Save. 

Warning
Only export the scene points for the features that you’re interested in. This 
makes the scene far more manageable when the points have been 
imported. Use the Flag Tracks for Export feature from the right-click 
menu in the main boujou 4.1 workspace.

Importing a boujou 4.1 Scene into an Animation 
Package

Once you have exported a scene file created in boujou 4.1, as 
described in Exporting a boujou 4.1 Scene for an Animation 
Package on page 5-1, you can import it into a supported third-
party animation package:

• Importing a Scene into 3D Studio Max on page 5-5
• Importing a Scene into After Effects on page 5-6
• Importing a scene into Cinema 4D on page 5-6
• Importing a scene into Cineon on page 5-8
• Importing a Scene into Combustion on page 5-9
• Importing a Scene into Flame, Inferno, or Smoke on page 5-9
• Importing a Scene into Fusion on page 5-10
• Importing a Scene into Houdini on page 5-11
• Importing a Scene into LightWave on page 5-11
• Importing a Scene into Maya on page 5-12
• Importing a Scene into Softimage XSI on page 5-12

Important
Not every third-party animation package works in the same way, and not 
every export format supports the same parameters. It is important to 
understand the limitations of your chosen animation package before you 
start working with camera tracking data exported from boujou 4.1.
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Importing a Scene into 3D Studio Max
boujou 4.1 creates a Max script file for importing into Max 3 and 
above.

Important
Max uses a Z-up, right-handed coordinate system.

To import a boujou 4.1 scene into 3D Studio Max:
1. From the menu bar, select on MAXScripts > Run Script.

2. Browse for the *.ms script created by boujou 4.1 and run it; 
a camera and a series of scene points appear in the 
workspace.

On export of the .ms file from boujou 4.1, an image index file 
(.ifl) is saved into the same directory as the original tracked 
image sequence. This file is referenced in the exported Max 
Script file and is used to load the image sequence into 
3DS Max when the script is run.
The image sequence is loaded as a viewport background 
image for the active viewport in 3DS Max. After import, 
ensure that the active 3DS Max viewport is set to the 
boujou 4.1 camera and then ensure that the Viewport 
Background for this viewport is set to display the image 
sequence. This can be done from the View menu > Viewport 
Background in 3DS Max. The viewport can be set to update 
with the animated images from the Customize > Preferences 
> Viewports Update Background when playing.
When boujou 4.1 writes the Max script file it converts the 
value of focal length it has calculated into a field of view using 
the film back settings. When you come to render your scene 
in Max, the field of view is converted to a focal length using 
the value of render aperture width given in the Render Scene 
dialog box. This value should be set appropriately to the 
correct film back setting by the exported Max script but should 
be checked if Max performs final renders with the wrong value 
for focal length. Unless you set this value to the correct film 
back setting, Max will use the wrong value of focal length for 
your final render.
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Important
Only export the scene points for the features that you’re interested 
in. This makes the Max workspace far more manageable when the 
points have been loaded. Use the Flagged for Export feature in the 
Taskview > Named Tracks dialog box.

Importing a Scene into After Effects
boujou 4.1 exports Maya (.ma) files for import into Adobe After 
Effects When the .ma file is imported into After Effects, it creates 
two compositions: one with the same name as the boujou 4.1 
project and the other with the prefix square. The latter is required 
to correct for non-square pixels in the original sequence.

In the composition window you will see a number of small red 
squares. These squares represent the position of the 3D 
predictions exported from boujou 4.1. You need to use these 
points as reference to place your additional layers at the correct 
distance from the camera.

Important
After Effects uses a Y-up coordinate system.

Importing a scene into Cinema 4D
When exporting for Cinema 4D, boujou 4.1 creates a .c4d file 
which can be loaded directly into Cinema 4D. An animated camera 
and a hierarchy of points are automatically created.

You can also use the plug-in available on the Resource disc to 
import into Cinema 4D. A different plug-in is required depending 
on which version of Cinema 4D you are using:

• The plug-in for release 8 works on both the Windows and 
Macintosh versions (release 8 and above). 

• The plug-in for release 7 works on Windows. It reads the 
boujou 4.1 ASCII text export.

Cinema 4D can also read the LightWave (*.lws) and FBX exports.
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To import a boujou 4.1 scene into Cinema 4D Release 8:
1. Open boujou 4.1 and click Edit > Preferences > Camera > 

Export > boujou 4.1 Animation > Camera Format and 
set to Both Formats for each Key (for details, see 
Appendix B boujou 4.1 Preferences).

2. Export your camera solving results as a boujou 4.1 Animation 
file (*.ban).

3. Create a folder called ban in your Cinema4D plugins directory 
(e.g. CINEMA_4D_R8\Plugins\ban).

4. Copy the boujou 4.1 plug-in (filter_ban.cob and 
plugin_ban.cob) into the ban folder you have just created

5. Start Cinema4D and go to File > Open

6. Ensure you have set File of type to All files and select the 
.ban file you exported from boujou 4.1.

7. In the View window go to Cameras > Scene Cameras > 
”Camera_1” to look through the boujou 4.1 camera.

To import a boujou 4.1 scene into Cinema 4D Release 7:
1. Track your shot with boujou 4.1 and export the results as an 

ASCII text file. Put the image sequence in the 
Cinema4D\CINEMA 4D XL Release 7 directory.

2. Copy the plug-in (boujou.cof or boujou.cob) into the Cinema 
4D plugins directory. Launch Cinema 4D.

3. Go to Plugins > boujou 4.1 import.

4. In the Viewing window, select Cameras > Scene Camera 
> boujou 4.1 Camera.

5. In the Materials window, select File > New Material.

6. Right-click Material > Edit. In the dialog box, select Image 
and browse for the image sequence in the Cinema4D\CINEMA 
4D XL Release 7 directory. Select Edit, then Calculate, then 
OK.

7. Right-click Camera in Object List > Edit. Enter the correct 
value of Focal Length and enter the filmback width value in 
the Aperture Width field - these values are not set by the 
plug-in. These values are written in the *.txt file exported 
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from boujou 4.1, and can also be found from the Camera 
Solves Summary artifact in boujou 4.1’s Taskview.

Importing a scene into Cineon
The export to Cineon is done via a *.jdf file. The layout contained 
in the file has a 3D Space node holding the camera and point data, 
and some nodes to set up a simple image patch for display of the 
point positions. The null size option in boujou 4.1 sets the size 
of this image patch in pixels. If the three planes per point user 
preference is set in boujou 4.1, each point is displayed as a set of 
three perpendicular patches, which can make the point’s position 
easier to see.

Important
Cineon uses a Y-up, right-handed coordinate system.

To import a boujou 4.1 scene into Cineon:
1. To view the basic output, create an input node holding the 

background footage and attach it as an input to the 3D space 
node. 

2. Attach an output node to the 3D space node. 

A render of the output should show the points from boujou 4.1 
moving correctly in relation to the background sequence.

3. It may be necessary to set the scale scene by option to 
something like 10 or 100 when exporting from boujou 4.1, for 
the scene to appear at a sensible size in Cineon. 

If a low resolution proxy was used for tracking in boujou 4.1, 
set the flow graph base size to the full render size and multiply 
the value in 3dSpaceNode/Camera/Format/Scan 
Resolution by the ratio of the sizes. For example, if tracking 
was on a half resolution proxy, change the value from 20.82 
to 41.64.
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Importing a Scene into Combustion
boujou 4.1 creates a *.cws workspace file that can be loaded 
directly into Combustion.

Important
Combustion uses a Y-up, left-handed coordinate system.

Only export the scene points for the features that you’re interested in. This 
makes the workspace file far more manageable when loaded into 
Combustion. Use the Flag Tracks for Export feature from the right-click 
menu in the main boujou 4.1 workspace.

To import a boujou 4.1 scene into Combustion:
• Double-click the *.cws file exported from boujou 4.1. This 

launches Combustion and sets up the camera, background 
image, and scene points (nulls).

Importing a Scene into Flame, Inferno, or Smoke
boujou 4.1 creates a *.action file that had be loaded directly into 
flame, inferno, or smoke.

Important
flame, inferno, and smoke use a Y-up, right-handed coordinate system.

Only export the scene points for the features that you're interested in. This 
makes the scene far more manageable when loaded into flame or inferno. 
Use the Flagged for Export feature from the right-click menu in the main 
boujou 4.1 workspace.

To import a boujou 4.1 scene into flame, inferno, or 
smoke:
1. Enter the action module using arbitrary clips. These clips are 

ignored once the setup has loaded.

2. Select load and navigate to the directory where the *.action 
file is stored.

3. Select All and load the setup.

4. Select the background layer, press Add, and choose the clip 
which was tracked in boujou 4.1 from the desktop.
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Importing a Scene into Fusion
boujou 4.1 creates a Fusion 5.0 (.comp) file that can be loaded 
directly into Fusion. This file contains the image sequence which 
is used for tracking, a 3D animated camera, a 3D point cloud and 
a merge node. The network created on import into Fusion is shown 
in Figure 5-2.

Figure 5-2: Fusion network created on import

Important
Fusion uses a Y-up, left-handed coordinate system.
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Importing a Scene into Houdini
boujou 4.1 creates a Houdini 4.1 (.hip) project file that can be 
loaded directly into Side Effects Software's Houdini.

Important
Houdini uses a Y-up, right-handed coordinate system.

To import a boujou 4.1 scene into Houdini:
• Go to File > Load and browse for the *.hip file exported from 

boujou 4.1.
Warning
Houdini 4 does not support Windows AVI files as background images.

An animated camera, the 3D scene points, and the 
background image are all created in the workspace. To group 
the 3D points as a single object set the Houdini Compound 
Points option in Edit > Preferences > Camera Export > 
Houdini (for details, see Appendix B boujou 4.1 
Preferences).

Importing a Scene into LightWave
boujou 4.1 creates a LightWave 6.5 (.lws) scene file that can be 
loaded directly into the layout module of NewTek’s LightWave. 
This export has been successfully tested in LightWave 8.
Important
LightWave uses a Y-up, left-handed coordinate system.

To import a boujou 4.1 scene into LightWave:
• Go to File > Load Scene and browse for the *.lws scene 

exported from boujou 4.1.

A camera and a series of scene points appear in the 
workspace. You have to load the tracked image sequence as 
the background image separately. There is a limit to the 
number of 3D points that can be loaded into LightWave. The 
default value of 1000 can often prove inadequate for complex 
scenes. To increase this value you must edit the lw3.cfg file 
(in Windows NT4 this is held in the WINNT\Profiles\userName 
directory). Search for the line MaxObjects 1000 and set it to 
2000.
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Importing a Scene into Maya
boujou 4.1 creates a Maya ASCII (.ma) file that can be loaded 
directly into Maya 2 and above. An animated camera, image plane, 
and a hierarchy of scene points are automatically generated. It 
uses Maya’s default units of centimeters and degrees.

Important
Maya uses a Y-up, right-handed coordinate system

To import a boujou 4.1 scene into Maya:
• In Maya go to File > Open Scene and select Files of type: 

Maya scene (*.mb, *.ma) and browse for the .ma exported 
file from boujou 4.1.

If you use File > Import to load the *.ma file, Maya does not 
change the default values of units and frame rate. This can 
result in the boujou 4.1 camera keyframes not lining up with 
the background images.

Warning
Do not change the name of your camera within boujou 4.1 to 
something starting with a number. Maya does not like object names 
that begin with a number and will fail to load the animation data onto 
the boujou 4.1 camera.

Importing a Scene into Softimage XSI
boujou 4.1 exports to Softimage and XSI using the dotXSI format. 
This format is interpreted differently by the various versions of 
Softimage products, and so boujou 4.1 must export its data using 
several variations of the dotXSI format.

Important
Softimage 3D & XSI use a Y-up, right-handed coordinate system.

Warning
Softimage 3D only supports its own image format (*.pic). Make sure that 
your *.pic files have the same pixel aspect ratio as the boujou 4.1 camera. 
If the pixel aspect ratio is wrong, the 3D points won’t line up with the 
background image.
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To import a boujou 4.1 scene into Softimage 3.8 (dotXSI 
version 1.3):
1. Set the playback speed to the appropriate value before 

importing the scene or the data will be fitted to a 30fps 
Timeline. Playback speed is set in Motion Module > Play 
Control.

2. Import the dotXSI file using Tools Module > Import > 
Objects > ASCII Import.

Constraints are not supported in this version of the dotXSI 
format, so the camera is animated directly. The camera and 
the boujou 4.1 reference cannot be grouped together, which 
makes applying global transformations to the scene very 
difficult.

To import a boujou 4.1 scene into Softimage 3.9.1 
(dotXSI version 2.0):
1. Set the playback speed to the appropriate value before 

importing the scene or the data will be fitted to a 30fps 
Timeline. Playback speed is set in Motion Module > Play 
Control.

2. Import the dotXSI file using Tools Module > Import > 
Objects > XSI Import.

The camera is constrained to a set of nulls that are grouped with 
the boujou 4.1 reference points. Roll is controlled by an up-vector 
constraint. Global transformations can now be applied to the 
points and the camera simultaneously by selecting the top node 
of the hierarchy of nulls imported from boujou 4.1.

To import a boujou 4.1 scene into Softimage 3.9.2 
(dotXSI version 3.0):
1. Set the playback speed to the appropriate value before 

importing the scene or the data will be fitted to a 30fps 
Timeline. Playback speed is set in Motion Module > Play 
Control.

Warning
Softimage 3.9.2 defaults to a vertical field of view.

2. Import the dotXSI file using Tools Module > Import > 
Objects > XSI Import.
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The camera is constrained to a set of nulls that are grouped 
with the boujou 4.1 reference points. Roll is controlled by an 
up-vector constraint. Global transformations can now be 
applied to the points and the camera simultaneously by 
selecting the top node of the hierarchy of nulls imported from 
boujou 4.1.

To import a boujou 4.1 scene into XSI 1.5 (dotXSI version 
3.0):
1. Import the dotXSI file using File > Import > Import xsi.

Warning
XSI 1.5 defaults to a horizontal field of view.

On some systems XSI gives you the error The file does not 
exist on import, or the .xsi file that you exported from 
boujou 4.1 does not appear in the file browser. To get around 
this problem drag and drop the file into the XSI workspace.

2. Make sure that the Timeline frame rate and the camera format 
are set to the appropriate values (XSI defaults to a NTSC 
camera with a frame rate of 29.97 fps).

The camera and camera interest are animated directly. The 
camera gets its pan and tilt rotations from the translation of 
the camera interest, and the camera roll is animated 
separately. All of the scene elements (camera, interest and 
reference points) are grouped under a parent null named 
TopNull.

XSI does not refer the camera roll values to the orientation of the 
parent null. Instead it uses the global orientation. This means that 
if you try to apply a rotation to the entire hierarchy the camera 
roll values stay constant relative to the global axis system and 
your 3D points are not in the correct position relative to the 
background image.

To get around this problem you should use the Softimage 3.9.2 
export. Because of the incompatibilities between Softimage and 
XSI some manual set-up is required to make the reference points 
line up with the background image.

XSI 1.5 defaults to a horizontal field of view for the camera 
imported from boujou 4.1, whereas Softimage 3D defaults to a 
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vertical field of view. You need to bring up the bou_cam 
properties dialog box to set the field of view to the correct 
orientation (vertical).

The Softimage 3.9.2 export uses an up-vector constraint to 
control camera roll, but XSI only supports up-vector constraints 
for IK chains. Without this constraint the camera will not roll and 
the nulls will not line up with the features in the background image. 

To correct the camera roll in XSI 1.5 (dotXSI version 3.0):
1. Load the .xsi file from boujou 4.1 into XSI.

2. In a schematic view select bou_cam.

3. In the menu bar select constrain > direction.

4. When it prompts you for a target reference, click 
camera_1_up_vector in the schematic view.

5. A properties window is displayed for the new direction 
constraint (with the title scene_root:bou_cam: direction 
cns). Change the Align Axis section to: X=0, Y=1, Z=0 and 
make sure the Active check box is selected. Ignore the Up 
Vector tab.

The camera should now roll correctly.

To import a boujou 4.1 scene into XSI 2.0 and above 
(dotXSI version 3.0):
1. Import the dotXSI file using File > Import > Import 

dotXSI.

Warning
XSI 2.0 and above defaults to a vertical field of view.

On some systems XSI gives you the error The file does not 
exist on import, or the .xsi file that you exported from 
boujou 4.1 does not appear in the file browser. To get around 
this problem drag and drop the file into the XSI workspace.

2. Make sure that the camera frame rate, rotoscope image 
sequence frame rate, and playback frame rate are all set to 
the appropriate value (XSI defaults to a NTSC camera with a 
frame rate of 29.97 fps).
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3. In the Camera Rotoscopy > Time Control > Source 
Clipping section make sure all of the frames of the image 
sequence are being used. XSI usually defaults to an out frame 
that is less than the last frame of the sequence. For a 25 frame 
sequence, starting at frame 1, the In value should be set to 
0 and the Out value should be set to 25.

The camera and camera interest are animated directly. The 
camera gets its pan and tilt rotations from the translation of the 
camera interest, and the camera roll is animated separately. All 
of the scene elements (camera, interest and reference points) are 
grouped under a parent null named TopNull.

XSI does not refer the camera roll values to the orientation of the 
parent null - instead it uses the global orientation. This means that 
if you try to apply a rotation to the entire hierarchy the camera 
roll values will stay constant relative to the global axis system and 
your 3D points will not be in the correct position relative to the 
background image.

To get around this problem you should use the Softimage 3.9.2 
export. Because of the incompatibilities between Softimage and 
XSI some manual set-up is required to make the reference points 
line up with the background image.

The Softimage 3.9.2 export uses an up-vector constraint to 
control camera roll, but XSI only supports up-vector constraints 
for IK chains. Without this constraint the camera does not roll and 
the nulls do not line up with the features in the background image.

To correct the camera roll in XSI 2.0 and above (dotXSI 
version 3.0):
1. Load the .xsi file from boujou 4.1 into XSI.

2. In a schematic view, select bou_cam.

3. In the menu bar, select constrain>direction.

4. When it prompts you for a target reference, click 
camera_1_up_vector in the schematic view.

5. A properties window is displayed for the new direction 
constraint (with the title scene_root:bou_cam: direction 
cns). Change the Align Axis section to: X=0, Y=1, Z=0 and 
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make sure the Active check box is selected. Ignore the Up 
Vector tab.

The camera should now roll correctly.

Exporting boujou 4.1 Data into Other Formats
boujou 4.1’s camera animation data and 2D track data can be 
exported in several other formats. Camera animation can be 
exported in the widely used FBX format, and can also be used to 
drive motion control rigs. The raw 2D tracks and the 3D 
predictions can be exported as 2D tracking data to compositing 
packages or as a simple text file:

• Exporting boujou 4.1 Camera-tracking Data in FBX Format

• Exporting boujou 4.1 Tracks in Shake Format on page 5-17

• Exporting boujou 4.1 Tracks in ASCII or boujou Animation File 
Format on page 5-20

• Exporting the Camera to Mark Roberts Motion Control Rig on 
page 5-20

• Exporting boujou 4.1 Tracks to Mistika DVE on page 5-21

Exporting boujou 4.1 Camera-tracking Data in FBX Format
boujou 4.1 can export its camera tracking data in the Autodesk 
FBX format. The FBX format can read by Maya, LightWave, 3DS 
Max, XSI and Cinema4D.

Warning
The FBX export is currently only available for Windows and Linux.

Exporting boujou 4.1 Tracks in Shake Format
boujou 4.1 can export its raw feature tracks and its 3D predictions 
as 2D tracks in a format that Shake can understand. Exporting 3D 
predictions as 2D tracks has the benefit of giving you tracks that 
last for the entire length of the sequence, even if the original 
feature is hidden behind another object or goes out of shot.
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You configure the way boujou exports its tracks to Shake in the 
Export Tracks to Shake dialog box, shown in Figure 5-3.

Figure 5-3: Export Tracks to Shake dialog box

To export boujou 4.1 tracks in the Shake format:
1. Open the Export Tracks to Shake dialog box in either of the 

following ways:

• Toolbox: Export to Shake shortcut button 

• Menu bar: Export > Export Tracks to Shake 

2. In the Filename field enter a name for the exported file.

3. In the Output Properties section edit the name of the node 
in the Node name field if required (default is 
boujou 4.1_Tracks).

4. Choose the type of node that you want to export from the 
Export type drop down list. You can export as a Tracker 
node, a MatchMove node, a Stabilize node, a Corner Pin 
node, or as raw data. If you choose MatchMove, Stabilize, 
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or Corner Pin, you need to select the required number of 
tracks to create these nodes.

If you choose raw data, the tracks are exported as a file per 
track with the X and Y values also in separate files. The files 
are named:

name_auto_###_x.txt

name_auto_###_y.txt

Each file contains a column of frame numbers and a column 
of X or Y values. 

5. In the Tracks section choose the sort of track that you want 
to export. Projected tracks are created after camera solving 
and exist on every frame of the sequence. Before camera 
solving you can only export tracks for visible features.

6. If your camera track has resulted in multiple camera 
solutions, you can choose which solution you want to export 
projected for by using the Camera Track drop down list.

7. The What to Export options allow you to either export all 
the tracks of the chosen type in the scene, just the tracks that 
you have flagged for export, or just the tracks from the 
current selection. Because boujou 4.1 can create thousands 
of feature tracks and 3D prediction points it is a good idea to 
only export the tracks that you really need using on the last 
two options. 

8. Checking the Clipped to Frame box cuts each track as it 
leaves the frame.

9. Output scale allows you to set the origin, change the units 
or scale the exported tracks. This is useful if, for example, you 
have tracked half-resolution images in boujou 4.1 and want 
to use them with the full-resolution image sequence. There 
are several presets available from the drop down list: 
Default, x2, x4, Half Size, Quarter Size, Top-Left, 
Bottom-Left, Normalized [0,1], or Center Origin [-1,1].

If you have chosen to export the tracks as raw data, they can be 
loaded into any Shake text field as a raw expression.
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To load boujou 4.1 tracks into Shake:
1. Right-click a Parameter (over the text box and not the 

parameter name).

2. Select Load Expression.

3. Set exprFormat to Raw.

4. Select the boujou 4.1 track file and select OK.

Exporting boujou 4.1 Tracks in ASCII or boujou Animation 
File Format

boujou 4.1 can also export its tracking data as an ASCII text file 
(*.txt) and a boujou animation file (*.ban). These formats contain 
the camera motion and the 3D scene points. The *.txt file uses a 
camera rotation matrix and the *.ban file uses a camera projection 
matrix. There are a number of options that can be set for these 
exports under Edit > Preferences > Camera Export (for 
details, see Appendix B boujou 4.1 Preferences).

Important
boujou 4.1’s *.txt and *.ban formats use a Y-up, right-handed coordinate 
system

Please refer to the comments within the files themselves for 
further information, or contact 2d3 directly at 
2d3support@2d3.com.

The *.txt format can be used for exporting to Cinema 4D and the 
*.ban format can be used for exporting to After Effects.

Exporting the Camera to Mark Roberts Motion Control Rig
boujou 4.1 creates a Flair file (*.mrmc) that can be used to drive 
Mark Roberts motion control rigs. Use the Z-up, X-forward user 
preference when exporting Flair files.

Important
The Flair format uses a Z-up, right-handed coordinate system.

Warning
The data exported to the Flair format by boujou 4.1 has not been validated 
in any way. It is the user’s responsibility to satisfy themselves that it is 
safe to use this data to drive a motion control rig.
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Exporting boujou 4.1 Tracks to Mistika DVE
boujou 4.1 can export its camera tracking data to SGO’s Mistika 
compositing system using the *.fx format. Only the Moving 
camera, static scene Move Type is supported.
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AAbou jou 4.1  Keyboard
Shortcuts

The following sections in this appendix describe the keyboard 
keys, keyboard shortcuts, and keyboard and mouse combinations 
you use to perform the specified action within the given functional 
area of boujou 4.1:

• 2D Tasks Keyboard Shortcuts on page A-2

• 3D Tasks Keyboard Shortcuts on page A-3

• Edit Keyboard Shortcuts on page A-3

• Export Keyboard Shortcuts on page A-4

• File Keyboard Shortcuts on page A-4

• Image Window Keyboard Shortcuts on page A-5

• Play Controls Keyboard Shortcuts on page A-7

• Scripts Keyboard Shortcuts on page A-8

• Setup Keyboard Shortcuts on page A-8

To use a keyboard shortcut, hold down the first key and then press 
the second and any subsequent keys. To use a keyboard and 
mouse combination, hold down the key while performing the 
mouse action, then release the key and the mouse button.

Tip
Middle wheel button on mouse: Where this appendix lists a keyboard 
shortcut using MIDDLE , you can use the middle wheel button if your 
mouse has this button and you have set the Middle mouse button for 
navigation option in the Preferences dialog box (for details, see 
Appendix B boujou 4.1 Preferences). If your mouse does not have this 
button or you choose not to set the option, hold down both the left and 
right mouse buttons. 
Apple users: Where this appendix lists a keyboard shortcut using a 
function key (F1–F12), if you are using an Apple Mac keyboard, hold down 
the Command (or Apple) key  and then press the specified function key. 
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2D Tasks Keyboard Shortcuts
Table A-1 describes the keyboard keys, keyboard shortcuts, and 
keyboard and mouse combinations you use to perform tasks with 
2D data in boujou 4.1.

Table A-1: Keyboard shortcuts—2D Tasks

Shortcut Function Notes

F8 Track Features and Solve 
Camera

See Apple users’ 
Tip on page A-1.

F9 Track Features See Apple users’ 
Tip on page A-1.

CTRL + A Target Tracks dialog box
CTRL + D Edit Named Tracks
CTRL + H Import Image-Based Mask
CTRL + J Join Tracks
CTRL + L Edit Locators
CTRL + M Edit Polygon-based Masks
CTRL +RETURN Show Properties Dialog 

Box for Selected Artifact

CTRL + LEFT Move mask pivot When in Edit Mask 
mode

CTRL + SHIFT + LEFT Add point to mask

CTRL + SHIFT + LEFT Reset mask pivot When in Edit Mask 
mode
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3D Tasks Keyboard Shortcuts
Table A-2 describes the keyboard key and keyboard shortcuts you 
use to perform tasks with 3D data in boujou 4.1.

Edit Keyboard Shortcuts
Table A-3 describes the keyboard key and keyboard shortcuts you 
use to edit data in boujou 4.1.

Table A-2: Keyboard shortcuts—3D Tasks

Shortcut Function Notes

F10 Solve Camera See Apple users’ 
Tip on page A-1.

CTRL + G Add/Edit Scene Geometry
CTRL + T Add/Edit Test Objects
CTRL + SHIFT + M Move to Point Select test object 

and point first.
CTRL + SHIFT + O Orient to Plane Select test object 

and points first.
CTRL + SHIFT + R Rotate Manipulator Toggle on/off
CTRL + SHIFT + S Scale Manipulator Toggle on/off
CTRL + SHIFT + T Translate Manipulator Toggle on/off

Table A-3: Keyboard shortcuts—Edit

Shortcut Function Notes

CTRL + C Edit Copy
CTRL + V Edit Paste
CTRL + X Edit Cut Exit
CTRL + Y Redo
CTRL + Z Undo
DELETE Delete
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Export Keyboard Shortcuts
Table A-4 describes the keyboard keys you use to export data 
from boujou 4.1.

File Keyboard Shortcuts
Table A-5 describes the keyboard shortcuts you use to manage 
image and project files in boujou 4.1.

Table A-4: Keyboard shortcuts—Export

Shortcut Function Notes

F11 Export Image Sequence See Apple users’ 
Tip on page A-1.

F12 Export Camera Solve See Apple users’ 
Tip on page A-1.

Table A-5: Keyboard shortcuts—File

Shortcut Function Notes

CTRL + N File New
CTRL + O File Open
CTRL + S File Save
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Image Window Keyboard Shortcuts
Table A-6 describes the keyboard keys, keyboard shortcuts, and 
keyboard and mouse combinations you use to manipulate data in 
the boujou 4.1 Image window.

Table A-6: Keyboard shortcuts—Image window

Shortcut Function Notes

F Center View on Selection
F3 Toggle 3D Mode See Apple users’ 

Tip on page A-1
F5 Default View See Apple users’ 

Tip on page A-1
DOWN ARROW Zoom Out
UP ARROW Zoom In
CTRL + 0 Toggle Ground Plane 

Overlay
CTRL + 1 Toggle Image Overlay
CTRL + 2 Toggle Mask Overlay 2D view only
CTRL + 3 Toggle Radial Overlay 2D view only
CTRL + 4 Toggle Tracks Overlay 2D view only
CTRL + 5 Toggle Predictions 

Overlay
CTRL + 6 Toggle Errors Overlay 2D view only
CTRL + 7 Toggle Locators Overlay
CTRL + 8 Toggle Target Tracks 

Overlay
CTRL + 9 Toggle Test Objects 

Overlay

CTRL + SHIFT + LEFT  
or 
SHIFT +  + LEFT  

Roll View 3D mode view
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SHIFT + LEFT Shuttle View

Rotate View

2D mode view

3D mode view

SHIFT + MIDDLE Translate View

Translate View

2D mode view

3D mode view

See Middle mouse 
button Tip on 
page A-1.

SHIFT + MIDDLE Translate view

Translate view

2D mode view

3D mode view

See Middle mouse 
button Tip on 
page A-1.

SHIFT + RIGHT Zoom View

Dolly View

2D mode view

3D mode view

Table A-6: Keyboard shortcuts—Image window

Shortcut Function Notes
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Play Controls Keyboard Shortcuts
Table A-7 describes the keyboard keys and keyboard shortcuts 
you use to play back data in boujou 4.1.

Table A-7: Keyboard shortcuts—Play Controls

Shortcut Function Notes

F1 Help
F6 Lock Play to Single Selected 

Point
See Apple users 
Tip on page A-1.

END Go to End
HOME Go to Start
LEFT ARROW Step backward
RIGHT ARROW Step forward
ALT + LEFT ARROW Play backward
ALT + RIGHT ARROW Play forward
CTRL + LEFT ARROW Previous Solved Frame
CTRL + RIGHT ARROW Next Solved Frame
SHIFT + LEFT ARROW Previous Key
SHIFT + RIGHT ARROW Next Key
PAGE DOWN Jump backward (10 frames)
PAGE UP Jump forward (10 frames)
SPACE BAR Toggle Play
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Scripts Keyboard Shortcuts
Table A-8 describes the keyboard shortcuts you use to work with 
embedded scripting in boujou 4.1. The META key is defined in the 
embedded script. For details, see Chapter 4 Advanced Functions.

Setup Keyboard Shortcuts
Table A-9 describes the keyboard shortcuts you use to set up 
cameras in boujou 4.1.

Table A-8: Keyboard shortcuts—Scripts

Shortcut Function Notes

META + A Toggle Lasso Mode
META + E Export meshes to Maya
META + Q Previous Keyframe
META + T Toggle Edit Track Mode
META + W Next Keyframe

Table A-9: Keyboard shortcuts—Setup

Shortcut Function Notes

CTRL + I Import Image Sequence
CTRL + E Edit Camera
CTRL + F Edit Focal Constraints
CTRL + R Edit Calibration Lines
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BBboujou 4.1  Pre ferences

This appendix lists and describes the interface and tool settings 
you can customize in the Preferences dialog box. For details on 
setting user preferences, see Chapter 4 Advanced Functions.

The following sections describe the settings you can configure in 
the specified section of the Preferences dialog box:

• 2D Display Preferences on page B-2

• 3D Display Preferences on page B-4

• Camera Export Preferences on page B-6

• Dialog Preferences on page B-8

• Directories Preferences on page B-9

• Display Preferences on page B-10

• Graph Display Preferences on page B-11

• Image Formats Preferences on page B-11

• Import Preferences on page B-12

• Miscellaneous Preferences on page B-12

• Target Tracking Preferences on page B-14

• Tracking Preferences on page B-15
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2D Display Preferences
Table B-1 describes the preferences you can set to control the 
appearance of the 2D Mode view in the Image window.

Table B-1: 2D Display Preferences

Preference Function

Background Color Sets the background color.

Default: charcoal gray

Calibration Line Color Sets the color of the calibration lines.

Default: cyan

Circle tessellation for 
predictions

Sets the number of sides for the 2D polygon 
shape when the Predictions as circles option 
is set to Yes.

Default: 5

Default Image 
Viewsize

Fit to Window
Scales the image viewsize to fit the workspace 
window.

Actual Size
Displays the images at actual size, regardless 
of the size of the workspace window.

Error Color Sets the color of the error vectors.

Default: magenta

Feature Color Sets the feature color.

Default: red

Grid Major Color Sets the color for major grid divisions.

Default: white

Grid Minor Color Sets the color for minor group divisions.

Default: gray

Inlying Feature Color Sets the color of the inlying features.

Default: red

Inlying Track Color Sets the color of the inlying tracks.

Default: cyan

Locator Feature 
Color

Sets the color for locator/feature cross display.

Default: cyan
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Locator Feature 
Connected Color 

Sets the color for locators which have been 
connected to survey points.

Default: orange

Locator Feature 
Connected Selected 
Color

Sets the color for selected locators when 
connected to survey points.

Default: green

Locator Feature 
Selected Color

Sets the color for selected locator cross display.

Default: green

Mask Color Sets the fill color of polygon and image-based 
masks.

Default: green

Mask Opacity Sets the opacity of the mask

Default: 50%

Polygon Color Sets the color of the polygon mask outline.

Default: light yellow

Prediction OFF Color Sets the color of the non-live predictions.

Default: cyan

Prediction ON Color Sets the color of the live predictions.

Default: yellow

Prediction Size Sets the size of the prediction dot.

Default: 5.0 units

Predictions as circles Whether or not to draw predictions as 2D 
polygon shapes

Default: No

Track Anti-aliasing Whether or not to have tracks displayed with 
anti-aliasing for a smoother appearance. This 
can help in determining the steadiness of a 
given track.

Default: Yes

Track Color Sets the color of the feature tracks.

Default: yellow

Table B-1: 2D Display Preferences

Preference Function
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3D Display Preferences
Table B-2 describes the preferences you can set to control the 
appearance of the 3D Mode view in the Image window.

Table B-2: 3D Display Preferences

Preference Function

Active camera color Sets the color of the camera frustum on the 
current frame.

Default: yellow

Background Color Sets the background color.

Default: charcoal gray

Camera color Sets the color of the camera position and path 
display.

Default: red

Grid Extent The size of the grid displayed in the 3D view 
and the ground plane in the 2D view. Defined 
as the number of divisions in one quarter of the 
grid when Grid Subdivision Size is set to 1.

Grid Major Color Sets the color for major grid divisions.

Default: white

Grid Minor Color Sets the color for minor group divisions.

Default: gray

Grid Subdivision Size The size of each subdivision of the grid 
displayed in the 3D view and the ground plane 
in the 2D view. 

Prediction OFF Color Sets the color of the predictions which fall 
outside the camera frustum on the current 
frame.

Default: cyan

Prediction ON Color Sets the color of the predictions which fall 
inside the camera frustum on the current 
frame.

Default: yellow

Prediction Size Sets the size of the prediction dot.

Default: 5.0 units
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Predictions as 
spheres

Draws the predictions as 3D polygonal spheres.

Default: No

Preferred Camera 
Orientation

Y-Up Z-back
Camera orientation for Y-up coordinate 
systems, e.g. Maya, LightWave, XSI.

Z-up Y-forward
Camera orientation for Z-up coordinate 
systems, e.g. 3D Studio Max. 

Z-up X-forward
Camera orientation for Mark Roberts Motion 
Control Rig. 

Default: Y-Up Z-back

Show color axes Display the coordinate system axes on the floor 
grid (X red, Y green, Z blue).

Default: No

Sphere tessellation 
for predictions

Sets the polygon tessellation when the 
Predictions as Spheres option is used.

Default: 5

Wireframe Color Sets the unselected color of the test object 
when the Draw Style is set to Wireframe.

Default: gray

Table B-2: 3D Display Preferences

Preference Function
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Camera Export Preferences
Table B-3 describes the preferences you can set to control the 
export of camera data from boujou 4.1 for use in third-party 
animation packages.

Table B-3: Camera Export Preferences

Preference Function

3DS Max Sets options for exporting cameras to 3D 
Studio Max:

Export points as spheres
Predictions are created as spheres in 3D Studio 
Max.

Default: No

boujou 4.1 
Animation

Camera format
Writes the camera animation in the *.ban file 
in one of three formats:

• 3x4 Projection Matrices
• Calibration, Rotation, Translation 
• Both Formats for Each Key
Default: 3x4 Projection Matrices 

Cineon Sets options for exporting cameras to Cineon:

Three planes per point
Displays points as three perpendicular patches.

Default: No

General Default Start Frame Index:

• Use sequence 'number from' value
boujou 4.1 uses the Number From value in 
the Import Sequence dialog box as the first 
frame index number. This is the default. 

Sets general options for exporting cameras:

Default Format
Sets the default format when exporting to a 3D 
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General (cont.) animation package.

Default: boujou 4.1 Animation

Default Scale
Sets the default scene scale when exporting to 
a 3D animation package. 

Default: 1.0

• Use first frame number of image 
sequence
boujou 4.1 uses the frame number of the 
first frame of the image sequence as the first 
frame index number.

• Use default for export format
This is always zero (unless a built-in value).

Show Camera Export Reminders
Displays reminders relating to the export 
format that you have selected, such as setting

the correct timeline frame rate or aperture 
width.

Default: Yes

Houdini Sets options for exporting cameras to Houdini:

Compound Points
Creates the 3D scene points as individual nulls 
or as a single object in Houdini. 

Default: Yes

Lightwave Sets options for exporting cameras to 
Lightwave:

Export points as spheres
Creates predictions as spheres in Lightwave.

Default: No

Maya Sets options for exporting cameras to Maya:

Units of Length
Choose the preferred measurement units from 
mm, cm, m, ins, yds.

Table B-3: Camera Export Preferences

Preference Function
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Dialog Preferences
Table B-4 describes the preferences you can set to control how 
some boujou 4.1 information and warning messages are 
displayed.

Text Sets options for exporting cameras to txt:

Camera Rotation Format
Sets the format of the camera rotations in the 
*.txt export:

• 3x3 rotation matrix 
• Static Axis Euler Angles
• Moving Axis Euler Angles
Default: 3x3 rotation matrix 

Table B-3: Camera Export Preferences

Preference Function

Table B-4: Dialog Preferences

Preference Function

Show Radial Change 
Warning

Whether or not to display the warning message 
alerting users that changing radial distortion 
values after solving or initializing cameras will 
affect existing solves.

Default: Yes

Show Re-feature 
Track Warning

Whether or not to display the warning message 
alerting users that feature tracking more than 
once with an existing solve will remove 
predictions associated with deleted tracks. For 
details, see Tracking Features section in 
Chapter 3 Basic Functions.

Default: Yes
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Directories Preferences
Table B-5 describes the preferences you can set to control where 
boujou 4.1 stores data on your computer.

Table B-5: Directories Preferences

Preference Function

Auto-save Files Sets the default directory for saving autosaved 
projects. 

Default: A temporary directory for the 
operating system:
• Windows: C:\Documents and Settings\ 

<Username>\Local Settings\Temp
• OS X: /private/tmp
• Linux: /tmp

Equivalent 
Directories 1, 2, 3

Enables you to set up groups of directory paths. 
If boujou 4.1 cannot find the files that it is 
looking for in the original directory path, it 
searches through all of the directory paths in 
the Equivalent Directories group. You can set 
up three groups of Equivalent Directories and 
there is no limit to the number of directory 
paths that you can include in each group. 
Spaces are used as delimiters and the directory 
paths are case sensitive.

Help Directory Sets the default directory for the boujou 4.1 
help files.

Default: The documentation installation 
directory for the operating system:
• Windows: <installation_directory>/docs/

pdf
• OS X: /Library/Documentation
• Linux: <installation_directory>/doc/pdf

Images Sets the default directory for loading and 
saving images.

Default: The last used directory

Masks Sets the default directory for loading image-
based masks.

Default: The last used directory
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Display Preferences
Table B-6 describes the preferences you can set to control the 
appearance of the 3D object models and survey points in the 
Image window.

Project Files Sets the default directory for loading and 
saving project files.

Default: The last used directory

Scripts Directory Sets the default directory in which boujou 4.1 
looks for lua scripts.

Default: ./scripts

Table B-5: Directories Preferences

Preference Function

Table B-6: Display Preferences

Preference Function

Model Vertex Size Adjusts the display size for vertices of imported 
models

Default: 0.5.

Model Wireframe 
Selected Color

Sets the color for the wireframe display of 
imported models when selected.

Default: green

Survey Point Color Sets the color of survey points (model 
vertices).

Default: yellow

Survey Point 
Connected Color

Sets the color of survey points (model vertices) 
when connected to locators/target tracks

Default: orange

Survey Point 
Connected Selected 
Color

Sets the color of selected survey points (model 
vertices) when connected to locators/target 
tracks.

Default: orange
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Graph Display Preferences
Table B-7 describes the preferences you can set to control the 
appearance of the Graph Mode view in the Image window.

Image Formats Preferences
Table B-8 describes the preferences you can set to control how 16-
bit images are converted by boujou 4.1 on import. 

Important
These settings can affect feature tracking.

Survey Point 
Selected Color

Sets the color of selected survey points (model 
vertices).

Default: green

Table B-6: Display Preferences

Preference Function

Table B-7: Graph Display Preferences

Preference Function

Background Color Sets the background color for the graph 
display.

Default: charcoal gray

Table B-8: Image Formats Preferences

Preference Function

Cineon Parameters Sets options for Cineon and DPX formats:

• Density delta - Default 0.002
• Density delta (16 bits) - Default 0.00003
• Film gamma - Default 0.6
• Mid-gray code - Default 445
• Mid-gray code (16bits) - Default 28480
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Import Preferences
Table B-9 describes the preferences you can set to control the way 
third-party image data is imported into boujou 4.1.

Miscellaneous Preferences
Table B-10 describes the preferences you can set to control the 
general appearance and operation of the boujou 4.1 user 
interface.

Table B-9: Import Preferences

Preference Function

Detect alpha channel 
to use as mask

Enables or disables alpha channel detection in 
imported image sequences. 

Default: Yes

Image Preview Enables or disables the image preview in the 
Import Sequence dialog box (you may want 
to disable the preview if you are loading large 
images over a network). 

Default: Yes

Preset Camera File 
Location

Sets the default directory for the 
preset_cameras.bpc file. If no location is 
specified, boujou 4.1 uses its internal presets 
(default).

Table B-10: Miscellaneous Preferences

Preference Function

Auto save period 
(minutes)

Specifies the number of minutes before the 
project is automatically saved. Setting this to a 
value of 0 (zero) turns the auto save feature 
off.

Default: 215
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boujou GUI style Specifies the look and feel of the boujou 4.1 
user interface (UI):

• None: Plain gray UI scheme.
• boujou3: Dark gray UI scheme used in 

boujou 3.
• boujou4: Charcoal gray UI scheme used in 

boujou 4.
• bulletSD: UI scheme used in boujou 

bullet SD.
• SilverBullet: UI scheme used in boujou 

silver bullet
• Nexus: UI scheme used in Vicon Nexus.
Default: boujou4

Console Prompt Specifies the font for the text in the Console 
pane prompt using basic HTML tagging.

Default: <B><font color=white>2d</
font><font color=#DD0000>3</font></B> 
<font color=white>$</font> <font 
color=white></font> 

that is, 

Font size Sets the default font size for text that appears 
on the screen. 

Default: 9 point

Help Reader Sets the location of the preferred PDF reader 
for viewing the documentation PDF files. If 
nothing is specified, the default PDF reader is 
used.

Middle mouse button 
for navigation

Enables you to use the middle mouse button for 
some of the workspace navigation controls. 

Default: No

MRU Items Sets the number of most recently used items 
shown in File > Open. 

Default: 4

Table B-10: Miscellaneous Preferences

Preference Function
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Target Tracking Preferences
Table B-11 describes the preferences you can set to control the 
target tracking process.

Script separate 
history items

Creates a separate entry in the history list for 
each command within an embedded lua script. 

Default: No

Total physical 
memory (MB)

Specifies the amount of RAM available on your 
computer if it is not correctly determined by 
boujou 4.1 (sometimes a problem on Macs with 
2GB or more).

Default: 0 (boujou 4.1 uses the value that it 
has found from the operating system)

Use Hardware 
OpenGL

Controls whether the hardware OpenGL is 
used. If you have a graphics card that supports 
OpenGL, you can set this option to make the 
boujou 4.1 interface more responsive. 

Default: Yes. You need to close boujou 4.1 and 
restart it for the hardware OpenGL to be used.

Use Version 1.0 bpj 
File Format

Save projects using the old .bpj format. 

Default: Yes

Table B-10: Miscellaneous Preferences

Preference Function

Table B-11: Target Tracking Preferences

Preference Function

Auto clear Sets whether adding a keyframe to a tracked 
range deletes the tracking for that range. If you 
want to keep the tracking, set this option to No. 

Default: Yes

Comparison region 
size

Sets the size of the comparison region used for 
target tracking. 

Default: 11
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Tracking Preferences
Table B-12 describes the preferences you can set to control the 
camera solve and feature tracking processes.

Good track threshold Sets the tracking score above which a tracked 
frame is considered good. 

Default: 0.9

OK track threshold Sets the tracking score above which a tracked 
frame is considered OK. 

Default: 0.7

Search window size Sets the size of the search window used for 
target tracking. 

Default: 21

Table B-11: Target Tracking Preferences

Preference Function

Table B-12: Tracking Preferences

Preference Function

Auto-save project 
after camera solve

Enables or disables the autosave after camera 
solving. 

Default: Yes

Auto-save project 
after feature tracking

Enables or disables the autosave after feature 
tracking. 

Default: Yes

Auto-track camera 
after feature tracking

Enables or disables auto-track camera after 
feature tracking. 

Default: No

Clear Cache before 
camera solve

Clears the cache before camera solving. 

Default: Yes

Clear Cache before 
feature tracking

Clears the cache before feature tracking. 

Default: Yes
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Feature tracking 
default parameters

Sets the defaults for the feature tracking 
parameters found in the Advanced 
Properties section of the Feature Tracking 
dialog box:

• Large feature scale
Sets the feature scale parameter to large 
features.
Default: No

• Maximum search distance (%)
Sets the size of the maximum tracking 
search distance as a percentage. 
Default: 20

• Minimum search distance (%)
Sets the size of the minimum tracking 
search distance as a percentage. 
Default: 1

• Sensitivity
Sets the default tracking sensitivity level. 
Default: 3

• Use blue channel
Enables or disables the use of the image 
sequence blue channel for feature tracking. 
Default: Yes

• Use fast tracker
Enables or disables the Fast Tracking 
feature. 
Default: No

• Use green channel
Enables or disables the use of the image 
sequence green channel for feature 
tracking. 
Default: Yes

• Use red channel
Enables or disables the use of the image 
sequence red channel for feature tracking. 
Default: Yes

Table B-12: Tracking Preferences

Preference Function
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CCLens  Squeeze Rat io

boujou 4.1 automatically creates a camera with the appropriate 
settings when you import an image sequence. You configure the 
way boujou 4.1 does this by specifying the camera type that was 
used to capture your footage in the Cameras dialog box (for 
details see Chapter 3 Basic Functions).

boujou 4.1 usually handles anamorphic footage by reducing the 
film back height to compensate for the increased pixel aspect 
ratio. This is adequate in a majority of cases, especially for DV 
cameras that achieve widescreen aspect ratio by masking the top 
and bottom of the CCD array. However, the incorrect vertical field 
of view can sometimes make CG objects look wrong when using 
film resolution footage. You can corrects for this by setting an 
appropriate value in the Lens Squeeze Ratio option in the 
Cameras dialog box. This option separates the anamorphic 
squeeze from the pixel aspect ratio, allowing you to keep the 
correct vertical field of view in your effects shot. 

Caution
Not all 3D animation packages support lens squeeze. Please check before 
you decide to use the lens squeeze ratio.

The following examples show how you determine the appropriate 
value to set in the Lens Squeeze Ratio option in the Cameras 
dialog box to correct for an anamorphic shot:

• Lens Squeeze Ratio Example 1 on page C-2

• Lens Squeeze Ratio Example 2 on page C-3
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Lens Squeeze Ratio Example 1
If you import a 2048x1556 image sequence, boujou 4.1 suggests 
a 35mm Full Aperture camera type. The settings for this type 
are:

Film Back Width = 0.98"; Film Back Height = 0.7446"
Pixel Aspect Ratio = 1; Lens Squeeze = 1.0

However, if this were an anamorphic shot with a lens squeeze 
of 2, we would change the pixel aspect ratio to 2. This results in 
film back values of:

Film Back Width = 0.98"; Film Back Height = 0.3722"

The height value has been reduced to give the required pixel 
aspect ratio value (filmback and pixel aspect ratio are linked in the 
Cameras dialog), and that’s not what happens in real life. If the 
Lens Squeeze Ratio is set to 2 and the pixel aspect ratio to 2, 
the filmback values stay unchanged (0.98" x 0.7446"). This 
represents the effect of attaching an anamorphic lens onto a 
normal 35mm camera—the size of the gate doesn't change, just 
the lens.

As far as boujou 4.1 is concerned, it is the value of pixel aspect 
ratio that is important for an accurate solve. The lens squeeze 
value makes sure that the filmback size stays how it should.

Once you’ve decided what the values of film back, lens squeeze, 
and pixel aspect ratio should be, you can add a line to your 
preset_cameras.bpc file (for details on specifying the location for 
this image formats file, see Table B-8 on page B-11). For 
example:

NewPresetCamera { Name “35mm Full Aperture Anamorphic 
(2048)” Width 2048 Height 1556 FilmWidthMM 24.892 
FilmHeightMM 18.9121 LensSqueeze 2 PixelAspect 2 
FocalMM 50 LensDistortion 0 Principal_X 50 
Principal_Y 50 TypeFocal Constant }



Lens Squeeze Ratio

boujou 4.1 Reference Guide C-3

Lens Squeeze Ratio Example 2
If you import a 720x576 image sequence, boujou 4.1 suggests a 
D1 PAL camera type. The setting for D1 PAL (4:3 image aspect 
ratio) are:

Film Back Width = 20.12mm; Film Back Height = 15.09mm
Pixel Aspect Ratio = 1.0667; ; Lens Squeeze = 1.0

However, 720x576 images could also be PAL Widescreen 
(16:9 image aspect ratio). If you select this preset, you get the 
following settings:

Film Back Width = 20.12mm; Film Back Height = 11.318mm
Pixel Aspect Ratio = 1.4222; Lens Squeeze = 1.0

If your camera masks the top and bottom of the sensor to get a 
16:9 aspect ratio, these settings will be correct. However, if an 
additional lens has been added in order to provide a horizontal 
squeeze, the vertical field of view will be wrong. If this is the case, 
you will need to use the following settings:

Film Back Width = 20.12mm; Film Back Height = 11.318mm
Pixel Aspect Ratio = 1.4222; Lens Squeeze = 1.3333
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DDboujou_scr ipt  F i le  Commands

This appendix illustrated how to write a boujou_script file and lists 
and describes the available boujou_script commands. For details 
on writing and running boujou_script files, see 
Chapter 4 Advanced Functions.

Example boujou_script File
#
# boujou script file for loading image sequences, feature 
tracking and camera solving
#
BoujouScriptFile    { }
SetLog              { File "F:\2d3\Training\boujou_script\log.htm" }
AddCamera           { PreSet "D1 NTSC" Name camera-0 }
AddImset            { Name imset-0
                      Camera camera-0
                      File 
"F:\2d3\Training\boujou_script\fish_interlaced\fish_interlaced
.###.sgi"
                      Start  001
                      Step   001
                      End    030
                      FrameRate  29.97
                      Offset 001
                      Interlace InterlaceFieldsEvenFirst }
Save                { File 
"F:\2d3\Training\boujou_script\fish_interlaced-0.bpj" }
Ftrack              { }
Save                { File 
"F:\2d3\Training\boujou_script\fish_interlaced-f.bpj" }
Ctrack              { }
Save                { File 
"F:\2d3\Training\boujou_script\fish_interlaced-c.bpj" }
SetExportOptions    { FlaggedOnly       False
                      NullSize          2
                      FirstFrame        001
                      LastFrame         030
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                      FrameStep         001
                      FirstFrameIndex   1
                      ExportScale       5
                      Type              Moving
                      UseFormatDefault  False  }
ExportCameraTrack   { Format "Maya 4"
                      File 
"F:\2d3\Training\boujou_script\fish_interlaced.ma" }
#
# start a new job
#
Clear               { }
#
AddCamera           { PreSet "PAL" Name camera-0 }
EditCamera          { Name camera-0  TypeFocal Variable }
AddImset            { Name imset-0
                      Camera camera-0
                      File 
"F:\2d3\Training\boujou_script\manor_pan_zoom\manor_pan_zoom.#
##.tif"
                      Move MoveNodal
                      Start  000
                      Step   001
                      End    050
                      FrameRate 25
                      Interlace InterlaceNone }
Save                { File 
"F:\2d3\Training\boujou_script\manor_pan_zoom-0.bpj" }
Ftrack              { }
Save                { File 
"F:\2d3\Training\boujou_script\manor_pan_zoom-f.bpj" }
Ctrack              { }
Save                { File 
"F:\2d3\Training\boujou_script\manor_pan_zoom-c.bpj" }
ExportCameraTrack   { Format "Flame (v7.0)"   File    
"F:\2d3\Training\boujou_script\manor_pan_zoom.action"  }
#
Clear               { }
#
# load a pre-saved project, track it and export the results to 
3DS Max
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#
Load                { File "F:\2d3\Training\boujou_script\market.bpj" 
}
Ftrack              { }
Save                { File "F:\2d3\Training\boujou_script\market-
f.bpj" }
Ctrack              { }
Save                { File "F:\2d3\Training\boujou_script\market-
c.bpj" }
ExportCameraTrack   { Format "3D Studio Max"   File  
"F:\2d3\Training\boujou_script\market.ms" }
#
# preferences
#
ExportPreferences { File 
"F:\2d3\Training\boujou_script\prefs.bpf" }
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boujou_script Commands
Table D-1 lists and describes the commands you can specify in a boujou_script command line. 

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values

AddCamera { }

Add a camera to the 
project

Name Yes Name of camera 
(camera-0 for default)

Preset Set Camera values from 
the preset values

see elsewhere

Type If no preset The camera type see elsewhere

Width If no preset Width of image in pixels, 
must agree with images

Height If no preset Height of image in 
pixels, must agree with 
images

FilmWidthMM If no preset Width of film back in mm

FilmHeightMM If no preset Height of film back in 
mm

PixelAspect If no preset Pixel aspect Ratio

FocalMM If no preset Focal length in MM

TypeFocal Constant

LensDistortion 0 Lens Distortion
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Principal_X 50 X coordinate of principal 
point

Principal_Y 50 Y coordinate of principal 
point

AddFocalLength{}

Add focal length data to 
the sequence

Name Yes Name of the focal length 
artifact

Keyframes Yes List of focal length 
keyframes

0 - nframes

KeyframeTypes Yes Type of focal length in 
each of the keyframes

APPROXIMATE

EXACT

KeyframeValues Yes Value of focal length in 
each keyframe in mm.

Ranges Yes Data type of the focal 
length in each range

CONSTANT

VARIABLE

AddImset { }

Add an image sequence 
to the project 

Name Yes Set name of image 
sequence

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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Camera Yes The name of the camera 
associated with 
sequence

File Yes Path and name of 
sequence files

Start From File Start frame deduced 
from file if not supplied

Step 1 Frame Step

End From File End frame deduced from 
file if not supplied

Interlace Interlace options InterlaceNone

InterlaceInterpolate
Replace Odd

InterlaceInterpolate
Replace Even

InterlaceFieldsOdd 
First

InterlaceFieldsEven
First

Move MoveFree Free move or Nodal Pan MoveFree 

MoveNodal

FrameRate 25

Offset 0

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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AddMatte { }

Apply an image mask to 
the image sequence

Name Yes Name of mask

MaskType Yes Type of mask Include White

Include Black

Exclude White

Exclude Black

File Yes Path and name of 
sequence files

Start From File Start frame, deduced 
from file if not supplied

Step 1 Frame step

End From File End frame, deduced 
from file if not supplied

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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Interlace Interlace options InterlaceNone

InterlaceInterpolate
Replace Odd

InterlaceInterpolate
Replace Even

InterlaceFieldsOdd 
First 

InterlaceFieldsEven
First

BoujouScriptFile{ }

Yes File must begin with this 
command

Clear {}

Clear the project space 
in order to start a new 
job

Ctrack {}

Solve camera

Camera 
TrackingMode

Complete Camera solving mode Complete

Reuse

Adjust

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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AdjustLevel Adjust-only camera 
solving

Typical

Thorough

Exhaustive

EditCamera { }

TypeFocal Set focal length to a type 
other than constant

Variable

UserFixed

ExportCameraTrack {}

Export a camera file

File Enter path and file name 
of exported file

Format Enter name of format 
type

See elsewhere

ExportFeatureTracks {}

Export 2d tracks to file

File Path and file name for 
exported file

OriginBottomLeft TRUE Origin position TRUE/FALSE

SeparateXYFiles FALSE Write X and Y ordinates 
in separate files

TRUE/FALSE

SeparateTrackFiles FALSE Write one file per track TRUE/FALSE

ClipToFrame FALSE Ignore tracks once they 
have left the current 
frame

TRUE/FALSE

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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FlaggedOnly FALSE Export flagged tracks 
only

TRUE/FALSE

IncludeFeatures TRUE Include feature tracks TRUE/FALSE

IncludeLocatorInput FALSE Include locators on their 
keyframes only

TRUE/FALSE

IncludeLocatorPredic
tions

FALSE Include solved locators TRUE/FALSE

IncludeTargetTracks FALSE Include target tracks on 
keyframes only

TRUE/FALSE

IncludeTTPredictions FALSE Include solved target 
tracks

TRUE/FALSE

IncludePredictions FALSE Include 3D predictions 
as 2D tracks

TRUE/FALSE

ExportPreferences {}

Export the user 
preferences to a file

Enter path and file name 
of .bpf to be saved

Ftrack {}

File Track features (or load 
from file). Enter path 
and file name of 2d track 
file to be loaded

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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Deflicker FALSE Compensate for lighting 
variations during 
tracking

TRUE/FALSE

Rolling FALSE Use this tracker if the 
camera rolls about its Z-
axis

TRUE/FALSE

SearchWindow 0.06 Value of search window

Method Standard Type of feature tracking Standard

Thorough

ImportPreferences {}

Import the user 
preferences from a file

File path Enter path and file name 
of .bpf file to be loaded

Load {}

Load a project file

File Enter path and file name 
of project file to be 
loaded

RedistortedMovie {} 

Input Yes Enter the path and file 
name of the image 
sequence to re 
redistorted

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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Output Yes Enter the path and file 
name of the image 
sequence to which the 
redistorted sequence 
will be saved

Interlace InterlaceNo
ne

Specify the interlacing 
setting for the input 
sequence

InterlaceNone

InterlaceInterpolate
Replace Odd

InterlaceInterpolate
Replace Even

InterlaceFieldsOdd 
First 

InterlaceFieldsEven
First

Start 1 First frame of the input 
sequence to redistort 
and export

Step 1 Frame step for the input 
sequence

End Same as 
input 
sequence

Last frame of the input 
sequence to redistort 
and export

NumberStart 1 Number to assign to the 
first frame of the 
exported sequence

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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NumberStep 1 Frame step for the 
output sequence 
numbering

MovieType Same as 
input 
sequence

Format of export 
sequence

AVI, MOV, JPEG, 
TIFF, PNG, PNM, 
SGI, SOFTIMAGE, 
CINEON, DPX, 
DPX16, TARGA, 
NULL

Save {}

Save a project file

File Path and file name for 
saved project file

SaveMovie {} 

File Enter path and file name 
of image sequence to 
export. Image format 
deduced from file 
extension. 

Distortion Add or remove lens 
distortion

Add

Remove

NumberStart Start frame

NumberStop End frame

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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SavePresetCameras {}

File Enter path and file name 
of .bpc to be saved

SetExportOptions {}

Set some options 
relating to exporting 
camera solves

Flagged Only FALSE TRUE/FALSE

NullSize 1 Override the default null 
size for that format

FirstFrame First frame to export

LastFrame Last frame to export

FrameStep Frame step

FirstFrameIndex First frame index, 0 vs 1

ExportScale 1 Scale factor applied to 
exported scene

Type Moving Export as moving 
camera static scene; 
static camera moving 
scene; panning camera 
translating scene

Moving

Static

Panning

UseFormatDefault TRUE TRUE/FALSE

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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SetLog { }

File Recommend-
ed

Specify the log file, use 
as first command

Name of script log file

Table D-1: boujou_script Commands

Command Arguments Compulsory Default Description Permitted Values
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EEUs ing  Survey Points  without  a
3D  Model

boujou 4.1 allows you to use an imported OBJ model to represent 
survey data and to automatically determine where on the timeline 
locator or target track keyframes should be placed. Using a 
3D model as survey data is the recommended method for using 
survey points (for details, see Chapter 4 Advanced Functions). 
However, if you only have a list of X,Y,Z values and no 3D model, 
then you can use survey points to improve the 3D structure of your 
solve by incorporating on-set measurements into the camera 
solve.

Important
You must feature track your shot before you start adding survey points.

Using Survey Points
Each survey point needs to be connected to a locator or a target 
track. The positions of the locator and target track keyframes are 
essential to getting a good result from the survey points feature. 
Each locator must have at least 2 keyframes and you should add 
the keyframes on the same image frames as other locator 
keyframes to create groups. Each group of keyframes must be 
connected to the next group by at least 10 automatic feature 
tracks. The minimum number of locators with keyframes in a 
group is either 4 or 7, depending on the camera tracking mode 
that you want to use (see below). All camera tracking modes need 
to have a keyframe group on the first and last frames of the 
sequence.

Important
If you only have survey data for a small area of the scene that you are 
trying to track, it is unlikely that you will get a good result using the survey 
points tool. Try to get measurements for points over a wide area of the 
scene.
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Figure E-1 illustrates the layout of locator keyframes for a shot 
with known focal length where only three of the locators were in 
shot for the entire length of the sequence:

Figure E-1: Locator keyframes layout

You use the Scene Geometry dialog box, shown in Figure E-2, 
to add a survey point.

Figure E-2: Scene Geometry dialog box

You must first feature track your shot and add locators or target 
tracks to the features in the image that you have survey data for. 
Make sure that you have grouped the locator and target track 
keyframes as described above.
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To add a survey point:
1. Open the Scene Geometry dialog box in any of the following 

ways:

Toolbox: Scene Geometry shortcut button 
Menu bar: Artifacts > Scene Geometry
Keyboard shortcut: CTRL+G

2. Click the Add Survey Point button to create the first point. 
A new survey point appears in the Geometric features list 
at the top of the dialog box. 

3. By default this survey point is named Geometric feature 1. 
You can rename it in the Name field in the Survey Point 
Properties section of the dialog box. After you finish typing 
press the TAB key to apply the new name and leave the field.

4. Enter the coordinates of the survey point in the X, Y, and Z 
fields.

5. Select the locator or target track that you want connect the 
survey point to and then click the Connect to selected 
button. In the Geometric features list the Status of the 
survey points changes from Disconnected to the point’s 
coordinates and which locator it is connected to. For example: 
(14.50, 100.50, 2.00) Locator 10.

6. Keep adding survey points until you have entered all of your 
survey data. Any survey points that are not connected to 
locators are not discarded when you close the Survey Points 
dialog box. They are saved with the project and their status 
is displayed as disconnected whenever you open the Scene 
Geometry dialog box. Disconnected survey points have no 
effect on the camera track.

7. Once you have added all of the survey points that you need 
you can check that you have not incorrectly entered any of the 
measurements by going to the 3D view and selecting Survey 
Data from the Solve drop-down list in the top left corner of 
the Image window (this view appears by default in the 3D view 
if you don’t already have a camera solve). Survey points that 
have been connected to locators are displayed in blue and 
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those that are unconnected are displayed in gray, as shown 
in Figure E-3.

Figure E-3: Survey Data

When you have added and connected all of your survey points, you 
can solve the camera as usual. The hard constraints that you have 
set up are incorporated into the 3D structure.
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Index

Numerics
2D display preferences  B-2
2D mode  2-18, 2-34, 2-39

Overlays pane  2-48
2D Tasks menu  2-11
2D track

export  4-73
import  4-77

3D display preferences  B-4
3D mode  2-18, 2-35

Overlays pane  2-49
3D model

Fly Align tool  4-61
Vertex Align tool  4-61

3D structure  2-35, 2-54, 3-16–3-
17, 3-19, 4-23–4-24, 4-42, E-1
filter  4-55, 4-67
generate  4-52
regenerate  4-55, 4-67

3D Studio Max  5-5
import  5-5

3D Tasks menu  2-12
3D test object  3-20, 4-63

alignment method  3-22
delete  3-26
insert  3-21
manipulate  3-24
rename  3-26
rotate  3-26
scale  3-25–3-26
translate  3-25–3-26
type  3-22

A
ACTION  1-4
Active View Controls toolbar  2-18

2D mode  2-18, 2-34
3D mode  2-18, 2-35
Graph mode  2-18, 2-37

grid splitter  2-19
horizontal split  2-18
Ortho mode  2-18, 2-36
orthogonal views  2-18, 2-39
single view  2-18
vertical split  2-19

add
coordinate frame hint  4-43
keyframe  4-29, 4-37, 4-41
locator  4-24
planar constraint  4-48
survey point  4-46, E-3
target track  4-32

Adjust Solve option  4-26, 4-48
After Effects

import  5-6
aperture size  3-6
approximate camera position  4-59, 

4-63
face-based tracking  4-65
Fly Align mode  4-63
manipulate 3D test object  4-63
vertex drag  4-64

artifact
status bar  2-45

ASCII
export  5-20

Auto Reverse button  2-22

B
BAN  1-4
basebar  2-4, 2-63

Console pane  2-64
Timeline pane  2-66
Wizard  2-65

batch process  4-95
bit depth  1-2
boujou

batch process  4-95
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command line  4-95
directories  B-9
user preferences  4-94

boujou animation file
export  5-1, 5-20

boujou window  2-3
basebar  2-4, 2-63
cache bar  2-4, 2-69
Image window  2-4, 2-32
left sidebar  2-4, 2-23
menu bar  2-3, 2-7
right sidebar  2-4, 2-46
status bar  2-4, 2-43
Timebar  2-4, 2-43
Timeline  2-66
toolbar  2-3, 2-16

boujou_script  4-95, D-1
command  D-4

broken camera solve  4-57

C
C4D  1-4
cache  3-27

disable  3-28
flush  3-28
properties  3-27
size  3-27

cache bar  2-4, 2-69
calibration line  4-80

delete  4-86
rename  4-86

camera
approximate position  4-59, 4-

63–4-65
compatible  3-6
export boujou scene file  5-1
film back  3-6
focal length  4-6
lens distortion  3-7
lens squeeze ratio  3-7
name  3-6

optimize path smoothness  3-17, 
3-19

pixel aspect ratio  3-7
principal point  3-7
specify  3-5

camera move
free move  3-4
nodal pan  3-4

camera solve  3-15
adjust  3-18, 4-26, 4-48, 4-52
complete  3-16, 4-52
copy  4-55, 4-65
delete  3-16
fragment  4-57
generate 3D structure  4-52
improve using locator  4-23
information  3-19
initialize  4-52
key schedule  4-54
optimize parameters  4-52
partial  4-57
preferences  B-15
reprojection error  4-56
solve  4-53
structure  4-54
view  4-53

Camera Solve on Completion check 
box  2-44, 3-13

camera solve tool  4-52, 4-55
advanced  4-55
copy solve  4-55
copy view  4-56
create user solve  4-55, 4-60, 4-

64, 4-66
default view from known 3D  4-55
delete view  4-56
filter structure  4-55, 4-67
interpolate views  4-55
optimize view  4-56–4-57
regenerate structure  4-55, 4-67
regenerate view  4-56
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solve view from known 3D  2-62, 
4-62

camera tracking. See camera solve
center view on selection

3D test object  3-26
feature track  4-71
locator  4-30
target track  4-41

channel select  3-13
Cinema 4D  5-6
Cineon  1-2–1-3, 4-93

import  5-8
clear all selections  2-44
Combustion

import  5-9
COMP  1-4
comparison region  4-31
connect survey point

feature track  4-71
locator  4-29
target track  4-41

Console pane  2-64
constraint

focal length  4-6
planar  4-43

coordinate frame
manipulate  4-51
rotate  4-51
translate  4-51

coordinate frame hint
add  4-43
edit  4-50
properties  4-46

copy
solve  4-55, 4-65
view  4-56

create
gold track  4-72
polygon mask  4-11, 4-13
user solve  4-55, 4-60, 4-64, 4-

66

CWS  1-4
Cycle button  2-22

D
default view from known 3D  2-62, 

4-55
delete

3D test object  3-26
calibration line  4-86
camera solve  3-16
feature track  4-72
keyframe  4-13, 4-16, 4-20, 4-

29, 4-35, 4-37, 4-41
locator  4-29–4-30
polygon mask  4-16, 4-20
selected keypoint  4-19
target track  4-42
view  4-56

dialog
preferences  B-8

directories  B-9
disconnect survey point

feature track  4-71
locator  4-30
target track  4-41

display preferences  B-10
distortion. See lens distortion
dolly  2-41
dotXSI format  5-12
DPX  1-2–1-3, 4-93
DVE  1-4

E
edit

coordinate frame  2-19
feature track  4-70
keyframe range  4-40
locator  4-27
polygon mask  4-12, 4-15
scene geometry  4-50
target track  4-35
test objects  2-19
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Edit menu  2-40
Edit mode  2-45
editing status  2-44
export

boujou scene file  5-1
corrected image  4-90
feature track  4-73
flagged tracks only  5-4
image sequence  4-90
mesh  4-69, A-8
polygon mask  4-17
preferences  B-6

export file format  1-4
3D Studio Max  1-4
After Effects  1-4
ASCII  5-20
boujou animation  1-4, 5-20
Cinema 4D  1-4
Cineon  1-4
Combustion  1-4
FBX  5-17
Filmbox  1-4
Flair  1-4, 5-20
flame  1-4
Fusion  1-4
Houdini  1-4
Lightwave  1-4
Mark Roberts motion control rig  

5-20
Maya  1-4
Mistika DVE  1-4, 5-21
Shake  1-4, 5-17
smoke  1-4
SoftImage  1-4
text  1-4, 5-20
XSI  1-4

Export menu  2-13

F
face-based tracking  2-60, 4-59, 4-

65

fast tracking  3-13
FBX  1-4

export  5-17
feature scale  3-13
feature track  3-9

center view on selection  4-71
channel select  3-13
check quality  3-14, 4-37
connect survey point  4-71
delete  4-72
disconnect survey point  4-71
edit  4-70
export  4-73
fast tracking  3-13
feature scale  3-13
flag for export  4-70, 4-77
gold  4-70
import  4-77
join  4-71, 4-78
manual  4-23
non-consecutive  4-23, 4-78
polygon mask  4-17, 4-20
preferences  B-15
properties  4-72
rename  4-72
search distance  3-12
sensitivity  3-12

file format
export  1-4
image  1-2–1-3

File menu  2-8
film back  3-6
filter structure  4-55, 4-67
flag for export  2-69

feature track  4-70, 4-77
locator  4-29
target track  4-41

Flair
export  5-20

flame
import  5-9
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fly align  2-20, 4-61, 4-63
focal length  2-62, 4-6

keyframe  4-8
optimize  2-62, 4-64
properties  4-6–4-7

fragmented solve  4-57
free move  3-4
FX  1-4

G
generate

3D structure  4-52
image proxy  4-2
mesh  2-12, 4-67–4-69

go to end  2-21
go to frame  2-42
Go to Start button  2-21
gold track  4-72

create  4-72
feature track  4-70
locator  4-29
target track  4-41

graph display preferences  B-11
Graph mode  2-18, 2-37

Overlays pane  2-50
grid splitter  2-19

H
hard constraint  4-46, 4-48
Help menu  2-15
Help pane  2-56
HIP  1-4
History pane  2-26

redo  2-27
undo  2-27

horizontal split  2-18
Houdini

import  5-11

I
IFF  1-2–1-3, 4-93
image

format preferences  B-11
lens adjust  4-92
redistort  4-92
supported formats  1-2

image file format  1-2–1-3
Cineon  1-2–1-3, 4-93
DPX  1-2–1-3, 4-93
IFF  1-2–1-3, 4-93
JPEG  1-2–1-3, 4-93
Maya IFF  1-2–1-3, 4-93
MOV  1-2
Open EXR  1-2
PGM  1-2–1-3
PNG  1-2–1-3, 4-93
PPM  1-2–1-3, 4-93
Quicktime  1-2
RGB  1-2–1-3, 4-93
SGI  1-2–1-3, 4-93
Softimage PIC  1-2–1-3, 4-93
TGA  1-2
TIFF  1-2–1-3, 4-93
Windows AVI  1-2–1-3

image proxy  3-28, 4-2
generate  4-2
import  4-3
properties  4-5
status bar  2-45

image sequence
export  4-90
import  3-1
rename  3-3

Image window  2-4, 2-32
navigation  2-41

image-based mask
import  4-21
interpolate  4-22
rename  4-22

import
3D Studio Max  5-5
After Effects  5-6
Cinema 4D  5-6
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Cineon  5-8
Combustion  5-9
feature track  4-77
flame  5-9
Houdini  5-11
image proxy  4-3
image sequence  3-1
image-based mask  4-21
inferno  5-9
LightWave  5-11
Maya  5-12
OBJ model  4-59–4-60, 4-64, 4-

66
polygon mask  4-17
preferences  B-12
smoke  5-9
Softimage  5-12
XSI  5-12

inferno
import  5-9

information messages
preferences  B-8

initialize camera  4-52
interlace

image-based mask  4-22
interpolate lines  3-4

interpolate
lines  3-4
view  4-55

invert polygon mask  4-13, 4-16, 4-
20

J
JDF  1-4
join

feature track  4-71, 4-78
JPEG  1-2–1-3, 4-93

K
keyframe

add  4-29, 4-37, 4-41
delete  4-13, 4-16, 4-20, 4-29, 4-

35, 4-37, 4-41
focal length  4-8
locator  4-23
polygon mask  4-11, 4-19
range  4-40
target track  4-32

keypoint
add  4-19
delete  4-19

L
Lasso Selection mode  2-45
left sidebar  2-4, 2-23

History pane  2-26
Taskview pane  2-24
Toolbox pane  2-28

lens adjust external sequence  4-92
lens distortion  4-80

automatic assessment  4-87
calculate  4-83
calibration line  4-80
export sequence  4-90
manual assessment  4-84
pipeline  4-81
redistort image  4-92

lens squeeze ratio  3-7, C-1
LightWave

import  5-11
locator

add  4-24
add 3D points  4-23
center view on selection  4-30
connect survey point  4-29
delete  4-29–4-30
disconnect survey point  4-30
edit  4-27
flag for export  4-29
gold track  4-29
improve camera solve  4-23
keyframe  4-23
manual feature track  4-23
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non-consecutive feature tracking  
4-23

properties  4-28, 4-30
rename  4-30
survey point  4-24
Timeline  4-23

locked to point  2-22
lua script  B-10, B-14
LWS  1-4

M
MA  1-4
manage holes  4-16, 4-20
manipulate

coordinate frame  4-51
polygon mask  4-12

manual feature track  4-23
Mark Roberts

export  5-20
mask

image-based  4-21
polygon  4-10

Max. See 3D Studio Max
Maya

import  5-12
Maya IFF  1-2–1-3, 4-93
menu bar  2-3, 2-7

2D Tasks menu  2-11
3D Tasks menu  2-12
Edit menu  2-40
Export menu  2-13
File menu  2-8
Help menu  2-15
Scripts menu  2-15
Setup menu  2-10
View menu  2-14

mesh  4-65
display  2-54
export  4-69, A-8
generate  2-12, 4-67–4-69

Mistika DVE

export  5-21
Model toolbar  2-20

Fly Align button  2-20
Vertex Align button  2-20

Model Tools pane  2-60
model-based tracking  4-59
motion control rig

export  5-20
MOV  1-2
move

polygon mask  4-13
MRMC  1-4
MS  1-4

N
navigation  2-41

dolly  2-41
orbit  2-41
Pan view  2-38
roll  2-41
scrub  2-41
shuttle  2-41
zoom  2-38, 2-41

new project  2-17
Next key  2-22
nodal pan  3-4
non-consecutive feature track  4-

23, 4-78

O
OBJ model

import  4-59–4-60, 4-64, 4-66
survey data  4-60, E-1

Open EXR  1-2
open project  2-17
optimize

camera parameters  4-52
camera path smoothness  3-17, 

3-19
focal length  2-62, 4-64
radial distortion parameters  3-

17–3-18, 4-89
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view  4-56–4-57
orbit  2-41
Ortho mode  2-18, 2-36

Overlays pane  2-49
orthogonal views  2-18
Overlays pane  2-48

2D mode  2-48
3D mode  2-49
controls  2-52
Graph mode  2-50
Ortho mode  2-49

P
Pan view  2-38
partial solve  4-57
pattern match  4-30
PGM  1-2–1-3
PIC  1-2–1-3, 4-93
pivot polygon mask  4-13
pixel aspect ratio  3-7
planar constraint  4-43

add  4-48
edit  4-50
properties  4-49

Play Backward button  2-42
Play Controls toolbar  2-21–2-22, 

2-40
Play Backward button  2-42
Play Forward button  2-42
Play Once  2-22
Start button  2-42
Step Backward button  2-42
Step Forward button  2-42
Stop button  2-42

play controls toolbar  2-21–2-22
Play Forward button  2-21, 2-42
Play Once  2-22
PNG  1-2–1-3, 4-93
polygon mask  4-10

animate  4-11
create  4-11, 4-13

delete  4-16, 4-20
edit  4-12, 4-15
export  4-17
import  4-17
invert  4-13, 4-16, 4-20
keyframe  4-11, 4-19
keypoint  4-19
manage holes  4-16, 4-20
manipulate  4-12
move  4-13
pivot  4-13
properties  4-15, 4-20
rename  4-16, 4-20
rotate  4-13
scale  4-13, 4-19
Timeline  4-13
track  4-17, 4-20
translate  4-13
visibility  4-20
with hole  4-13

PPM  1-2–1-3, 4-93
preferences  4-94

2D display  B-2
3D display  B-4
camera export  B-6
camera solve  B-15
dialog  B-8
directories  B-9
display  B-10
feature track  B-15
graph display  B-11
image formats  B-11
import  B-12
miscellaneous  B-12
target track  B-14

previous key  2-21
principal point  3-7
processing status  2-44
progress bar  2-44
project

save  3-8
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project notes
add  3-29

proxy. See image proxy

Q
Quicktime  1-2

R
radial distortion  3-7, 4-80

optimize parameters  3-17–3-18, 
4-89

redistort image  4-92
Redo button  2-17, 2-27
regenerate

structure  4-55, 4-67
view  4-56

rename
3D test object  3-26
calibration line  4-86
camera  3-6
feature track  4-72
image sequence  3-3
image-based mask  4-22
locator  4-30
polygon mask  4-16, 4-20
survey point  E-3
target track  4-40, 4-42

reprojection error  4-56
Reset Coordinate Frame button  2-

20
RGB  1-2–1-3, 4-93
right sidebar  2-4, 2-46

Help pane  2-56
Model Tools pane  2-60
Overlays pane  2-48
Zoom Tool  2-57

roll  2-41
rotate

3D test object  3-24, 3-26
coordinate frame  4-51
polygon mask  4-13

Rotate button  2-20

S
save project  2-17, 3-8
scale

3D test object  3-24–3-26
polygon mask  4-13, 4-19

Scale button  2-19
scene geometry  4-42

coordinate frame hint  4-43
edit  4-50
hard constraint  4-46, 4-48
planar constraint  4-48
soft constraint  4-43
survey point  4-46

Scripts menu  2-15
scrub  2-41
search distance  3-12
search region  4-31
sensitivity  3-12
Setup menu  2-10
SGI  1-2–1-3, 4-93
Shake

export  5-17
SHK  1-4
shuttle  2-41
single view  2-18
smoke

import  5-9
soft constraint  4-43
Softimage  1-2–1-3, 4-93

import  5-12
Solve Adjust dialog box  3-18, 4-52
solve camera.  See camera solve
solve complete  3-16, 4-52
solve tool. See camera solve tool
spring

delete  2-62
standard toolbar  2-17

New button  2-17
Open button  2-17
Redo button  2-17
Save button  2-17



Index-10 boujou 4.1 Reference Guide

Undo button  2-17
start playback  2-42
status bar  2-4, 2-43

artifact  2-45
Camera Solve on Completion 

check box  2-44, 3-13
clear all selections  2-44
editing information  2-44
Lasso Selection mode  2-45
processing information  2-44
progress bar  2-44
proxy  2-45
toggle Edit mode  2-45

Step Backward button  2-21, 2-42
Step Forward button  2-21, 2-42
Stop Playback button  2-21, 2-42
survey data  4-60
survey point  E-1

add  4-46, E-3
edit  4-50
locators  4-24
properties  4-47
rename  E-3

T
target track  4-30

add  4-32
center view on selection  4-41
clear  4-41
comparison region  4-31
connect survey point  4-41
delete  4-42
disconnect survey point  4-41
edit  4-35
flag for export  4-41
gold  4-41
keyframe  4-32
polygon mask  4-17, 4-20
preferences  B-14
properties  4-37–4-38, 4-42
range  4-38

rename  4-40, 4-42
search region  4-31
Timeline  4-33
track  4-37

Taskview pane  2-24
text

export  5-20
TGA  1-2
TIFF  1-2–1-3, 4-93
Timebar  2-4, 2-43
Timeline  2-66

functions  2-67
locator  4-23
polygon mask  4-13
target track  4-33

toggle Edit mode  2-45
toolbar  2-3, 2-16

Active View Controls  2-18
Model  2-20
Play Controls  2-21, 2-40
standard  2-17
Transformations  2-19

Toolbox pane  2-28
track

gold  4-72
target  4-30

track camera. See camera solve
track feature.  See feature track
track target. See target track
Transformations toolbar  2-19

Edit the Coordinate Frame button  
2-19

Edit the Test Objects button  2-19
Reset Coordinate Frame button  

2-20
Rotate button  2-20
Scale button  2-19
Translate button  2-19

translate
3D test object  3-24–3-26
coordinate frame  4-51
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polygon mask  4-13
Translate button  2-19
troubleshooter  2-65
TXT  1-4

U
undo  2-27
Undo button  2-17
user interface  2-1

enhancements  2-2
user preferences. See preferences

V
Vertex Align button  2-20

spring  2-62
Vertex Align tool  4-61
Vertex Drag button  4-64
vertical split  2-19
view

grid split  2-19
horizontal split  2-18
orthogonal  2-18
single  2-18
vertical split  2-19

View menu  2-14

W
warning messages

preferences  B-8
Windows AVI  1-2–1-3
Wizard  2-65

X
XSI  1-4

import  5-12

Z
zoom

Graph mode  2-38
Image window  2-41

Zoom Tool  2-57



Index-12 boujou 4.1 Reference Guide


	Reference Guide
	Contents
	Preface
	Audience
	Structure
	Conventions
	Related Documentation

	Introduction
	Camera tracking with boujou
	Supported Import Image File Formats
	Supported Export Image File Formats
	Supported Camera Export File Formats

	boujou Camera Tracking Workflow

	User Interface
	boujou 4.1 User Interface Enhancements
	boujou 4.1 Window
	Managing Panes

	Menu Bar
	File Menu
	Edit Menu
	Setup Menu
	2D Tasks Menu
	3D Tasks Menu
	Export Menu
	View Menu
	Scripts Menu
	Help Menu

	Toolbars
	Standard Toolbar
	Active View Controls Toolbar
	Transformations Toolbar
	Model Toolbar
	Play Controls Toolbar

	Left Sidebar
	Taskview Pane
	Informationals

	History Pane
	Toolbox Pane

	Image Window
	2D Mode View
	3D Mode View
	Ortho Mode View
	Graph Mode View
	Splitting the Image Window into Multiple Views
	Playing Back Data in the Image Window
	Navigating Data in the Image Window

	Timebar
	Status Bar
	Processing Status
	Editing Status

	Right Sidebar
	Overlays Pane
	Help Pane
	Zoom Tool Pane
	Model Tools Pane

	Basebar
	Console Pane
	Wizard and Troubleshooter Pane
	Timeline Pane

	Cache Bar

	Basic Functions
	Importing an Image Sequence
	Specifying a Camera
	Saving a Project
	Tracking Features
	Checking Feature Tracking Quality

	Solving the Camera
	Performing a Complete Camera Solve
	Performing an Adjust Camera Solve
	Checking Camera Solve Quality

	Using 3D Test Objects
	Inserting a 3D Test Object
	Manipulating 3D Test Objects

	Caching Images
	Adding Project Notes

	Advanced Functions
	Using Image Proxy Sequences
	Generating an Image Proxy Sequence
	Importing an Image Proxy Sequence
	Managing a Proxy Image Sequence

	Setting Focal Length Constraints
	Using the Advanced Mode

	Using Polygon Masks
	Creating a Polygon Mask
	Editing a Polygon Mask
	Creating a Polygon Mask with a Hole
	Editing Polygon Mask Properties
	Importing and Exporting Polygon Masks
	Manipulating Polygon-based Masks

	Importing an Image-based Mask
	Using Locators
	Adding Locators
	Editing Locator Positions
	Editing Locator Properties
	Manipulating Locators

	Using Target Tracks
	Adding Target Tracks
	Editing Target Tracks
	Checking Target Tracks Quality
	Editing Target Tracks Properties
	Manipulating Target Tracks

	Describing Scene Geometry
	Adding a Coordinate Frame Hint
	Adding a Survey Point
	Adding a Planar Constraint
	Editing Geometric Features
	Manipulating the Coordinate Frame

	Solving the Camera with Advanced Tools
	Using Advanced Camera Solve Tools
	Visualizing Reprojection Errors
	Working with Partial Solves and Fragmented Solves

	Using Model-based Tracking
	Using a 3D Model as Survey Data
	Using a 3D model to Create Approximate Camera Positions
	Using a 3D Model for Face-based Object Tracking

	Using Mesh Generation
	Using Feature Tracks
	Editing Automatically Generated Feature Tracks
	Creating Gold Tracks
	Exporting 2D Feature Tracks
	Importing 2D Feature Tracks
	Using Non-Consecutive Feature Tracking

	Assessing Lens Distortion
	Understanding the Lens Distortion Pipeline
	Understanding boujou Lens Distortion Assessment

	Manually Assessing Lens Distortion
	Automatically Assessing Lens Distortion
	Exporting a Corrected Image Sequence
	Lens-adjusting an External Sequence

	Setting User Preferences
	Using boujou 4.1_script for Command-line Processing

	Export to an Animation Package
	Exporting a boujou 4.1 Scene for an Animation Package
	Importing a boujou 4.1 Scene into an Animation Package
	Importing a Scene into 3D Studio Max
	Importing a Scene into After Effects
	Importing a scene into Cinema 4D
	Importing a scene into Cineon
	Importing a Scene into Combustion
	Importing a Scene into Flame, Inferno, or Smoke
	Importing a Scene into Fusion
	Importing a Scene into Houdini
	Importing a Scene into LightWave
	Importing a Scene into Maya
	Importing a Scene into Softimage XSI

	Exporting boujou 4.1 Data into Other Formats
	Exporting boujou 4.1 Camera-tracking Data in FBX Format
	Exporting boujou 4.1 Tracks in Shake Format
	Exporting boujou 4.1 Tracks in ASCII or boujou Animation File Format
	Exporting the Camera to Mark Roberts Motion Control Rig
	Exporting boujou 4.1 Tracks to Mistika DVE


	boujou 4.1 Keyboard Shortcuts
	2D Tasks Keyboard Shortcuts
	3D Tasks Keyboard Shortcuts
	Edit Keyboard Shortcuts
	Export Keyboard Shortcuts
	File Keyboard Shortcuts
	Image Window Keyboard Shortcuts
	Play Controls Keyboard Shortcuts
	Scripts Keyboard Shortcuts
	Setup Keyboard Shortcuts

	boujou 4.1 Preferences
	2D Display Preferences
	3D Display Preferences
	Camera Export Preferences
	Dialog Preferences
	Directories Preferences
	Display Preferences
	Graph Display Preferences
	Image Formats Preferences
	Import Preferences
	Miscellaneous Preferences
	Target Tracking Preferences
	Tracking Preferences

	Lens Squeeze Ratio
	Lens Squeeze Ratio Example 1
	Lens Squeeze Ratio Example 2

	boujou_script File Commands
	Example boujou_script File
	boujou_script Commands

	Using Survey Points without a 3D Model
	Using Survey Points

	Index


